# Table of Contents

- **Home** .................................................................................................................. 1
- **Getting started with the Nik Collection by DxO** .................................................. 2  
  - *Introducing the Nik Collection by DxO* .................................................................. 3
- **Configuration and installation** ............................................................................... 4
  - *System requirements* ................................................................................................. 5
  - *Installation, activation, and uninstallation* ............................................................... 6
- **Control points** ....................................................................................................... 24  
  - *Control point principles and functions* .................................................................... 25
- **Workflows** ............................................................................................................ 31  
  - *DxO PhotoLab* .......................................................................................................... 32
  - *Adobe Lightroom Classic* .......................................................................................... 39
  - *Serif Affinity Photo* ................................................................................................. 69
  - *Standalone mode* ....................................................................................................... 72
  - *Standalone mode (Nik Collection 4)* ......................................................................... 79
  - *Non-destructive workflow* ....................................................................................... 87
- **Workflow with Adobe Photoshop** ........................................................................... 101  
  - *Accessing the Nik Collection* .................................................................................... 102
  - *Selective Tool 2, Meta-presets, and Brush tool* ...................................................... 115
- **Analog Efex Pro 2** ................................................................................................. 136  
  - *Introduction* ............................................................................................................. 137
  - *Settings and help* ..................................................................................................... 138
  - *Interface* .................................................................................................................. 141
  - *Cameras and tools* ................................................................................................... 154
  - *Custom camera kits and tools* ................................................................................ 165
- **Color Efex Pro 4** ................................................................................................... 169  
  - *Introduction* ............................................................................................................. 170
  - *Settings and help* ..................................................................................................... 171
  - *Interface and keyboard shortcuts* ............................................................................ 174
  - *Managing recipes and filters* ................................................................................... 189
- **Dfine 2** .................................................................................................................... 196  
  - *Introduction* ............................................................................................................. 197
  - *Settings and help* ..................................................................................................... 199
  - *Interface and keyboard shortcuts* ............................................................................ 202
  - *Measuring and reducing noise* .............................................................................. 210
- **HDR Efex Pro 2** ..................................................................................................... 224  
  - *Introduction* ............................................................................................................. 225
  - *Settings and help* ..................................................................................................... 227
  - *Interface and keyboard shortcuts* ............................................................................ 231
  - *Merging images* ....................................................................................................... 245
  - *Using and managing presets* ................................................................................... 251
  - *Correction tools* ..................................................................................................... 257
- **Perspective Efex** ................................................................................................... 268  
  - *Introduction* ............................................................................................................. 269
  - *Settings and help* ..................................................................................................... 270
  - *Interface and keyboard shortcuts* ............................................................................ 272
  - *Applying DxO Optics Modules* ................................................................................ 278
  - *Correcting distortion* .............................................................................................. 280
<table>
<thead>
<tr>
<th>Module</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Correcting volume deformation</td>
<td>284</td>
</tr>
<tr>
<td>Fixing perspective</td>
<td>288</td>
</tr>
<tr>
<td>Straightening horizons and cropping</td>
<td>299</td>
</tr>
<tr>
<td>Miniature effect</td>
<td>306</td>
</tr>
<tr>
<td>Sharpener Pro 3</td>
<td>310</td>
</tr>
<tr>
<td>Introduction</td>
<td>311</td>
</tr>
<tr>
<td>Settings and help</td>
<td>313</td>
</tr>
<tr>
<td>Interface and keyboard shortcuts</td>
<td>316</td>
</tr>
<tr>
<td>RAW Presharpen: initial sharpening</td>
<td>330</td>
</tr>
<tr>
<td>Output Sharpener: creative output enhancement</td>
<td>341</td>
</tr>
<tr>
<td>Silver Efex Pro 3</td>
<td>355</td>
</tr>
<tr>
<td>Introduction</td>
<td>356</td>
</tr>
<tr>
<td>Settings and help</td>
<td>357</td>
</tr>
<tr>
<td>Interface and keyboard shortcuts</td>
<td>361</td>
</tr>
<tr>
<td>Using and managing presets</td>
<td>376</td>
</tr>
<tr>
<td>Correction tools</td>
<td>391</td>
</tr>
<tr>
<td>Viveza 3</td>
<td>421</td>
</tr>
<tr>
<td>Introduction</td>
<td>422</td>
</tr>
<tr>
<td>Settings and help</td>
<td>423</td>
</tr>
<tr>
<td>Interface and keyboard shortcuts</td>
<td>428</td>
</tr>
<tr>
<td>Using and managing presets</td>
<td>442</td>
</tr>
<tr>
<td>Correction tools</td>
<td>457</td>
</tr>
</tbody>
</table>
What’s New: The Nik Collection 4 by DxO!

- Control points
- Silver Efex Pro 3
- Standalone mode (Nik Collection 4)
- Viveza 3
- Workflow with Adobe Photoshop
- Workflows
Getting started with the Nik Collection by DxO
Introducing the Nik Collection by DxO

The Nik Collection by DxO offers a wide range of creative tools with numerous filters, renderings, and editing options that are readily mastered both by demanding photographers and by photographers who are looking for easy-to-use tools.

The suite is compatible with Adobe Photoshop, Adobe Lightroom Classic, Serif Affinity Photo, and DxO PhotoLab, and is based on the following 8 plug-ins or external editors:

- Analog Efex Pro 2, simulating the rendering of many types of film cameras.
- Color Efex Pro 4, offering a variety of color camera renderings and recipes for color photography.
- Dfine 2, allowing for very precise noise correction, both globally and locally.
- HDR Efex Pro 2, for merging and processing images with a wide dynamic range.
- Perspective Efex, specializing in geometric image correction.
- Silver Efex Pro 3, offering a rich palette of tools and renderings for black and white images, along with many film simulations inherited from the original Nik Collection, plus those developed by DxO Labs.
- Sharpener Pro 3, taking care of all sharpening tasks from the beginning of the workflow to media output.
- Viveza 3, using darkroom principles to easily correct tone and color.

The Nik Collection by DxO is based on a variety of technologies such as selective correction with control points (U-points); film simulation based on the real-world characteristics of old-fashioned film; tone compression and 32-bit image support for HDR; and optical correction and associated modules from DxO Labs.

In this guide you will find not only a complete description of all the tools, plugin by plugin, but also all you need to know about workflows with host applications, as well as the different usage scenarios.
Configuration and installation
Compatible operating systems

- Microsoft Windows 8.1 (64-bit only)
- Microsoft Windows 10 (64-bit and versions still supported by Microsoft)
- Apple macOS 10.14 Mojave, 10.15 Catalina, or 11 Big Sur

Hardware configuration

PC (Windows)

- Intel® Core™ 2 or AMD Athlon™ 64 X2 or higher (Intel Core® i5 or higher recommended)
- 8 GB of RAM (16 GB recommended)
- Minimum of 4 GB space available on hard drive
- Microsoft Surface devices are not supported
- Requirements for HiDPI monitor support:
  - Microsoft Windows 10 (1607) and later versions
  - Adobe Photoshop 2020 and 2021 (if launched from Adobe Photoshop)

Mac (macOS)

- Intel® Core™ i5 or higher
- 8 GB of RAM (16 GB recommended)
- Minimum of 4 GB space available on hard drive

Graphics cards (GPU)

- If your graphics card is not compatible, GPU acceleration will be disabled in favor of the CPU.

Compatible host software

Mac and PC

- Adobe Photoshop 2020 and 2021
- Adobe Photoshop Elements 2020 and 2021 (except for HDR Efex Pro 2, not compatible with Photoshop Elements)
- Adobe Lightroom Classic 2020 and 2021
- From DxO PhotoLab 4
- From Serif Affinity Photo 1.8.3 (except Perspective Efex, not compatible with Affinity Photo)
Installing, activating, and uninstalling

You will find instructions for the following on this page:

- Downloading
- Installing
- Activating
- Installing in host applications
- Installing in Serif Affinity Photo
- Uninstalling

**Downloading**

You can download the Nik Collection by DxO at nikcollection.dxo.com; it will be saved in your computer’s Downloads folder. In Windows, the file will have the extension .exe; in Mac, the file has the extension .dmg.

**Installing**

![Mac](image)

Left: Mac, right: PC
Welcome

This wizard will guide you through the installation. Please close all other applications so you won't have to reboot your computer after.

If you already own a version of Nik Collection, please note that Nik Collection 4 will replace it.

To retrieve your former version later, please make a copy of the former installer.

I understand that any existing version of Nik Collection on this computer will be replaced.

Version: 4.0.6

[Install] [Cancel]
License Agreement

Please, review the Terms of Service and Privacy Policy before installing Nik Collection

Before using Nik Collection you agree to the DxO Terms of Service and Privacy Policy

Consult our Terms of Service

I agree to the Terms of Service and Privacy Policy.

< Back  Cancel  Accept
Choose Install Location

Choose the folder in which to install Nik Collection.

Setup will install Nik Collection in the following folder. To install in a different folder click 'Browse' and select another destination.

/Applications/Nik Collection

Space required: 2.84 GB
Space available: 284.51 GB

Default installation location (Mac)
Choose Install Location

Choose the folder in which to install Nik Collection.

Setup will install Nik Collection in the following folder. To install in a different folder click ‘Browse’ and select another destination.

C:\Program Files\DxO\Nik Collection

Space required: 2.6 GB
Space available: 192.9 GB

Default installation location (PC)
Compatible Host Applications

Nik Collection will be installed to the following Host Applications.
Nik Collection plugins will be added to the listed Host Applications. If you would like to add another host, please, choose the host plugins folder by pressing '+'.

- Adobe Photoshop 2021
- Adobe Lightroom Classic CC
- DxO Photolab 4

< Back  Cancel  Install
Installing...

Please wait while Nik Collection is being installed.
1. Be sure to close all host image editing applications, such as Photoshop or Lightroom.
2. Locate the installation file you downloaded, and double-click it.
3. In the installation window, click on Nik Collection (Mac).
4. Select the installation language (the system language is proposed by default).
5. A dialog box informs you that any version installed on your computer, including the original Nik Collection, the Nik Collection from Google and a previous version of the Nik Collection by DxO, will be replaced. Validate by checking the box and click on Install.
6. A new dialog box offers you to accept the license agreement. Check the box and click on Accept (if you do not accept, the installation will be canceled).
7. The installer will suggest a default location (Program Files folder on PC, Applications folder on Mac) and indicate the space required and the space available. If you wish to install the Nik Collection by DxO in another location, click on Browse, a system dialog box will prompt you to create and/or select another volume. Confirm by clicking on Next.
8. In the next window, you will find a list of compatible host programs detected on your computer. You can remove a program with the "-" button. The "+" button allows you to add a program that is not detected or that requires a special installation of plugins (see the
Installation paragraph for Serif Affinity Photo, below). Validate by clicking on Install (your system will display a security dialog box asking you to authorize the installation).

9. The installation process will continue, displaying a progress bar.

10. The last window indicates that the installation is complete. To exit the installation program, click on Finish.

Before installing the new version of Nik Collection to replace a previous version, we recommend that you first export the types, presets, and recipes that you have customized or imported from Analog Efex Pro 2, Color Efex Pro 4, Silver Efex Pro 2, and HDR Efex Pro 2.

Activating

At the first launch after installation, a window will prompt you to enter your registration key. This window will appear at each launch as long as you have not entered the key. During the trial period (30 days), you will be able to continue using the Nik Collection; after that, you will be blocked at the registration window.
Installing in host applications
The Nik Collection by DxO automatically installs in the following host applications (make sure they are closed first; if that is not the case, a warning dialogue box will pop up):

- DxO PhotoLab
- Adobe Lightroom Classic
- Adobe Photoshop
- Adobe Photoshop Elements

Installing Serif Affinity Photo*

*Important: Compatibility between Affinity Photo and the Nik Collection by DxO exists from version 1.8 and higher of the Serif program, and from version 2.5 and higher of the collection.

Plug-ins for the Nik Collection by DxO are not automatically installed in Affinity Photo during the installation process. You must install them manually as follows:

For Mac users:

1. Plugin installation and creation:
   1. Launch the Nik Collection by DxO Installer.

      - During the Compatible Host Applications step (step 8 of the Installation section), click + to search for or create a folder in the directory of your choice to store the Nik Collection plugins, then click Open.
In the installer window, you will then see a new host in the list called **Adobe Photoshop Custom1**.
By successively clicking Continue, then Install, a "DxO" folder will be created in the background in the directory of your choice.

This DxO folder will contain all the Nik Collection by DxO plugins.

Continue the installation until the end and click on Close.

2. Launch the Affinity Photo program.

3. Import the Nik Collection plugins into Affinity Photo:
   - From the top menu bar, go to Affinity Photo> Preferences.
   - In the window that opens, click on the Photoshop Modules icon.
In the **Plugin Search Folder** section, click on **Add**.

In the dialog window, select the **DxO** folder generated inside the folder you created during installation, and press the **OK** button.

In the **Plugin Support Folders** section on the right, click **Allow Global Support** and then on **Allow**, without selecting anything.

Underneath the **Detected Modules** section, select the **Allow the use of "Unknown" modules** checkbox.
4. Import your image into Affinity Photo.

5. Launch the Nik Collection by DxO plugins via Affinity Photo:
   - Go to Filters > Plugins > Nik Collection > Name of plugin.

For Windows users:

A. Plugin installation and creation:
   1. Launch the Nik Collection by DxO installer.
   2. During the "Compatible Hosts" step, click + to create a new folder in the directory of your choice to store the Nik Collection plugins, then click Open. In the installer window, you will then see in the list a new host called Adobe Photoshop Custom1.
   3. By successively clicking on Continue, then Install, a "DxO" folder will be created in the background in the directory of your choice. This DxO folder will contain all Nik Collection by DxO plugins.
   4. Continue the installation to the end and click Close.
B. Launch the Affinity Photo application.
C. Import the Nik Collection plugins into Affinity Photo.
   1. In the top menu bar, go to Edit > Preferences.
   2. In the window that opens, click on the Photoshop Modules icon.
   3. In the Modules Search Folder section, click on Add.
   4. In the dialog window, select the DxO folder generated inside the folder you created during installation, and press the OK button.
   5. Underneath the Detected Modules section, select the Allow the use of "Unknown" modules checkbox.
   6. Click on Close.
   7. In the other dialog window, select Restart.
   8. After the restart, if it is open, close the Preferences popup.

Uninstalling

There are two different ways to uninstall the Nik Collection by DxO; before using either method, close the the host applications.
We’re sorry to see you go!

If there’s a particular issue, please let us know and contact Dxo Support Team directly. We will do our best to help you.
Compatible Host Applications

Nik Collection will be removed from the following Host Applications:

- Adobe Photoshop 2021
- Adobe Lightroom Classic CC
- DxO Photolab 4

Keep my custom and imported presets

Uninstall button
Uninstalling, method 1:

1. As a prerequisite to uninstallation, close the host applications.

2. Go to the Programs (PC) or Applications (Mac) folder, then to the Nik Collection folder, where you will find an Uninstall icon. Click on it to start the uninstallation.

3. A dialog box will notify you of the uninstallation. Click Next.

4. The Host Applications window will summarize the list and offer you the option to keep your presets despite the uninstallation by checking the box. Then click on Uninstall. Another dialog box displays a progress bar.

5. A dialog box confirms that the Nik Collection by DxO has been uninstalled. Exit by clicking on Finish.

Uninstalling, method 2:

- **Method 2**: Click on the installer in your Downloads folder, then in the window that appears, click on the Uninstall icon and follow the instructions.
Control points
Control points

Principles and functions

Control Points use U Point technology, developed by Nik Software and acquired in 2017 by DxO Labs, which allows you to make precise selections without the need for masks or complex selection tools. (The name “U Point” is simply an abbreviated form of “you point.”)

Each of the Nik Collection by DxO’s plugins (except Perspective Efex) includes control points tailored to its function. For example, in Dfine 2, control points allow you to selectively reduce noise, while in Viveza 2, they allow you to correct tone and color.

Each control point makes its selection based on the characteristics of the reference pixels to which it is applied. These characteristics include:

- RGB channels (red, green, blue)
- Hue or tint
- Saturation
- Brightness
- Texture (thanks to the consideration of adjacent pixels and the presence of details)
- Location of the selected pixels

U Point technology then automatically selects other elements and areas of the image with characteristics similar to the selected image point on which the control point is placed within the range defined by the size slider. (To define the size of the selection, use the Size slider associated with each control point.)

Finally, adding control points in the same image allows for even finer and more precise analyses, which will have an impact on the efficiency and accuracy of your selections. Further, more areas will be selected simultaneously in the image.

Note that control points and U Point technology have also been integrated into the local settings of DxO PhotoLab.

You can compare below the different control points/U-points in the Nik Collection by DxO, and the version in DxO PhotoLab (bottom image in the series):
Control Point / Analog Efex Pro 2

Control Point / Color Efex Pro 4
Note: only the **Radius** slider is accessible; the other settings are in the right panel of the plugin in use.
Control Point / DxO PhotoLab
Workflows
DxO PhotoLab

The Nik Collection by DxO is accessible to DxO PhotoLab users as a set of external applications via a dedicated button in the Image Explorer, both in the Photo Library tab and the Customize tab. In this chapter, we discuss:

- Settings
- **Recommended settings**
- **Standard workflow**

**Settings**

The first thing to do is to set the type of file you will transfer to one of the Nik Collection plugins:
1. At the bottom right, in the DxO PhotoLab image explorer toolbar, click on the Nik Collection button.

2. In the Plugin Selector, click Settings.

3. In the Format section, choose the file format:
   - **Action**: Choose between TIFF and JPEG format
   - **Quality** (for TIFF format): Choose from 16-bit, 8-bit, or 8-bit with compression (depth per channel, R, G, and B).
   - **Quality** (for JPEG format): Use the slider to adjust the compression level.

4. In the Resize section, you will determine the physical characteristics of images to be processed in the Nik Collection:
   - **Resolution**: Set to 72 ppi (dots per inch) by default, this setting has no influence on image characteristics until you specify a physical dimension (changing this value automatically activates the resize options). Indeed, if a lab or a printer asks you for 240 or 300 ppi, you will also have to resize the image (for example, a 50x75 cm print at 300 ppi).
   - **Resize the image**: Click the box to manually activate the resizing options (automatic activation when changing resolution).
- **Maximum dimension** lets you set the dimension of the wide side of the image in pixels (px) for images intended for electronic (web) distribution, or the physical dimensions of the wide side of the image in centimeters or inches for images intended for printing.

- **Interpolation**: Allows the use of algorithms in the case of physical enlargement of the image, with the algorithms Bicubic (default choice), Sharper Bicubic or Bilinear).

5. The Watermark section allows you to overlay a text and/or graphic watermark created in DxO PhotoLab. However, at this point, we recommend that you apply a watermark only after processing the image in the Nik Collection by DxO.

6. In the **Advanced** section, you can assign a space or color profile in the **ICC Profile** menu:

- **Original**: Default choice, keeps the original profile of the image transferred from DxO PhotoLab to the Nik Collection, and back

- **sRGB**: Select this space for general use (web, inkjet printing, minilab).

- **Adobe 1998**: Select this space for a print run at an off-set printer’s.

- **Choose Profile**: allows you to search and assign an ICC profile stored in your operating system (adds to the menu).

- **Clear Menu**: Deletes added profiles.

**Recommended settings***

For a maximal quality workflow, especially if you plan to do further processing and retouching later, or to provide documents of the highest quality:

- 16-bit TIFF format

- Do not change the resolution

- Do not resize

- No watermark (apply it at the end of the workflow for an export, for example).

- Original ICC profile

For maximal quality workflow, but without considering further processing afterwards:

- Format JPEG, compression 75 à 100%.

- Do not change the resolution

- Do not resize

- No watermark (apply it at the end of the workflow for an export, for example).
• Original ICC profile

For a standard workflow, without considering further processing, for Facebook broadcast, or for emailing:

• JPEG format, 70-75% compression
• Do not change the resolution
• Resize to 2048 pixels
• No watermark (apply it at the end of the workflow for an export, for example).
• sRGB profile

* In general, when processing images in the Nik Collection, maintain maximum quality workflow. You will be able to modify your files afterwards, depending on their usage, during the export phase in DxO PhotoLab.

Standard workflow*

The workflow from DxO PhotoLab is very simple:

1. Process your original image in DxO PhotoLab (automatic corrections, white balance, tone, noise, etc.).

2. If you want to send a batch of images to the Nik Collection, whether it’s a batch process (all plug-ins) or an HDR merge (HDR Efex Pro 2), make sure you have selected them all in the Image Explorer.

3. Click on the **Nik Collection** button.

4. In the Plugin Selector, click the button for the desired plug-in.

5. The plugin will open.

6. Process your image in the plugin.

7. When finished, click **Save** or **Save all** if there are multiple images (or **Apply...** for Silver Efex Pro 3 and Viveza 3) at the bottom right.

8. Your processed image will return to DxO PhotoLab.

   • If you start from a folder, the return image from the Nik Collection will appear next to the original with the same name, with the suffix _Nik added, the extension depending on the file format chosen in the settings.

   • If you start from a project, the return image from the Nik Collection will not be directly visible, as it is not automatically assigned to that project. To view both the original and the processed image in the Nik Collection, right-click the original and select **View Image Folder.**
Selecting a Nik Collection plugin from DxO PhotoLab
* In a standard workflow, the Nik Collection’s return image processing can no longer be changed. If you want to take advantage of this feature from DxO PhotoLab, see Non-
destructive workflow.
Adobe Lightroom Classic

The Nik Collection is one of the very first external editors made available for Adobe’s workflow program. Please note that the Nik Collection is only compatible with Lightroom Classic, as the cloud variant, Lightroom (formerly Lightroom CC), does not currently have an interface for plugins. In this section, we discuss:

- External editing preferences
- Recommended settings
- Standard workflow
- Smart Copy/Paste
- Workflow with HDR Efex Pro 2
- Non-destructive workflow

External editing preferences

To change the default settings after installing the Nik Collection or to set the files that will be transferred to the Nik Collection as desired:
1. Open the Lightroom Classic Preferences (PC: Edit menu, Mac: Lightroom Classic menu).

2. Go to the External Editing tab.

3. In the Additional External Editor section, select one of the Nik Collection plugins from the Preset list.

4. Choose from among the following settings:

   - **File format**: Choose TIFF, PSD, or JPEG.
   - **Color Space**: Choose Prophoto RGB, Adobe RGB (1998), P3 Monitor, or sRGB.
   - **Depth**: Select the depth per R, G, and B channel, either 16-bit (TIFF and PSD) or 8-bit (TIFF, PSD, and JPEG).
   - **Resolution**: 240 (leave as is).
   - **Compression**: TIFF format only; LZW or ZIP methods are available to save disk space.

5. In the Preset menu (see step 1), the plugin name is followed by: (modified). Go to the very bottom and select Update Preset.

6. For other plugins, repeat steps 1 to 6*.

7. In the Stack with Original section, select the checkbox to allow the processed image to be returned to the Nik Collection with the original as an expanded stack.

8. If you wish, you can create your own suffix in the Edit Externally File Name section. Otherwise, the suffix _Modify will be added to the original file name to form the name of the file processed in the Nik Collection.

9. Exit Preferences (no restart required).

* You can leave the External Editing Preferences as they are, and configure the files in the dialog box that appears when transferring from Lightroom Classic to one of the Nik Collection’s plugins (see the paragraph about Standard workflow below).

### Recommended settings

For a maximum quality workflow, especially if you plan to do further processing and retouching later, or to provide documents of the highest quality:

- 16-bit TIFF format (for universality) or 16-bit PSD format (specific to a workflow with Photoshop)
- Adobe RGB Space (1998)
- Do not change the resolution

For maximum quality workflow, but no further processing planned:
### JPEG format, 75-100% compression

- sRGB space
- Do not change the resolution

For a standard workflow, with no further processing planned, for Facebook broadcast, or emailing:

- JPEG format, 65-75% compression
- sRGB space
- Do not change the resolution

---

* In general, when processing images in the Nik Collection, maintain maximum quality workflow. You will be able to modify your files afterwards, depending on their usage, during the export phase in Lightroom Classic.

---

## Standard workflow

The step-by-step procedure explained here concerns exchanges between Lightroom Classic and all the plugins of the Nik Collection, with the exception of HDR Efex Pro 2 (see the HDR Efex Pro 2 sub-section below).

### From a RAW file

The workflow with RAW files, as well as DNGs generated by cameras, requires the creation of a TIFF, PSD, or JPEG file, depending on the settings in Lightroom Classic's external editing preferences (which implies output from a RAW stream):

1. Make basic corrections to your originals.
2. In a folder or collection, select one or more images.
3. Right-click, and from the cascading menus, choose **Edit in** and select the desired plugin.
4. In the **Retouch Photo(s) with** dialog box:
   - Only the **Edit a Copy with Lightroom Adjustments** option is available. In this case, Lightroom Classic will generate a file according to the options in the External Editing Preferences, to which it will apply any corrections made beforehand.
   - By deploying the **File Copy Option** arrow, you can change your external editing preferences.
5. Click on **Edit**.
6. The images will open in the selected plugin.
7. Process your images.
8. Click on **Save** or **Save all** if there are multiple images (or on **Apply...** for Silver Efex Pro 3 and Viveza 3) at the bottom right. The plug-in closes, your images return to Lightroom Classic,
stacked with their originals in the original folder or collection, with the file name followed by the suffix set in the External Editing Preferences.

Selecting an external editor in Lightroom Classic

Edit Photo with Silver Efex Pro 3

What to Edit

- **Edit a Copy with Lightroom Adjustments**
  
  *Apply the Lightroom adjustments to a copy of the file and edit that one. The copy will not contain layers or alpha channels.*

- **Edit a Copy**
  
  *Edit a copy is not applicable to raw or Digital Negative files.*

- **Edit Original**
  
  *Edit Original is not applicable to raw or Digital Negative files.*

Copy File Options

[Cancel] [Edit]
External editing options

Processing an image in the selected external editor (25th anniversary preset — Hint of Blue, Silver Efex Pro 3)
Processed image returned to Lightroom Classic

From a TIFF, PSD, or JPEG file

Several scenarios are possible here, as your TIFF, PSD or JPEG files may come from other sources, unless they are files that you have already processed in the Nik Collection:

1. In a folder or collection, select one or more images.

2. Right-click and, from the cascading menus, choose Edit in and then select the desired plugin.

3. In the Retouch Photo(s) with dialog box, select one of the following options:

   - **Edit copy with Lightroom corrections**: A copy of the selected file(s) will be created (and if you have corrected these files in Lightroom, the corrections will be applied to the copy or copies).

   - **Modify a copy**: The copy created will not include any corrections made in Lightroom Classic.

   - **Modify the original** transfers the selected file(s) as is, without creating a copy.

   - By deploying the File Copy Option arrow, you can change your external editing preferences (unless you have modified the original).

4. Click on Edit.

5. The images open in the selected plugin.


7. Click on Save or Save all if there are multiple images (or on Apply... for Silver Efex Pro 3 and Viveza 3) at the bottom right. The plug-in closes, your images return to Lightroom Classic, stacked with their originals in the original folder or collection, with the file name followed by the suffix set in the External Editing Preferences.
Edit Photo with Silver Efex Pro 3

What to Edit

- **Edit a Copy with Lightroom Adjustments**
  
  *Apply the Lightroom adjustments to a copy of the file and edit that one.
  *The copy will not contain layers or alpha channels.

- **Edit a Copy**
  
  *Edit a copy of the original file.
  *Lightroom adjustments will not be visible.

- **Edit Original**
  
  *Edit the original file.
  *Lightroom adjustments will not be visible.

▶ Copy File Options

---

Copyright © 2021 DxO
Smart Copy/Paste

Smart Copy/Paste mode is a great way to speed up workflow with the ability to apply the latest corrections made in the Nik Collection by DxO to a batch of images ready to be exported by Lightroom Classic. There are two scenarios: copy/paste settings within Lightroom Classic, and copy/paste via the Export menu.

Scenario 1: Copy/paste settings to remaining images in Lightroom Classic

Process the image and copy the settings:
In Lightroom Classic, select a photo and process it in one of the plugins of the Nik Collection by DxO.

Once the processed image is back in Lightroom Classic, right-click on it (be sure to do this on the TIFF or JPEG image coming back from the plugin, not on the original Raw file).

In the context menu, go to **Export > Nik Collection** and select **Copy and apply**.

In the dialog box, click on the **Copy** button that corresponds to the plugin you are using.

The dialog box shows the name of the file from which the associated effects and settings are copied.

Click on **OK**. The dialog box closes.

Paste the settings to the destination image:
Workflows

1. Open in Reference View
   - Set as Reference Photo
   - Lock to Second Monitor
   - Show in Finder
   - Go to Folder in Library

2. Export...
   - Export with Previous
   - Lightroom Presets
     - Burn Full-Sized JPEGs
     - Export to DNG
     - For Email
     - For Email (Hard Drive)
   - DxO
   - HDR Efex Pro 2
   - Nik Collection

Copy and Apply Parameters

User Presets
- JPEG 2048 Q100 NetStd sRVB
- JPEG TailleMax Q100 sRVB
- TIFF 8bits Adobe98
1. In Lightroom Classic, select the destination image (or images).
2. Right-click and, in the context menu, go to Export > Nik Collection > Copy and Apply.
3. In the dialog box, click on the Apply button that corresponds to the plugin you are using.
4. A dialog box offers you to create a copy. If the destination images are Raw files, only the Edit a copy with Lightroom adjustments option will be available, if the destination images are bitmap files (TIFF, JPEG, etc.), all options will be available, and will allow you to either create a copy or edit the destination image itself.
5. Click on Run.
6. A series of progress bars from Lightroom Classic and the Nik Collection will show you the current process (no Nik Collection by DxO plug-ins will open). If the destination images are Raw files, Lightroom Classic generates the image copies and the Nik Collection by DxO effects are applied (if the destination images are bitmap files, the effects will be applied according to the option chosen in step 4).

7. If you started from a Lightroom Classic folder (and not a collection), the processed images are automatically stacked with the starting image, but the stack is expanded to display the results.

**Scenario 2: Copy and paste parameters via the Export menu**

Process the image and copy the parameters:
Nik Collection Copy & Apply

Effect will be copied from DJI_0129-Modifier-7.tif

HDR Efex Pro  Copy  Apply
Silver Efex Pro  Copy  7 Apply  from DJI_0129-Modifier-7.tif
Color Efex Pro  Copy  Apply
Analog Efex Pro  Copy  Apply
Viveza  Copy  Apply
Dfine  Copy  Apply
Sharpen output  Copy  Apply
Presharpen  Copy  Apply

Apply to DJI_0129-Modifier-7.tif

Cancel  OK
1. In Lightroom Classic, select a photo and process it in one of the plugins of the Nik Collection by DxO.

2. Once the processed image is back in Lightroom Classic, right-click on it (be sure to do this on the TIFF or JPEG image coming back from the plugin, not on the original Raw file).

3. In the context menu, go to **Export > Export...**

4. In the Export menu, click on the **Nik Collection > Copy and Apply Parameters** preset in the left column.

5. The Export menu reconfigures and gives you two options, File Name and Image Sizing.

6. Click on **Export** at the bottom right.

7. A dialog box shows the name of the file from which the effects and associated settings are copied. Click on Copy.

8. Click on **OK**. The dialog box closes.

Paste the settings to the destination image:
Workflows

Export 2 Files

Preset:
- Lightroom Presets
- DxO
- Nik Collection
- Copy and Apply Parameters
- User Presets

Export To: Nik Collection

3

File Naming
- Rename To:
- Start Number:
- Example: DJI_0125.tif
- Extensions: Lowercase

Image Sizing
- Resize to Fit: Width & Height
- Don’t Enlarge
- Resolution: 240 pixels per inch

Add Remove

Plug-in Manager...

Done Cancel Export

Nik Collection Copy & Apply

Effect will be copied from DJI_0125.DNG

HDR Efex Pro Copy Apply

Silver Efex Pro Copy Apply from DJI_0129-Modifier-7.tif

Color Efex Pro Copy Apply

Analog Efex Pro Copy Apply

Viveza Copy Apply

Dfine Copy Apply

Sharpen output Copy Apply

Presharpener Copy Apply

Apply to 2 images

4

5

Copyright © 2021 DxO
Apply parameters with Silver Efex Pro

What to Edit

- Edit a Copy with Lightroom Adjustments
  Apply the lightroom adjustments to a copy of the file and edit that one
  The copy will not contain layers or alpha channels
  NOTE: For RAW images the copy will be in TIFF format

- Edit a Copy
  Edit a copy of the original file
  Lightroom adjustments will not be visible

- Edit Original
  Edit the original file
  Lightroom adjustments will not be visible

Run

Applying parameters with Silver Efex Pro

Processing image 1 of 2

Loading...
Nik Collection Copy & Apply

Effect will be copied from DJI_0125.DNG

<table>
<thead>
<tr>
<th>Effect</th>
<th>Copy</th>
<th>Apply</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDR Efex Pro</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Silver Efex Pro</td>
<td></td>
<td>from DJI_0129-Modifier-7.tif</td>
</tr>
<tr>
<td>Color Efex Pro</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Analog Efex Pro</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Viveza</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Define</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sharpen...r output</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Presharpen</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Apply to 2 images

[Image of thumbnails of images]
1. Select the destination image (or images).

2. Right-click and in the context menu, go to Export > Export...

3. In the Export menu, you should find the configuration of the copy step. If not, click in the left column on the Nik Collection > Copy and Apply Parameters preset.

4. Click on Export at the bottom right.

5. A dialog box shows the name of the file from which the effects and associated settings are copied, and the name of the destination image. Click on Apply.

6. A new dialog box informs you that a copy of the destination image will be created.

7. Click on Run.

8. Progress bars indicate that the copy of the image is being created and that the Nik Collection processing is being applied.

9. Click on OK to close the dialog box for applying the processing (Step 5).

10. If you started from a Lightroom Classic folder (and not a collection), the processed images are automatically stacked with the starting image, but the stack is expanded to display the results.

**Workflow with HDR Efex Pro 2**

The workflow for merging photos with HDR Efex Pro 2 is unique and does not go through the Edit In cascading menu, but rather through the Export menu. There is also a more direct access. Via the Export menu

1. Make basic corrections to your originals.

2. In a folder or collection, select the images to be merged.

3. Right-click, and in the cascading menus, choose Export and then Export….

4. From the Export menu, you can access commands to transfer to HDR Efex Pro 2 in two ways:

   - **Export to**: From the list at the very top of the Export menu, select HDR Efex Pro 2.
   - **HDR Efex Pro 2 preset**: In the Export Presets column on the left, open the HDR Efex Pro 2 section and click on the HDR Efex Pro 2 preset.

5. Verify the settings or change them as desired in the File Settings section on the right.

6. Click on Export at the bottom right.

7. A dialog box prompts you to choose between processing the originals directly, or creating a copy with the Lightroom settings. Select the desired option and then click Edit.
8. Lightroom Classic generates the files according to the settings in step 5.

9. The **Merge Settings** window opens. Create the HDR image, edit it in HDR Efex Pro 2, and then click on **Save**, or if there are several images, on **Save all**, at the bottom right.

10. Lightroom Classic automatically switches to a collection labeled with the return date and time, within a collection set named HDR Efex Pro 2, to display the created image. In the original folder or collection, the HDR image is stacked with the originals, and the file name has the suffix _HDR.

*Images Chris Gorman*

---

**Selecting the images to merge**
Selecting the mode for exporting files to HDR Efex Pro 2

Selecting the file format
The HDR Efex Pro 2 Merge Settings window

Processing and then saving in HDR Efex Pro 2
Direct access

To transfer images to be merged into HDR Efex Pro 2 without going through the Export menu:

1. Select the images.
2. Right-click and from the cascading menus, select Export and then HDR Efex Pro 2.
3. Follow the steps in the Via the Export menu section above.
Non-destructive workflow

From Lightroom Classic, you can benefit from two reversible workflows, one via Photoshop, the other via the Nik Collection.

Reversible workflow via Photoshop (smart objects)

First processing:
1. In Lightroom Classic, make basic corrections to your originals.
2. From a folder or collection, select the image(s) to be processed in the Nik Collection.
3. Right-click and, from the cascading menus, choose **Edit in** and then **Open as Smart Object in**.
Photoshop.

4. The image will open as a smart object in Photoshop.

5. Process the image in the Nik Collection with the reversible Photoshop workflow, as explained in the chapter Workflow with Adobe Photoshop.

6. When you return to Lightroom Classic, the processed image is stacked with the original.
The smart object in Photoshop

Processing in the Nik Collection (Preset 002 – Blue Hour in Viveza 3)
Modify the processing

1. In Lightroom Classic, select the previously processed image.

2. Right-click then Edit in and Edit in Adobe Photoshop (no need to reselect the smart object command). The image will open in Photoshop.

3. Follow the procedure as explained in the Workflow with Adobe Photoshop chapter, notably the part about how to reopen and resume processing in the Nik Collection.
4. After saving in the Nik Collection and then in Photoshop, the image returns to Classic Lightroom and its thumbnail is refreshed to show the modified processing.

Returning the image to Photoshop

Double-click on the smart filter to relaunch Viveza

Viveza 3
Changing the processing in Viveza 3 (here, preset 001 - Golden Hour)

The modified image in Viveza 3 (left), and image returned to Lightroom Classic (right)

The Nik Collection non-destructive workflow

In case you don’t have Photoshop or don’t want to use it, from Lightroom Classic you can take advantage of the reversible workflow offered by the Nik Collection (from version 3.0 onwards).
** For more information and to follow the steps of the reversible workflow with the Nik Collection, see the Non-destructive workflow page.
Serif Affinity Photo

The Serif program is an alternative to Adobe Camera Raw and Adobe Photoshop, and you can use the plugins from the Nik Collection by DxO in it, starting with version 1.8 for Affinity Photo, and version 2.5 for the Nik Collection.

Using Affinity Photo and the Nik Collection together requires a special installation procedure, which is described in the Installation, activation, and uninstallation page in the Configuration and installation chapter.

Workflow with Affinity Photo

To process your images in the Nik Collection by DxO in Affinity Photo:

1. In Affinity Photo, develop your RAW files or process your TIFF, PSD, JPEG, or other files as you normally do (basic corrections, etc.)

2. Go to Filters > Modules > Nik Collection and select the plugin you wish to work with.

3. Once you have finished working with the plug-in, click OK. The Nik Collection plug-in will apply processing and then close; the processed image is displayed in Affinity Photo.

4. If you want to return to the image at a later time, you can save it in Affinity Photo format (.afphoto extension) via the File > Save or Save as menu.

5. If you want to export your image, do so in the desired format by going to the File > Export menu.

Image: Chris Gorman
Image opened in Affinity Photo

Opening external plugins
Processing an image in the Nik Collection (Color Efex Pro 4)

Processed image returned to Affinity Photo
Standalone mode

You can use the Nik Collection by DxO plugins in standalone mode, without using a host application (Lightroom, Photoshop, etc.), as long as you use TIFF or JPEG files. This page presents the standalone mode specific to all Nik Collection plugins other than Silver Efex Pro 3 and Viveza 3.

Note that on a PC, Dfine 2 and Sharpener Pro 3 keep (for the moment) the particularities of the original interface of the Nik Collection.

Perspective Efex also has its particularities and its menus in standalone mode are the same as in plugin mode. See the Perspective Efex Interface page.

- Standalone mode (PC)
- Standalone mode (Mac)
- The menu bar (PC)
- The menu bar (Mac)

Provided you are opening a TIFF file, you can use the reversible workflow available in standalone mode from version 3.0 and later of the Nik Collection by DxO. For more information, see Non-destructive workflow.

Standalone mode (PC)
Analog Efex Pro 2, Color Efex Pro 4, and HDR Efex Pro 2 plugins

1. You can launch any of the Nik Collection plugins directly in one of the following ways:

   - In the Windows Start menu, go to the DxO Nik Collection folder and click on the icon of the desired plugin.

   - Right-click on an image and then in the cascading menus, select Open with and select a plugin.

2. The selected plugin opens.

3. If you have opened the plugin directly, without an image, click on the Open button at the top left.

4. A system dialog box allows you to select an image to open.

5. Edit your image as desired.

6. Click on Save on the bottom right: the processing is applied to the image, the plugin closes.

7. The processed image remains in the same format as when it was opened (JPEG > JPEG, TIFF > TIFF).

Dfine 2 and Sharpener Pro 3 (RAW PreSharpener and Output Sharpener) plugins

1. You can launch any of the Nik Collection plugins directly in one of the following ways:

   - In the Windows Start menu, go to the DxO Nik Collection folder and click on the icon of the desired plugin.

   - Right-click on an image and then in the cascading menus, select Open with and select a plugin.

2. The selected plugin opens.

3. If you have opened the plugin directly, without an image, click on the Open button at the top left.

4. A system dialog box allows you to select an image to open.

5. Edit your image as desired.

6. Click on Save on the bottom right: the processing is applied to the image, the plugin closes.

7. The processed image remains in the same format as when it was opened (JPEG > JPEG, TIFF > TIFF).

Standalone mode (Mac)
You can launch any of the Nik Collection plugins directly in one of the following ways:

1. Double-click on the icon.
2. Right-click on an image and then, in the cascading menus, **Open with** and select a plugin.

   3. The selected plug-in opens.
   4. If you have opened the plugin directly, without an image, go to the **File > Open Images** menu.
   5. A system dialog box allows you to select an image to open.
   6. Edit your image as desired.
   7. Click on **Save**: the processing is applied to the image, the plugin closes.

The processed image remains in the same format as when it was opened (JPEG > JPEG, TIFF > TIFF).

**The menu bar (PC)**

*Analog Efex Pro 2, Color Efex Pro 4 and HDR Efex Pro 2*
The menu bar allows you to access the features described here:

1. **File**:
   - **Open images**: allows you to open images via a system dialog box.
   - **Save Image As**: you create another version of the image, possibly in another format and saved in a different location.
   - **Exit**: closes the plug-in (a dialog box prompts you to save the changes made to the image).
   - **Save**: the treatment is applied to the image.

2. **Edit**:
   - **Last modification**: allows you to apply effects and corrections from the previous image or session (including after closing/reopening).

3. **Help**: contains the following links and commands (internet connection required):
   - User Guide (viewable online and downloadable as a PDF)
   - Frequently asked Questions
   - Online support
DxO Academy (webinars, tutorials, etc.)

Dfine 2 and Sharpener Pro 3 (RAW PreSharpener and Output Sharpener)

These two plug-ins, which inherit the original Nik Collection interface, do not have a menu bar, but rather buttons that are located at the top left:

1. **Open**: lets you open images via a system dialog.

2. **Last modification**: lets you open and apply effects and corrections to the previous image or session (even after closing/reopening).

**The menu bar (Mac)**

Analog Efex Pro 2, Color Efex Pro 4, Dfine 2, HDR Efex Pro 2, and Sharpener Pro 3 (RAW PreSharpener and Output Sharpener)
The menu bar at the top of the window contains the following menus:

1. **Name of plugin:**
   - **Exit**: closes the plugin.

2. **File:**
   - **Open**: lets you open images via a system dialog box.
   - **Save image as**: lets you create another version of the image, possibly in another format and saved in a different location.
3. **Edit:**

- **Last modified** allows you to apply effects and corrections from the previous image or session (including after closing/reopening).

4. **Help** contains the following links and commands (internet connection required):

- User Guide (viewable online and downloadable as a PDF)
- Frequently asked Questions
- Online support
- DxO Academy (webinars, tutorials, etc.)
Standalone mode for Silver Efex Pro 3 and Viveza 3

You can use the Nik Collection by DxO plug-ins in stand-alone mode, without using a host application (Lightroom, Photoshop, etc.), as long as you use TIFF or JPEG files. This page presents the standalone mode specific to the new Nik Collection 4 plugins Silver Efex Pro 3 and Viveza 3.

- Standalone mode (PC)
- Standalone mode (Mac)
- The menu bar (PC)
- The menu bar (Mac)

Provided you are opening a TIFF file, you can use the Nik Collection by DxO reversible workflow in standalone mode. For more information, see Non-destructive workflow.

Unlike the other plugins in the Nik Collection by DxO, Silver Efex Pro 3 and Viveza 3 allow you to open a mixture of JPEG and TIFF images in standalone mode.

Standalone mode on PC (Silver Efex 3 and Viveza 3)
Standalone mode: opening images by drag and drop (PC)

1. You can launch any of the Nik Collection plug-ins directly in one of the following ways:
   
   - Double-click on the icon of the desired plugin in the DxO Nik Collection folder in the Start menu, on the desktop alias, or on the plugin icon if you have it pinned to the Windows taskbar (at the bottom).
   - Right-click on an image and then, in the cascading menus, choose Open with and select a plugin.

2. The selected plugin opens.

3. If you have opened the plugin directly, without an image, you can:
   
   - Drag and drop your images into the interface.
   - Go to the File menu and select Open. A system dialog box allows you to choose the image or images to open.

4. Process your image as desired.

5. Click on Save in the File menu: the processing is applied to the image, and it remains in the same format as when it was opened (JPEG > JPEG, TIFF > TIFF), and in the same location.

6. If you want to create another version of the image, possibly in a different format and location, go to the File menu and select Save image as... . A system dialog box will prompt you
to choose your saving options.

7. If you have several images open and want to save all your changes at once, even if you have processed each one differently, select the Save All command from the File menu.

8. To exit the plugin, go to the File menu and choose Exit.

Standalone mode on Mac (Silver Efex 3 and Viveza 3)
1. You can launch any of the Nik Collection plugins directly in one of the following ways:

   - Double-click on the icon.
   - Right-click on an image and then, in the cascading menus, choose **Open with** and select a plugin.

2. The selected plug-in opens.

3. If you have opened the plugin directly, without an image, you can:

   - Drag and drop your images into the interface.
   - Go to the **File** menu and select **Open**. A system dialog box allows you to choose the image or images to open.
   - Use the keyboard shortcut Cmd+O (letter "O"). A system dialog box allows you to choose the image or images to open.

4. Process your image as desired.

5. Click on **Save** in the **File** menu: the processing is applied to the image, and it remains in the same format as when it was opened (JPEG > JPEG, TIFF > TIFF), and in the same location.

6. To save your image in another format (for example, from TIFF to JPEG) and/or in another location, select **Save as** from the **File** menu.
7. If you have several images open and want to save all your changes at once, even if you have processed each one differently, select the **Save All** command from the **File** menu.

8. To exit the plugin, go to the menu with the plugin's name and choose `Exit {{plugin name}}`.

**The menu bar on PC (Silver Efex Pro 3 & Viveza 3)**
When using any of the Nik Collection by DxO suite plug-ins, the menu bar allows you to access some of the features described here:

1. **File**:
   - **Open** allows you to open images via a system dialog box.
   - **Exit**: closes the plugin (a dialog box prompts you to save the changes made to the image).
   - **Save**: the treatment is applied to the image.
   - **Save image as**: lets you create another version of the image, possibly in another format and saved in a different location.
   - **Save all**: if you have opened several images, saves all the corrections, even if they vary from one image to another.
   - **Preferences**: opens the plugin options and settings window.

2. **Edit** includes the following commands:
   - **Undo**: undoes the last correction and then the previous corrections.
   - **Redo**: restores the last undone correction and then the previous ones.
   - **Apply Last Edit**: Applies the effects and corrections from the previous image or session (even after closing/reopening).

3. **Help** contains the following links and commands (internet connection required):
   - **User Guide** (viewable online and downloadable as a PDF)
   - **Frequently asked Questions**
   - **Online support**
   - **DxO Academy** (webinars, tutorials, etc.)
   - **Check for updates**
   - **About** (displays the home screen and plugin version number; click to close)

The menu bar on Mac (Silver Efex Pro 3 & Viveza 3)
The menu bar at the top of the window contains the following menus:

1. **Plugin name**: this menu, which has the name and version number of the plugin used, gives you access to the **Preferences**.
2. **File:**
   - **Open** allows you to open images via a system dialog box.
   - **Save**: the treatment is applied to the image.
   - **Save image as**: lets you create another version of the image, possibly in another format and saved in a different location.
   - **Save all**: if you have opened several images, saves all the corrections, even if they vary from one image to another.

3. **Edit** includes the following commands:
   - **Undo**: undoes the last correction and then the previous corrections.
   - **Redo**: restores the last undone correction and then the previous ones.
   - **Apply Last Edit**: Applies the effects and corrections from the previous image or session (even after closing/reopening).

4. **Help** contains the following links and commands (internet connection required):
   - **User Guide** (viewable online and downloadable as a PDF)
   - **Frequently asked Questions**
   - **Online support**
   - **DxO Academy** (webinars, tutorials, etc.)
   - **Check for updates**
   - **About** (displays the home screen and plugin version number; click to close)
Non-destructive workflow

Starting with the Nik Collection by DxO 3.0, you can take advantage of a reversible, non-destructive workflow, which allows you to resume or modify the processing you have done, under the following conditions:

1. Works with TIFF files only.
2. Can be used in all plugins except Perspective Efex.
3. Accessible via the following*:
   - Standalone mode
   - Workflow with DxO PhotoLab
   - Workflow with Adobe Lightroom Classic

* The reversible workflow of Nik Collection by DxO is not available in Serif Affinity Photo, nor in Adobe Photoshop, which has its own reversible workflow using dynamic objects (see the chapter on Workflow with Adobe Photoshop).

The principle of the reversible, non-destructive workflow is based on encapsulating a second TIFF file in the TIFF file generated during transfer from the host application to the Nik Collection (or during the workflow in standalone mode). This doubles the size of the file that contains an input TIFF, an output TIFF, and the parameters and settings applied in the Nik Collection.

To take advantage of this workflow in **Standalone mode**, simply check the **Save & allow to resume editing (larger files)** option next to the **Save** button.

You can access an information page about reversible flow by clicking on the ? button in the bottom right corner of the open plugin.

Non-destructive workflow with DxO PhotoLab

Faire le premier traitement :

1. Select a RAW, DNG or TIFF file in the Image Explorer.
2. Click on the **Nik Collection** button.
3. In the **Selector Plugin**, click **Settings**.
4. In the **Edit in** dialog box, choose **Process as TIFF and export** and confirm by choosing **OK**.
5. In the Plugin Selector, select the desired plugin (except Efex Perspective).
6. The image will open in the selected plugin
7. A dialog box will be displayed in two cases:
   - If it is a TIFF file, you are prompted to use the reversible workflow.
• If it is a JPEG file, you are prompted to use the TIFF format to take advantage of the reversible workflow.

• In both cases, you can select **Do not display again**.

8. Process your image.
9. Before saving, select the **Save & allow to resume editing (larger files)** checkbox. The checkbox is not active if your image is not in TIFF format.
10. Click on **Save** or **Save All** if there are several images (or **Apply...** for Silver Efex Pro 3 and Viveza 3) on the bottom right.
11. Processing is applied to the image, and then the plugin closes.
12. The processed image is visible in DxO PhotoLab.

Image: Gilles Theophile

Opening the image in the Nik Collection
Selecting TIFF format (required for non-destructive workflow)

Information message about the non-destructive workflow
Processing the image in the Nik Collection (in this case, Analog Efex Pro 2)

Saving with the intention of further editing
Modifying the processing (one or more images):

1. Select the return TIFF file from the Nik Collection.
2. Click on the **Nik Collection** button.
3. In the Plugin Selector, click on **Settings**.
4. In the **Edit in** dialog box, choose **Export selected file(s) without processing** and confirm by choosing **OK**.*
5. In the **Plugin Selector**, click on the plugin you used for the first processing. (If you choose another plugin this time, its effects combine with the effects applied during the first processing.)
6. The image will open in the selected plugin.
7. Modify the processing of your image.
8. Click on **Save**.
9. Processing is applied to the image, and then the plugin closes.
10. The processed image is visible in DxO PhotoLab.

* Choosing this option is crucial, because if you select one of the other two, you will not be able to change the processing.
** If you want to keep the ability to repeatedly change the processing of your image, make sure that you have checked the **Save and edit later** box.

Exporting selected files without processing (required for reversible workflow)

Processing modification in the plugin
Non-destructive workflow with Adobe Lightroom Classic

Performing the first processing (you can process one or several images):

1. Select a file.
2. Go to the **Edit in** cascading menu and select one of the Nik Collection plugins*.
3. In the **Edit Photo With...** dialog box, in the **File Copy Options** section, verify that the format is **TIFF**.
4. The image will open in the selected plugin.
5. A dialog box will be displayed in two cases:
   - If it is a TIFF file, you are prompted to use the reversible workflow.
   - If it is a JPEG file, you are prompted to use the TIFF format to take advantage of the reversible workflow.
   - In both cases, you can select **Do not display again**.
6. Process your image.
7. Before saving, check the **Save & allow to resume editing (larger files)** box.
8. Click on **Save** or **Save All** if there are several images (or **Apply...** for Silver Efex Pro 3 and Viveza 3) on the bottom right.
9. Processing is applied to the image, and then the plugin closes.
10. The processed image returns to Lightroom Classic, stacked with the original.

* Perspective Efex does not benefit from the reversible workflow. For HDR Efex Pro 2, access is via export (see Adobe Lightroom Classic page).

Opening the Nik Collection (Silver Efex Pro 3) from Lightroom Classic
**Edit Photo with Silver Efex Pro 3**

**What to Edit**

- Edit a Copy with Lightroom Adjustments
  
  Apply the Lightroom adjustments to a copy of the file and edit that one. The copy will not contain layers or alpha channels.

- Edit a Copy
  
  Edit a Copy is not applicable to raw or Digital Negative files.

- Edit Original
  
  Edit Original is not applicable to raw or Digital Negative files.

**Copy File Options**

- **File Format**: TIFF
- **Color Space**: Adobe RGB (1998)
- **Bit Depth**: 16 bits/component
- **Resolution**: 240
- **Compression**: None

[Button] **Cancel**  
[Button] **Edit**

*Lightroom Classic dialogue box showing editing options*

*Information message about the reversible workflow*
Processing the image in Silver Efex Pro 3

Box to check for reversible workflow ("save and edit later")
Modifying the processing (one or more images):

1. Select the TIFF file from the Nik Collection.
2. Go to the **Edit In** cascading menu and select the plugin used in the first processing.
3. In the **Process Photo With...** dialog box, select **Edit Original** or **Edit Copy**.
4. The image opens in the selected plugin.
5. Modify the image processing as desired.
6. Make sure the **Save & allow to resume editing (larger files)** checkbox is checked, otherwise uncheck it if you do not plan to resume editing again.
7. Click on **Save**.
8. The processing is applied to the image, and then the plug-in closes.
9. The processed image returns to Lightroom Classic, stacked with the original.

* The **Edit Copy with Lightroom** corrections option does not restore reversibility of processing.

** You can re-edit the image as many times as you like, as long as you do not uncheck the **Save & allow to resume editing (larger files)** box.
Selecting and opening the image in the Nik Collection (Silver Efex Pro 3)
The two options to retain for the non-destructive workflow:

- **Edit a Copy with Lightroom Adjustments**
  - Apply the Lightroom adjustments to a copy of the file and edit that one.
  - The copy will not contain layers or alpha channels.

- **Edit a Copy**
  - Edit a copy of the original file.
  - Lightroom adjustments will not be visible.

- **Edit Original**
  - Edit the original file.
  - Lightroom adjustments will not be visible.

---

**Copy File Options**

- **File Format:** TIFF
- **Color Space:** Adobe RGB (1998)
- **Bit Depth:** 16 bits/component
- **Resolution:** 240
- **Compression:** None

---

[Cancel]  [Edit]
Modifying the processing in Silver Efex Pro 3

Processed image returned to Lightroom Classic
Workflow with Adobe Photoshop
Accessing the Nik Collection from Adobe Photoshop

In Photoshop, there are several ways to access the Nik Collection by DxO plugins, starting with the Filter menu, then the reversible workflow with smart objects and filters, and finally the special case of HDR Efex Pro 2.

- Opening an image in the Nik Collection from the Filter menu
- Launching HDR Efex Pro 2
- Converting to a smart object

Opening an image in the Nik Collection from the Filter menu

After opening your image in Photoshop*:

1. Go to the Filter menu, then go to the Nik Collection sub-menu.
2. Select one of the Nik Collection plugins.
3. The image will open in the selected plugin.
4. Perform your processing and corrections.
5. Click on Save (or Apply for Silver Efex Pro 3 and Viveza 3).
6. The plugin applies processing and then closes.
7. Your processed image is displayed in Photoshop.
8. Save or Save As (to create another file), then exit Photoshop.

* This procedure applies to both Photoshop and Photoshop Elements.

You can also process your images in the Nik Collection through Photoshop from your host application, such as DxO PhotoLab or Adobe Lightroom Classic (see the respective pages).

* Image: Chris Gorman
Accessing the Nik Collection in Photoshop's Filter menu

Processing in the Nik Collection (Silver Efex Pro 3)
Launching HDR Efex Pro 2

The case of HDR Efex Pro 2, which allows image merging, is special, and you don’t need to have the images already open in Photoshop*:

1. Go to the File menu, then go to the Automate sub-menu.
2. Select Merge to HDR Efex Pro 2. HDR Efex Pro 2 will open, along with a dialog box for selecting images.
3. Click Open, which will open a system dialog box.
4. Locate and select the images you wish to merge, and then click OK. The HDR Efex Pro 2 dialog box will display a list of the selected images.
5. To remove an image from the list, click on the file name and then click on Remove.
6. The Add Open Files button allows you to select images already open in Photoshop.
7. If you wish to switch to a reversible workflow, check Create Smart Object*.
8. Click on Merge Dialog. The dialog box for creating HDR files** opens.
9. After selecting the options you need, click Create HDR. The images are merged, and the HDR image opens in HDR Efex Pro 2.
10. When you are finished processing, click **Save**. The image processed in HDR Efex Pro 2 will display in Photoshop.

* Smart objects are not available in Photoshop Elements.

** For more information on the content and options of the HDR Merge dialog box, see the Merging images page in the HDR Efex Pro 2 chapter.
Selecting files in HDR Efex Pro 2

Images: Chris Gorman

Preparing to merge in HDR Efex Pro 2
Merging and then processing in HDR Efex Pro 2

Processed photo returned to Photoshop

Converting to a smart object

In Photoshop, a smart object* is a layer that encapsulates the original image, providing a non-
destructive and reversible workflow, and plugins in the Nik Collection by DxO are compatible with that workflow. This means you can make corrections or apply a rendering to the image, which you can modify as you wish, after saving and even after closing the applications.

Converting your image to a smart object and then processing it in a Nik Collection plugin

1. Open the image in Photoshop**.

2. In the Filter menu, select **Convert for Smart Filters**. A dialog box informs you that the selected layer (the background layer of your image) will be converted to a smart object (you can disable this dialog).

3. Click on **OK**. Your image is converted to a smart object, the background layer is renamed **Layer 0**, and an icon appears in the thumbnail in the **Layers** panel.

4. Go to the Filter > Nik Collection menu and select the desired plugin***. A dialog box confirms that the selected plugin has detected that it is a smart object (you can disable its display).

5. Work on your image in the selected plugin, then click **OK** (or **Apply** for Silver Efex Pro 3 and Viveza 3). The plugin closes and the processed image is displayed in Photoshop; in the **Layers** panel, a filter effect thumbnail is displayed below Layer 0 with the name of the plugin used below it.

6. Save and exit Photoshop.
Converting to smart object
Selecting a plugin and warning message about smart objects
Processing image in Color Efex Pro 4

Processed image returned to Photoshop
Re-editing your processing

1. Open the processed image in Photoshop.

2. In the Layers panel, double-click the plugin name below the thumbnail of the filter effect. The plugin used to process this image will open.

3. Modify or even completely reprocess the image, as you wish.

4. Click on OK (or Apply for Silver Efex Pro 3 and Viveza 3).

5. The plugin closes and the processed image is displayed in Photoshop.

6. Save and exit Photoshop.

![Image of Layers panel showing Smart Filters](image-url)

*Reopening the Color Efex Pro 4 smart filter*
Modifying the processing in Color Efex Pro 4

Returning the image to Photoshop after modifying the processing

Permanently applying processing

1. If it is not already the case, open the image in Photoshop.
2. In the **Layer** menu, select **Flatten Image**. The mask of the filter is Layer 0 will form only a background layer; at this point, the processing is no longer reversible.

3. Save and exit Photoshop.

* Lightroom Classic allows you to open images as smart objects in Photoshop (see the Adobe Lightroom Classic page in the Workflows chapter).

** Applies only to Photoshop (Photoshop Elements does not offer workflows with smart objects and filters).

*** HDR Efex Pro 2 can be accessed through the File > Automation menu, and offers its own option for working as a smart filter.
Thanks to its Selective Tool 2, Meta-presets, and Brush tool, the Nik Collection by DxO allows you to take your workflow and integration with Photoshop and Photoshop Elements even further, allowing you to:

- Launch any of the plug-ins.
- Apply treatments directly without opening a plug-in.
- Apply the last treatment used in a plug-in.
- Apply a Meta-Preset, i.e. a preset combining several plug-ins.
- Apply locally, in Photoshop, the treatments and certain corrections of the suite using the Brush tool.

Selective Tool 2
The Selective Tool 2 is a floating palette that is part of the Nik Collection, where you will find a list of plugins, with direct access to some predefined tools and effects, as well as a communication section, where you will find information and updates.

Interface and handling
The floating palette is automatically displayed in Photoshop. You can change this behavior:
1. Park the Selective Tool at the bottom left in Photoshop: Click on the "-" (minus) sign at the top left.

2. Show the Selective Tool again: Click the window reset sign.

3. Display only the plugin icons: Click on the 3rd icon, top left (and vice-versa to restore full display).

4. Close the Selective Tool: Click on the "X".

5. Open or reopen the Selective Tool: In the File menu of Photoshop, go to Automate, then select Nik Selective Tool 2.

6. Reveal section contents: use the scroll bar, on the right, the mouse wheel or the trackpad.

7. Show/hide the contents of each section: Click on the chevron on the right.

8. Move the Selective Tool: Grab the top bar.
Preferences and help

Preferences

To access the Selective Tool 2 Preferences, click on the gear at the bottom left:

1. General section:
   - **Open Selective Tool automatically on launch**: Check or uncheck the box to enable / disable the automatic display of the Selective Tool when opening Photoshop (automatic display is enabled by default).

2. Filters section:
   - **Apply filter to**: Apply filters and image processing to either the composite image or the active layer.
   - **Apply Brush effect**: Apply the effects with the Brush tool to the current layer or to
another layer.

- **Apply Favorite Filters, Recipes & Last Edit:** Apply Favorite filters and effects or the last edit either directly in Photoshop or by opening the relevant plugin.

**Help**

Click on the "?" button at the bottom right to access the Selective Tool 2 user guide.

**Use**

The Selective Tool allows you to perform the following operations and tasks:

- Launch one of the Nik Collection by DxO plugins.
- Apply a favorite preset, filter, or recipe, without having to open one of the plugins, which saves you time if you have many images to process.
- Apply the latest processing done with a plugin.

For information about features specific to Dfine 2, see the Brush Tool section below.

**Launching a plugin**
Workflow with Adobe Photoshop

1. Nik Collection Selective Tool
   - Dfine 2
     - Noise Reduction
   - Viveza 3
     - Adjust color & tonality
   - Perspective Efex
     - Correct perspective
   - HDR Efex Pro 2
     - Merge - multiple exposures
   - HDR Efex Pro 2
     - Tone mapping - single image
   - Color Efex Pro 4
     - Color filters & creative effects
   - Analog Efex Pro 2
     - Classic cameras & film effects
   - Silver Efex Pro 3
     - Black-and-white photography
   - Sharpener Pro 3
     - RAW Pre-sharpener
   - Sharpener Pro 3
     - Output Sharpener
   - Meta-presets
     - Sequence of Nik presets

2. Loupe & Histogram

3. OK
To process an image with one of the plugins of the Nik Collection while in Photoshop:

1. Go into the Selective Tool.
2. Click on one of the buttons to select a plugin. The chosen plugin opens.
3. Process your image, then save it by clicking on OK (in Viveza 3 and Silver Efex Pro 3, click on Apply).
4. After it is returned to Photoshop, the processed image is its own layer.

Directly applying a favorite preset, filter, or recipe:
You can apply a preset, filter, or recipe without opening its associated plugin, as long as you have selected it as a Favorite* in the plugin**:

1. Go into the Selective Tool.
2. Click the arrow to the right of the desired plugin button. A space opens below the button, where you can choose from among your favorite presets, filters, or recipes.
3. Click on the desired preset, filter, or recipe, which is immediately applied to the image.

* To create favorites that can appear in the Selective Tool, see the specific chapters for each Nik Collection plugin.

** Perspective Efex, RAW Presharpener (Sharpener Pro 3), and Viveza 2 do not allow you to create favorites, so you will not be able to apply favorites directly from them with the Selective Tool.
Applying a Last Edit:

Another time-saving feature is the ability to apply the very last edit you applied the last time you used a plugin*, without having to open the plugin:

1. Go into Selective Tool.
2. Click on the arrow to the right of the desired plugin button.
3. A space will open below the button.
4. Click on Last Edit.
5. The most recent processing is applied to the image.

* The Last Edit function is not available in Perspective Efex.
Meta-presets

Use

Image before processing with a Meta-preset
Selecting a Meta-preset
The applied Meta-preset

The Meta-presets included with Selective Tool 2 are sequences of presets saved as Photoshop Actions, and which simultaneously implement several corrections of several Nik Collection by DxO plugins. You will find them at the bottom of the Selective Tool 2, in the Meta-presets section.

To apply a Meta-preset, hover the mouse over the tile of your choice, then click on the playback arrow. The chosen effect is applied directly to the image, without opening the relevant plugins. The tile is accompanied by the plugin icons of the Nik Collection by DxO used for the Meta-preset (for example, the Fine and Specular Meta-preset combines Color Efex Pro 4 and Viveza 3).

You cannot directly intervene in the settings (unless you convert your image to a dynamic object; see Advanced use below) nor create Meta-presets. To obtain information on Meta-presets, move the mouse over one of the blocks and click on the “?” that appears.

Advanced use
If you want to change the effect of a Meta-preset, first convert your image into a dynamic object:

1. In the Photoshop Layers panel, right-click on the background layer (your image).
2. In the contextual menu, select Convert to dynamic object.
3. The image is converted, the layer is named Layer 0 and the thumbnail displays the
Once converted to a dynamic object, apply a Meta-preset to the image. After application, the Layers panel displays the following information:

4. Filter effect indication (a filter has been applied to your image).
5. White thumbnail of the dynamic filter effects mask (the effects applied by the Nik Collection).
6. The list of filters and associated Nik plugins, and the modification pictogram for each of them (4).

To modify the effects and corrections applied, you have two possibilities: merge options or opening the plugins.
Merge options:

7. Double-click on the edit icon.
8. The Merge Options window of the respective filter opens.
9. You can change the blend mode (Mode menu)...
10. ...and/or refine the opacity, which consists of adjusting the intensity of the effect (the lower the opacity, the lighter the effect).
Opening plugins

11. Double-click on the name of the filter (and therefore of the plugin).
12. The plugin will open and allow you to partially or completely modify the effects, corrections, and settings.

Brush tool

When using the Nik Collection by DxO in Photoshop, a Brush button is visible at the bottom of
the plugin window you are currently using, next to the Undo and Save buttons. The Brush button is not visible when using the Nik Collection from a host application such as DxO PhotoLab or Adobe Lightroom Classic. It is a tool specific to Photoshop and Photoshop Elements*. It will allow you to apply your treatments and effects locally**, painting into the image opened in Photoshop. You can apply artistic or creative effects, but the real interest of this function is to be able to make more technical corrections, such as enhancing the sharpness or reducing noise with Dfine 2 (see below).

* The Brush button activates the Brush tool in Photoshop and Photoshop Elements.

** The Brush button is not available in Efex Perspective.

SECOND IMAGE IS IN FRENCH

Operating principles
To locally process with one of the Nik Collection plugins:

1. Open the plugin of your choice, either through the Filter menu in Photoshop or with Selective Tool 2.

2. After opening the plugin, choose the processing to apply.

3. At the bottom of the plugin window, click the Brush button. The plugin will close. Photoshop automatically generates a layer and a black fusion mask to paint the process (view in the Layers panel).

4. Photoshop’s Brush tool is activated automatically (you can set it in the options bar at the top). Paint into the image to apply the processing.
5. A floating window from the Selective Tool offers you the following options:

- **Brush** button, enabled by default, to apply the processing.
- **Eraser** button, to locally erase the processing applied with the brush.
- **Fill** button, to apply the processing to the entire image or to a selection made with one of the Photoshop tools.
- **Erase** button, to completely remove the application of processing.
- The **Apply** button, to apply the correction permanently (which also causes the layers to be flattened).
- The **Undo** button, to cancel the operation and close the floating window.

You can cumulate different uses of the brush, including with several plugins one after the other, or several times with the same plugin, but with a different or complementary treatment, by repeating the above steps. Each time you use the Brush mode, Photoshop will automatically create a layer and a black fusion mask.

**Corrections specific to Dfine 2**

Dfine 2 also comes with seven additional noise correction tools, each designed to work on specific details. These tools have no settings or parameters, as they are designed to be applied selectively, and provide optimal noise reduction for each of the different types of details or cases offered. These tools are available only in Selective Tool 2 and their use does not launch Dfine 2:
1. **Background** applies noise reduction to the background of the image.

2. **Hot Pixels** minimizes unwanted, hot, or dead pixels visible as bright spots in the image, especially in the darkest areas of the image.

3. **Fine Structures** reduces color noise and contrast noise, while preserving details such as hair and fine image structures.

4. **Skin**: Applied to the skin, it reduces both color and contrast noise and unevenness, while preserving details.

5. **Sky** reduces color noise and smoothes out artifacts that appear in the blue sky.

6. **Shadows** reduces color noise, especially in dark and dimly lit areas, preserving detail and structure.

7. **Strong Noise** is used on images taken at high sensitivity, with high levels of contrast noise, again preserving details as best as possible. It is an alternative to the selective blur technique, which affects detail and color.
Image: Gilles Theophile

Applying a Dfine 2 noise reduction filter (Strong Noise)
Analog Efex Pro 2
Analog Efex Pro 2

With the Analog Efex Pro 2 module, you can immerse yourself in the past and delight in nostalgia by simulating a large number of vintage cameras and shooting techniques, and by combining a plethora of well-designed and realistic camera and lens effects, film types, and paper prints — including their intrinsic (and often charming) flaws.
Analog Efex Pro 2 settings and help

Analog Efex Pro 2 settings let you make choices affecting the interface, GPU acceleration, and image output, and gives you access to the online user guide:

- **Interface settings**
- **Image output**
- **Help**

### Interface settings

After launching Analog Efex Pro 2, click on the **Settings** button in the lower left corner. In the floating window, you can open one of the sections by clicking on its banner, starting with **Interface settings**:

- **Interface Language**: Allows you to choose from one of 17 languages. By default, the language selected is that of your operating system.
• **Default Preview Mode***: Allows you to choose how images will be displayed when you open the app, either **Display single image**, or **Split preview** (the image is separated by a line, with Before corrections on the left, After corrections on the right), or **Preview side by side** (the two versions of the image, before and after corrections, are displayed next to each other).

• **Default Background Color***: Determines the appearance of the background, white, gray, or black.

• **Default Zoom Status***: Sets the zoom value that will be applied to the image when you click the Zoom button (values from 6.25% to 400%).

*Changes take effect when you open the application the next time.*

For each of the default display options, if you select **Use last setting**, the setting from the previous session will be automatically applied.

**GPU**

The GPU (Graphics Processor Unit) section, which you can access by clicking on its banner, allows you to use your computer’s video card to perform calculations related to image processing, thus relieving the load on the main processor. To do this, check the **Use GPU for image processing** checkbox. You will also find information about your GPU’s make, model, memory, and driver version (if available) in this section.

**Image output parameters**

In this section, you can choose the settings for the output files after clicking on the **Image Output Settings** banner:

• **TIFF Compression**: Choose between **LZW*** or **ZIP*** compression methods if you want to reduce the size of your TIFF files. Otherwise, select **No Compression**.

• **TIFF saving type**: This is the method of storing image data in TIFF files. **Stripe** is the oldest and **Tiles** is newer and is designed for very large files. The Stripe setting is selected by default; leave it as is if you have no reason to change it.

• **JPEG Quality**: Adjusts the compression of JPEG files; the default setting is 80%. As you decrease the setting, with the slider to the left, the size of JPEG files will decrease, resulting in a gradual degradation of image quality.

* Both LZW and ZIP compression methods are lossless. The ZIP method produces smaller compressed files than the LZW method.
Improve the Nik Collection

If you want the program to transmit usage statistics, check the dedicated box, after opening the section by clicking on its banner. These statistics, which remain anonymous, allow DxO Labs developers to evaluate how users use the program, with the aim of developing and improving the product. Click the link below the checkbox to find out more about the improvement program (internet connection required).

To save your choices, click OK, otherwise click Cancel.

Help

To access the online help links, you can go to the Help menu or click on the Help button at the bottom left (Internet connection required):

- User guide
- Frequently Asked Questions (FAQs)
- Online Support (report problems and ask questions after creating a support ticket)
- DxO Academy (tutorials, videos, webinars)
- Getting Started
- Close/Open Instant Help
Analog Efex Pro 2 interface

Generally speaking, all the components of the Nik Collection suite share the same interface, except for a few details and elements. Analog Efex Pro 2 is composed of 5 distinct elements, and includes keyboard shortcuts (see table below):

1. The upper toolbar
2. The left panel
3. The image display area
4. The right panel
5. The lower toolbar

> Keyboard Shortcuts

You can find information and details about the Edit and Help menus on the Standalone mode page in the Workflows chapter; note that the File menu is inactive in plugin mode.

The upper toolbar

The upper toolbar contains the tools and commands related to the display of the image and
side panels.

1. **Hide or view adjustment panels**: Hide or reveal the left panel.

2. **Single image display**: Normal image display without separation and comparison.

3. **Split preview**: Divides the image in two with a vertical red line that you can move left or right, or toggle to horizontal mode by clicking the arrow at the top of the line, with the option of also moving the red line up and down. The left half (or upper half) represents the image as it was opened in the plugin, the right half (or lower half) represents the processed and corrected image. You can also zoom in and out of the image either with the browser or with the Hand tool by pressing the spacebar.

4. **Side-by-side preview**: The version before processing is displayed on the left, the version after processing is displayed on the right. You can also display the two versions of the image one above the other by clicking on the button in between. You can also zoom and move synchronously in the two images, either with the Browser or with the Hand tool, by pressing the spacebar.

5. **Compare**: By clicking this button, you can quickly compare the before- and after-correction versions of your image. You can use this tool only in Single image display mode (2).

6. **Zoom + / Zoom -**: Set to 100% by default, lets you zoom into the image. A floating window automatically displays the enlarged zone in the image; you can move this window either by clicking on it and dragging it, or by clicking on a different part of your image. By pressing and holding the spacebar, you can also use the Hand tool to move it. To return to normal view, click on the Zoom button again. The arrow lets you access different sizes, from 6.25% to 400%. You can also use the zoom and movement functions in split preview and side-by-side display modes.

7. **Change background color**: Click the button successively to change the background from medium gray to white, black, and back to medium gray so as to adapt the screen to the brightness of the image displayed (for example, you can darken the background to avoid too strong a contrast between a dark image and the interface).

8. **Hide or view adjustment panels**: Hide or reveal the right panel.

* You can use the Tab key to hide/unhide the two side panes at the same time.

** To zoom in, you can also press the Spacebar, and go back to the previous size by...
split view and side-by-side view

floating navigator

the left panel

The left panel contains all the filters and effects grouped under the Cameras section, as well as the Custom section, to create your own effects, and the Imported section, to load effects shared by other users. To use these sections, refer to the Cameras and tools chapter.
**INSTANT HELP**

Use the cursor to explore the functionality of Analog Efex Pro 2 by hovering over selected features.
The panel also includes two other sections:

1. **History**: Shows all the processing and correction steps of your image, from the top (older) to the bottom (newer). To view the image at a particular stage, click on the stage in question in the list. The selected step is displayed in yellow, all previous (top) steps are white, and all subsequent (bottom) steps are grayed out: if you make a correction at this time, the grayed out steps will be removed. The **Last filtered state** button allows you to go back to the most recent step in the history. In split or side-by-side display mode, you can move the history selector (the yellow arrow on the left edge of the section) to apply a history step to the left view.

2. **Instant Help**: This palette, which you can close by clicking on the X, displays information about the tools and interface elements when you hover over them with the mouse.

**The image display area**

This is where the image is displayed, on a medium gray background (which you can change by clicking the **Change Background Color** button in the top toolbar).
At the bottom right, below the image, you will find the following information:

- File name and extension
- Size in megapixels
- ISO sensitivity
- Camera used

The right panel

The right panel displays the tool sections, based on the effects and filters selected in the left panel. But there are also a number of common features:
1. **Enable/disable the section effect**: By unchecking the box to the left of the palette name, you temporarily disable the tools and settings applied to the image so as to let you make quick comparisons. To reactivate the tools and settings, check the box.

2. **Reset all settings in this section to their default values**: Click on the curved arrow to reset all the tools and settings in the section at once.

3. Click on the section name bar or the arrow on the left to close/open the section.

4. Double-click on a slider to reset it.

5. **Control points**: See below.

6. **Vary**: Changes the settings randomly with each click, to offer you variations of the chosen effects. Press the **Shift** key at the same time for a more dramatic impact.

7. **Save**: Lets you save and name your custom settings as types that you will find in the Custom section (left pane).

**Control Points**

Control points allow you to modify only certain parts of the image. Add a control point and when setting the corresponding sliders, it will only affect the objects or areas covered by the control point. In Analog Efex Pro 2, control points are used to adjust the corrections in the **Standard Settings** panel.

1. **Add Control Point**: Click on this button to add a control point. The mouse pointer changes to indicate that you can click to place the control point in the image. You can place as many control points as you want. After placing the
control point on the image, you can apply and adjust the following settings:

2. **Size**: Sets the range or radius of application of the control point. All image elements whose color, brightness, and contrast correspond to the pixels on which the control point is placed will be affected by the following corrections and settings.

3. **Detail Extraction (DE)**: Controls how much detail is accentuated. Increasing the value of this slider exaggerates details while brightening shadows and degrading highlights.

4. **Brightness (Br)**: Controls the brightness of the selected area.

5. **Contrast (Co)**: Controls the overall contrast of the selected area.

6. **Saturation (Sa)**: Controls the vividness of the colors in the selected area.

**Control Points** list allows you to manage the different control points applied to the image, presented here as a numbered list. An active control point is indicated in yellow.

1. **Switch on /off effect for all control points** disables and re-enables all control points applied to the image, as well as the associated corrections and settings.

2. **Show/hide effect of control point**: The checkbox to the left of each control point in
the list lets you temporarily deactivate and reactivate the display of the concerned control point and its associated corrections and settings.

3. **Show/hide selection for all control points**: This button displays the monochrome masks for all control points. To display the mask of only one control point at a time, check the box on the right side of the list. In the monochrome mask, white indicates areas of the image where 100% correction is applied, black indicates no correction, and gray variations indicate areas more or less affected by the correction.

4. **Size**: The dotted circle indicates the size column, in %, of the radius of control point effectiveness.

5. **Group**: You can group several control points by selecting them beforehand (draw a rectangle encompassing the control points or click on it with the Ctrl/Cmd key) and then clicking on this button. In the list, the selected control points are grouped in a numbered group. When you apply a correction to one of the control points, the correction will be applied to the other control points in the group. However, you can use the size slider to adjust the size of each control point in a group independently.

6. **Ungroup**: To remove the grouping of control points, select the group from the list and press this button. All control points will be displayed as ungrouped, allowing you to delete, modify, or create new groups from individual control points.

7. **Duplicate**: Clicking this button duplicates the currently selected control point(s). You can also duplicate a control point by clicking on it with the Alt/Option key (the pointer will change to a "+") and then dragging the mouse to reposition the duplicated control point.

8. **Delete**: Click the Delete button to delete the currently selected control point(s).

**Loupe and Histogram**

The Loupe and Histogram section is also available regardless of the tools you use. To switch from one to the other, move the mouse just below the title bar to bring up the selector, then click on either function:
1. Loupe

- The preview shows a real-time magnification of 200% as you move the mouse pointer through the image.
- You can also lock the loupe to a specific place in the image: click on the pin on the right in the title bar and then click on the desired place in the image. To unlock, click the pin again.
- Regardless of whether the loupe is locked or not, you can also move around in the image after clicking in the loupe (the image displayed in the center does not move, even when zoomed in).

2. Histogram

- **Show clipped shadows / Show clipped highlights**: The two buttons at either end of the Loupe/Histogram mode switch can be used to display clipped shadows as a red mask (shadows that are too dense) or blue mask (highlights that have turned white).
- By default, the histogram shows all channels. By clicking in the histogram, you switch from All channels to Red, Green, Blue, Brightness, and then back to All channels.

The lower toolbar

1. **Help** provides access to the online user guide.
2. **Settings** opens the plugin options window.
3. **Previous / Next** allows you to switch between images if you have opened more than one in the same session; and indicates the number of images.
4. **Save & resume editing** activates the reversible workflow. The ? button opens a page with information about this workflow (internet connection required).

5. **Cancel** lets you cancel the current processing and corrections and closes the plugin; the image in the host application is not modified.

6. **Save / Save All** lets you saves the processing and corrections and closes the plugin; the image in the host application is modified. The Save All command appears when several images have been opened in the plugin.

* For more information, see the Settings and help page.

** For more information about the Nik Collection 3’s reversible non-destructive workflow, see the chapter by the same name.

---

**Keyboard shortcuts**

<table>
<thead>
<tr>
<th>Action</th>
<th>Windows</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clipped Highlights</td>
<td>Shift + H</td>
<td>Shift + H</td>
</tr>
<tr>
<td>Clipped Shadows</td>
<td>Shift + S</td>
<td>Shift + S</td>
</tr>
<tr>
<td>Undo</td>
<td>Ctrl + Z</td>
<td>Cmd + Z</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl + Y</td>
<td>Cmd + Y</td>
</tr>
<tr>
<td>Full Screen</td>
<td>F</td>
<td>F</td>
</tr>
<tr>
<td>Preview</td>
<td>P</td>
<td>P</td>
</tr>
<tr>
<td>Show/Hide Control Palettes</td>
<td>Tab</td>
<td>Tab</td>
</tr>
<tr>
<td>Apply Filter</td>
<td>Enter</td>
<td>Return</td>
</tr>
<tr>
<td>Cancel Filter</td>
<td>Esc</td>
<td>Esc</td>
</tr>
<tr>
<td>Zoom</td>
<td>Spacebar</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Ctrl + &quot;+&quot;</td>
<td>Cmd + &quot;+&quot;</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Ctrl + &quot;:&quot;</td>
<td>Cmd + &quot;:&quot;</td>
</tr>
<tr>
<td>Zoom to Fit</td>
<td>Ctrl + 0</td>
<td>Cmd + 0</td>
</tr>
<tr>
<td>Action</td>
<td>Ctrl + Alt + 0</td>
<td>Cmd + Alt + 0</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>----------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Zoom to 100%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remove Control Point or Blur Point</td>
<td>Delete</td>
<td>Delete</td>
</tr>
</tbody>
</table>
Cameras
Cameras types and tool combinations

The camera selector and tool combination selector in the top left corner allow you to select a camera type, or a rendering inspired by film techniques. After selection several variants of the same camera or rendering are displayed in the left pane, and the associated tools and default settings in the right pane. These cameras and renderings are:

- **Classic Camera**
- **Black and White**
- **Color Cast**: offers colorization effects reminiscent of prints that have aged in photo albums.
- **Motion**: applies zoom and rotation effects in the image.
- **Wet Plate**: An ancient photographic process that preceded the appearance of silver bromide negatives.
- **Subtle Bokeh**: An artistically blurred background.
- **Double Exposure**: process that consists of exposing the same view twice.
- **Toy Camera**: reproduces the behaviour of lenses with significant distortion and/or
vignetting defects.

- **Vintage Camera** gives a vintage look to your photos.
- **Multilens** reproduces cameras that allow you to frame a subject in different ways in the same view.
- **En Vogue**: Renderings added by versions 2 and 2.5 of the Nik Collection by DxO.
- **Camera Kit**: Create your own camera.

For example, if you select Classic Camera, the left panel offers 9 variants or combinations that you can scroll through to select or apply to your photo. If you click Classic Camera 1, the panels shown in the right-hand panel are:

- Standard settings
- Dirt and scratches
- Lens vignetting
- Film type

And if you click on another combination on the left — for example, Classic Camera 2, the controls in the right panel will be the same, but the settings and choice of textures and other effects will be different. You can also display the tool panels as you wish, by selecting them from the **Tools/Tool Combinations** lists. To access this list, click on the arrow to the right of the camera you have selected, which opens a window with a comprehensive list of all available tools and a set of icons showing all available tool combinations.

**Vary button**

The **Vary** button, located under the panels in the right pane, allows you to randomly change the selected effects and settings by clicking once or several times in a row.

To save your effects, recipes, and custom settings, see the **Custom camera kits and**
Basic adjustments

Use these tools to adjust the basic characteristics of the image — detail, brightness, contrast, and saturation — regardless of what camera type or tool combination you choose.

**Standard settings panel**

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detail Extraction</td>
<td>Allows you to control how much detail is accentuated. Increasing the value of this slider amplifies details while lightening shadows and tamping down highlights. As a result, the tone is distributed more evenly throughout the photo.</td>
</tr>
<tr>
<td>Brightness</td>
<td>Controls the overall brightness of the image.</td>
</tr>
<tr>
<td>Contrast</td>
<td>Controls the overall contrast of the image.</td>
</tr>
<tr>
<td>Saturation</td>
<td>Controls the overall saturation of colors in a photo</td>
</tr>
<tr>
<td>Control Points</td>
<td>Selectively apply corrections to the various sliders in the panel and adjust their opacity.</td>
</tr>
</tbody>
</table>

Lens distortion

Check out the optical distortion properties typical of lenses with extreme focal lengths. Apply concave or convex distortion, or the color fringes of chromatic aberrations.

**Lens Distortion panel**
### Type of Distortion
Drag the slider to the left to apply pincushion (concave) distortion or to the right for barrel (convex) distortion.

### Chromatic Shift
Controls the extent to which a chromatic change appears.

### Chromatic Aberration
Select the color combination for the fringes caused by chromatic aberration.

### Defocus
Gradually introduces blur throughout the entire image.

---

## Bokeh

Apply the Bokeh filter to creatively control image sharpness. Use the Insert to Image control to adjust the size and shape of the blurred area or to move the focus away from the center, if desired.

### Bokeh panel

<table>
<thead>
<tr>
<th>Bokeh Style</th>
<th>Choose between elliptical or tilt/shift blur.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blur Strength</td>
<td>Lets you determine the amount of blur applied to the photo.</td>
</tr>
<tr>
<td>Optimize Highlights</td>
<td>Allows you to increase the intensity of the highlights in the blurred area.</td>
</tr>
<tr>
<td>Aperture Shape</td>
<td>Click the arrows to choose from several shapes to apply to blurred highlights.</td>
</tr>
<tr>
<td>Aperture Rotation</td>
<td>Adjusts the angle at which the aperture shape is set.</td>
</tr>
<tr>
<td>Aperture Variation</td>
<td>Drag the slider to the left for a concave aperture shape or to the right for a convex aperture shape.</td>
</tr>
</tbody>
</table>

---

## Zoom and rotation blur
Apply a creative blur effect around the center of the image when zooming and rotating to draw the eye into the image. Use the Insert command on the image to move the focus away from the center, if desired.

**Zoom & rotate blur panel**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protect Center</td>
<td>Adjusts the size of the targeted center area.</td>
</tr>
<tr>
<td>Zoom Strength</td>
<td>Controls the amount of blur applied to the image during zoom movement.</td>
</tr>
<tr>
<td>Rotate Strength</td>
<td>Controls the amount of blur applied to the image during rotational movement.</td>
</tr>
</tbody>
</table>

**Directional blur**

From the **Motion** tool combination, create motion, distortion, or texture in the image by making it appear as if the camera or subject is moving. Use multiple vector points to customize the appearance of the desired movement.

**Directional Blur panel**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blur Strength</td>
<td>Controls the amount of blur applied to the image during directional movement.</td>
</tr>
<tr>
<td>Add a blur point</td>
<td>To add vector points, click Add a blur point, and then click in the image to insert the point. Click and drag the point at the end of the vector to change the direction or the extent of the vector. Use the Delete key on your keyboard to quickly delete the last inserted point.</td>
</tr>
</tbody>
</table>

**Double exposure**
Apply this filter to recreate the exclusively analog effect of two image captures in a single frame. Choose to overlay a second image on top of the first, or use the frame inlay to overlay, shift and enlarge the same image twice.

**Double Exposure panel**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Second Exposure</td>
<td>By default, the original image is duplicated and appears as a second exposure. Click the “+” button to replace it with another .tif or .jpg image instead.</td>
</tr>
<tr>
<td>Exposure</td>
<td>Protects the overall brightness and contrast of the single image generated by the double exposure.</td>
</tr>
<tr>
<td>Exposure Balance</td>
<td>Controls the opacity of the second exposure.</td>
</tr>
<tr>
<td>Zoom Strength</td>
<td>Adjusts the zoom effect of the double image.</td>
</tr>
<tr>
<td>Rotate Strength</td>
<td>Adjusts the rotation of the double image.</td>
</tr>
</tbody>
</table>

**Light leaks**

*Image: Modern Afflatus on Unsplash*

Add light to the image, and use the Insert control on the image to customize the location of the light to vary the effect and make sure the light is placed where you want it. To vary the effect, choose between soft, sharp and precise or dynamic shapes. Use the intensity slider to adjust the overall opacity of the light, or a control point to selectively adjust the effect.

**Light Leaks panel**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Strength</td>
<td>Adjusts the presence and impact of the effect applied to the image.</td>
</tr>
<tr>
<td>Effects menu</td>
<td>Offers a wide selection of light leaks in three categories (Soft, Crisp, Dynamic).</td>
</tr>
<tr>
<td>Control Points</td>
<td>Locally applies the selected effect and adjusts its opacity.</td>
</tr>
</tbody>
</table>

**Dirt & scratches**
Give the impression that your photos have been developed with a negative damaged by dirt, scratches, and/or stains. Use the **insert** control to adjust the location of marks, to vary the effect, and to make sure the texture appears exactly where you want it. Choose a **Dust and Lint**, **Scratches**, **Organic**, or **Eroded** texture, then apply it in black or white to vary the effect. Use the **Intensity** slider to adjust the overall opacity and tone of the texture, or a control point to selectively adjust or remove the effect.

### Dirt and Scratches panel

<table>
<thead>
<tr>
<th>Strength</th>
<th>Adjusts the presence and impact of the effect applied to the image.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effects menu</td>
<td>Offers a wide selection of defects in four categories (Dust and Lint, Scratches, Organic, Eroded).</td>
</tr>
<tr>
<td>Control Points</td>
<td>Locally applies the selected effect and adjusts its opacity.</td>
</tr>
</tbody>
</table>

**Photographic Plate**
Simulates on digital images the natural textures typical of darkroom processing. Choose a Streaked, Corroded, or Concrete style, then apply the texture in black or white to vary the effect. Use the Intensity slider to adjust the overall opacity and tone of the texture, or a control point to selectively adjust or remove the effect.

**Photographic Plate panel**

<table>
<thead>
<tr>
<th>Strength</th>
<th>Adjusts the presence and impact of the effect applied to the image.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effects list</td>
<td>Offers a selection of plates in three categories (Streaked, Corroded, Concrete).</td>
</tr>
<tr>
<td>Control Points</td>
<td>Locally applies the selected effect and adjusts its opacity.</td>
</tr>
</tbody>
</table>

**Lens Vignetting**

Simulates the vignetting created by different types of lenses. The darkening of the edge of the frame helps to draw the viewer’s eye within the image boundaries and gives the picture more depth. Use the Insert command on the image to move the vignetting away from the center, if desired.

**Lens Vignette panel**

<table>
<thead>
<tr>
<th>Amount</th>
<th>Controls the intensity of the vignetting. Move the slider to the left to add vignetting darkening to the image edges. Conversely, move the slider to the right to add lightening vignetting to the edges.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Circle / Rectangle</td>
<td>Controls the overall shape of the vignetting: circular or rectangular.</td>
</tr>
</tbody>
</table>
### Film Type

Simulates different film styles with various colors, tones, contrasts and grain styles. You can choose between warm, cool or subtle color variations.

**Film Type panel**

<table>
<thead>
<tr>
<th>Effect</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Effects list</strong></td>
<td>Selects film renderings from five categories (Warm, Cool, Subtle, B&amp;W Neutral, B&amp;W Toned).</td>
</tr>
<tr>
<td><strong>Neutral / Faded</strong></td>
<td>Drag the slider to the right to give a retro fade effect.</td>
</tr>
<tr>
<td><strong>Strength</strong></td>
<td>Controls the degree to which the filter is applied to the photo.</td>
</tr>
<tr>
<td><strong>Grain per pixel</strong></td>
<td>Based on Nik's unique grain engine, this slider is used to add realistic grain to the photo. Moving the slider to the left reduces the number of grain elements applied per pixel, increasing the size and visibility of the grain throughout the photo. If you don’t want to apply any grain to your photo, move the slider all the way to the right.</td>
</tr>
<tr>
<td><strong>Soft / Hard</strong></td>
<td>Adjusts the appearance of the grain. When the grain is coarse, the image appears more detailed and sharp. When the grain is finer, the image feels more natural.</td>
</tr>
</tbody>
</table>

### Multilens

Instantly create a dynamic multi-border layout with multiple focal points in a single image.

**Multilens panel**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Layout</strong></td>
<td>Choose a layout from a selection of five layouts and four borders.</td>
</tr>
<tr>
<td><strong>Border Color</strong></td>
<td>Apply a professional white or black border, or remove the border completely for a smooth outline.</td>
</tr>
</tbody>
</table>
### Frames

<table>
<thead>
<tr>
<th>Narrow / Wide</th>
<th>Controls the width of a white or black border.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vignette</td>
<td>Adds a darkening effect to each border.</td>
</tr>
<tr>
<td>Variation Strength</td>
<td>Controls the degree of tonal variation between borders.</td>
</tr>
<tr>
<td>Variation Type</td>
<td>Lets you select one of five different patterns of tonal variation between borders.</td>
</tr>
</tbody>
</table>

Choose a border type from styles that simulate different types of films, or possibly a more subtle streaked border from the **Filmstrip**, **White**, or **Lightbox** border collections. Use the **Scale** slider to adjust the width of the selected borders.

#### Frames panel

<table>
<thead>
<tr>
<th>Scale</th>
<th>Allows you to adjust the thickness of the frames.</th>
</tr>
</thead>
<tbody>
<tr>
<td>List of effects</td>
<td>Offers a wide choice of frames grouped in three categories (Filmstrip, White, Lightbox).</td>
</tr>
</tbody>
</table>

#### Levels & Curves
Levels and curves are among the most commonly used tools for adjusting the brightness and tone of an image. From the Color Cast tool combination, this filter allows you to fine-tune basic brightness and contrast.

### Levels and Curves panel

<table>
<thead>
<tr>
<th><strong>Channel</strong></th>
<th>Selects the channel for which the tone is to be set. In addition to the RGB (Red, Green, Blue) channels usually located in the Curve dialog boxes, the Levels and Curves filter also provides a brightness channel that allows you to adjust the brightness and contrast of your photo without changing the colors.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Opacity</strong></td>
<td>Controls the degree to which the filter is added to the photo.</td>
</tr>
<tr>
<td><strong>Tone curve</strong></td>
<td>Click on the curve to add anchors directly to it. To remove an anchor point, double-click it.</td>
</tr>
<tr>
<td><strong>Levels sliders</strong></td>
<td>Move the Shadows, Midtones, and/or Highlights sliders to adjust the tone ranges.</td>
</tr>
</tbody>
</table>
Custom camera kits and tools

In addition to a choice of cameras, Analog Efex Pro 2 also offers you tools that you can combine together as custom kits. You can also change tool settings and save them.

- Building a camera kit
- Importing camera kits
- Managing camera kits

Building a camera kit

To create a custom camera kit:

1. In the camera selector, in the **Build a camera** section, click on **Camera Kit**.
2. The list of tools is displayed in the left pane.
3. Moving the mouse through the list, a + (add to kit) or - (remove from kit) button appears.
4. Add or remove the tools as you wish. Your choice is visible in real time in the right pane.
5. When you have finished your choice of tools, click on **Save** in the right pane under the

![Building a camera kit steps]

---

**Building a camera kit steps:**

1. Click on **Camera Kit**.
2. The list of tools is displayed.
3. A + (add to kit) or - (remove from kit) button appears.
4. Add or remove the tools as you wish.
5. Click on **Save** to save your choice.
6. A dialog box prompts you to enter the name of your custom type.
7. Click **OK** to confirm.
8. Your custom camera appears in the **Custom** section of the left pane.

**Saving a variant of a kit or tool**
If you simply want to save a variant of a tool, with your own settings, click **Save**, enter an explicit name, and click **OK**.

**Importing camera kits**

To import a kit shared by another user:
1. In the title bar of the **Imported** section in the left pane, click on the + button. A system dialog box allows you to locate the location of the kit(s) to be imported.
2. Select the kit(s) to be imported and click **Open**. The kit(s) appear in the Imported section.

**Managing camera kits**
You can export, modify, and delete custom kits in the **Custom** and **Imported** sections:

1. **Rename this recipe**: Click on the recipe name below the thumbnail to activate the input field. After entering the new name, validate with the **Enter** key.

2. **Click to delete this recipe***: Hover over the recipe to display the buttons embedded in the thumbnail. Click on the **X** in the upper left corner to remove the recipe from the **Custom** section. This control is only available for imported/custom presets, filters, and recipes.

3. **Click to export this recipe***: Hover over the recipe to display the buttons embedded in the thumbnail. Clicking on the top right button will export the recipe for sharing. A system dialog box allows you to change the pre-entered name, and to choose the save location, before clicking on **Save**.

4. **Click to update this recipe with the current settings***: Hover over the recipe to display the buttons embedded in the thumbnail. Clicking on the button in the bottom right corner will update the recipe if you make changes to the settings with the tools in the right pane.

5. **Export all**: This button, located at the bottom of the panel, allows you to save all the recipes in one go in a folder (which you have created beforehand) that is accessible by a system dialog box.

* Applies only to custom kits, not to imported kits.

The terminology here may seem confusing, as it comes from Color Efex Pro 4 and Silver Efex Pro 2. Here, what is called a “recipe” or “type” simply refers to camera kits.
Color Efex Pro 4
The Color Efex Pro 4 module is an extensive library of filters that allows you to apply creative effects, modify them as you wish with global correction tools and control points, and even combine them to create an infinite number of special color effects.
Color Efex Pro 4 settings and help

Color Efex Pro 4 settings let you make choices about the interface, GPU acceleration, and image output, and gives you access to the online user guide:

- **Interface settings**
- **Image output**
- **Help**

### Interface settings

After launching Analog Efex Pro 2, click on the **Settings** button in the lower left corner. In the floating window, you can open one of the sections by clicking on its banner, starting with **Interface settings**:

- **Interface Language**: Allows you to choose from one of 17 languages. By default, the language selected is that of your operating system.
• **Default Preview Mode**: Allows you to choose how images will be displayed when you open the app, either **Display single image**, or **Split preview** (the image is separated by a line, with Before corrections on the left, After corrections on the right), or **Preview side by side** (the two versions of the image, before and after corrections, are displayed next to each other).

• **Default Background Color**: Determines the appearance of the background, white, gray, or black.

• **Default Zoom Status**: Sets the zoom value that will be applied to the image when you click the Zoom button (values from 6.25% to 400%).

*Changes take effect when you open Color Efex Pro 4 the next time.*

For each of the default display options, if you select **Use last setting**, the setting from the previous session will be automatically applied.

**GPU**

The GPU (Graphics Processor Unit) section, which you can access by clicking on its banner, allows you to use your computer’s video card to perform calculations related to image processing, thus relieving the load on the main processor. To do this, check the **Use GPU for image processing** checkbox. You will also find information about your GPU’s make, model, memory, and driver version (if available) in this section.

**Image output parameters**

In this section, you can choose the settings for the output files after clicking on the **Image Output Settings** banner:

• **TIFF Compression**: Choose between **LZW** or **ZIP** compression methods if you want to reduce the size of your TIFF files. Otherwise, select **No Compression**.

• **TIFF saving type**: This is the method of storing image data in TIFF files. **Stripe** is the oldest and **Tiles** is newer and is designed for very large files. The Stripe setting is selected by default; leave it as is if you have no reason to change it.

• **JPEG Quality**: Adjusts the compression of JPEG files; the default setting is 80%. As you decrease the setting, with the slider to the left, the size of JPEG files will decrease, resulting in a gradual degradation of image quality.

* Both LZW and ZIP compression methods are lossless. The ZIP method produces smaller compressed files than the LZW method.
Improve the Nik Collection
If you want the program to transmit usage statistics, check the dedicated box, after opening the section by clicking on its banner. These statistics, which remain anonymous, allow DxO Labs developers to evaluate how users use the program, with the aim of developing and improving the product. Click the link below the checkbox to find out more about the improvement program (internet connection required).

Filter list settings
There are six categories that allow you to rearrange the Filter Library, at the very top of the left pane, with your favorite filter lists.

Whatever your choice, which will affect the position of 6 category blocks, the top 2 blocks, All and Favorites, will not change position.

To save your choices, click OK, otherwise click Cancel.

Help

To access the online help links, you can go to the Help menu or click on the Help button at the bottom left (Internet connection required):

- User guide
- Frequently Asked Questions (FAQs)
- Online Support (report problems and ask questions after creating a support ticket)
- DxO Academy (tutorials, videos, webinars)
- Getting Started
Color Efex Pro 4 interface

Generally speaking, all the components of the Nik Collection suite share the same interface, except for a few details and elements. Color Efex Pro 4 is composed of 5 distinct elements, and includes keyboard shortcuts (see table below):

1. The upper toolbar
2. The left panel
3. The image display area
4. The right panel
5. The lower toolbar

> Keyboard shortcuts

Image: Chris Gorman

The five elements of the Color Efex Pro 4 interface

You can find information and details about the Edit and Help menus on the Standalone mode page in the Workflows chapter; note that the File menu is inactive in plugin mode.
The upper toolbar

The top toolbar contains the tools and commands related to the display of the image and side panels.

1. **Hide or view adjustment panels**: Hide or reveal the left panel.

2. **Single image display**: Normal image display without separation and comparison.

3. **Split preview**: Divides the image in two with a vertical red line that you can move left or right, or toggle to horizontal mode by clicking the arrow at the top of the line, with the option of also moving the red line up and down. The left half (or upper half) represents the image as it was opened in the plugin, the right half (or lower half) represents the processed and corrected image. You can also zoom in and out of the image either with the Navigator or with the Hand tool by pressing the spacebar.

4. **Side-by-side preview**: The version before processing is displayed on the left, the version after processing is displayed on the right. You can also display the two versions of the image one above the other by clicking on the button in between. While zoomed in, you move synchronously in the two images, either with the Navigator or with the Hand tool, by pressing the spacebar.

5. **Compare**: By clicking this button, you can quickly compare the before- and after-correction versions of your image. You can use this tool only in Single image display mode (2).

6. **Zoom + / Zoom -**: Set to 100% by default, lets you zoom into the image. After you zoom in, a floating **Navigator** window automatically displays the enlarged zone in the image; you can move this window either by clicking on it and dragging it, or by clicking on a different part of your image. (By pressing and holding the spacebar, you can also use the Hand tool to move around in your image.) To return to normal view, click on the Zoom button again, which will also hide the Navigator window. The arrow lets you access different sizes, from 6.25% to 400%. You can also use the zoom and movement functions in split preview and side-by-side display modes.

7. **Change background color**: Click the button successively to change the background from medium gray to white, black, and back to medium gray so as to adapt the screen to the brightness of the image displayed (for example, you can darken the background to avoid too strong a contrast between a dark image and the interface).
8. **Hide or view adjustment panels**: Hide or reveal the right panel.

* You can use the **Tab** key to hide/unhide the two side panels at the same time.

** To zoom in, you can also press the **Spacebar**, and go back to the previous size by releasing it.

*Split and side-by-side views*
The left panel

Filter library and Recipes

The left panel contains all the filters and effects grouped under the Filter library section, as well as the Recipes section for storing your own effects, and the History section, which records all the steps involved in correcting and processing images.

Refer to the Filter Library and the Managing recipes pages for more detailed descriptions.

History section
The **History** section automatically saves and shows all the processing and correction steps of your image, oldest the top (initial state) to newest at the bottom. To view the image at a particular stage, click on the stage in question in the list. The selected step is displayed in yellow, all previous (top) steps are white, and all subsequent (bottom) steps are grayed out: if you make a correction at this time, the grayed out steps will be removed. The **Last Filtered State** button allows you to go back to the most recent step in the history.
In split view or side-by-side display mode, you can move the history selector (the yellow arrow on the left edge of the section) to apply a history step to the left view.

The image display area
This is where the image is displayed, on a medium gray background (which you can change by clicking the **Change background color** button in the top toolbar). At the bottom right, below the image, you will find the following information:

- File name and extension
- Size in megapixels
- ISO sensitivity
- Camera used

**The right panel**

The right panel displays the tool sections, based on the effects and filters selected in the left panel. But there are also a number of common features:
1. **Toggle the effect of the section**: By unchecking the box to the left of the palette name, you temporarily disable the tools and settings applied to the image so as to let you make quick comparisons. To reactivate the tools and settings, check the box.

2. The hamburger menu (3 stacked marks to the right of the section name) lets you access the following functions:

   - **Copy / Paste Control Points**: Allows you to duplicate control points and associated settings.
   - **Reset Filter**: Resets all section settings to 0, with the choice of whether or not to retain the control points and associated settings.

3. Click on the section name bar (triangle or arrow on the left) to close/open the section.
4. Double-click on a slider to reset it.
5. **Control points**: See below.
6. **Add Filter**: Adds an empty filter under the previous sections. To place a filter there, click in the Filter library in the left panel.
7. **Save Recipe**: Lets you save and name your custom settings as types that you will find in the Recipes section (left panel).

### Control Points

Control points allow you to modify only certain parts of the image. Add a control point, and when setting the corresponding sliders, it will affect only the objects or areas covered by the control point. In Color Efex 4, control points are used to adjust the opacity of corrections and sliders, depending on the filter used.

1. **[Add] Control Point +**: Click on this button to add a control point. The mouse pointer changes to indicate that you can click to place the control point in the image. You can place...
as many control points as you want. After placing the control point in the image, you can apply and adjust the following settings:

2. **Size**: The slider allows you to set the range or radius of the application of the control point. All image elements whose color, brightness, and contrast correspond to the pixels on which the control point is placed will be affected by the corrections and settings you apply to the point.

3. **Opacity (0)** modulates the effect of the selected filter corrections.

4. **[Negative] Control Point** - : You can also protect part of the image from sharpening by using a negative control point (you can also put and chain several of them together):

   - Click on the **Control Point** - button.
   - Adjust the radius to cover the area to be protected.
   - Set the **Opacity** slider to 0, which will act as protection and prevent correction in this part of the image.

---

**Control Points**: The Control Points section allows you to manage the different control points.
applied to the image, presented here as a numbered list. An active control point is indicated in yellow.

1. **Enable/Disable effect for all Control Points**: the switch disables and re-enables all control points applied to the image, as well as the associated corrections and settings.

2. **Show/hide effect of Control Point**: The checkbox to the left of each control point in the list lets you temporarily deactivate and reactivate the display of the concerned control point and its associated corrections and settings.

3. **Switch on/off effect for all Control Points**: This button displays the monochrome masks for all control points. To display the mask of only one control point at a time, check the box on the right side of the list. In the monochrome mask, white indicates areas of the image where 100% correction is applied, black indicates no correction, and gray variations indicate areas more or less affected by the correction.

4. **Size**: The dotted circle indicates the size column, in %, of the radius of control point effectiveness.

5. **Group**: You can group several control points by selecting them beforehand (draw a rectangle encompassing the control points or click on it with the Ctrl/Cmd key) and then clicking on this button. In the list, the selected control points are grouped in a numbered group. When you apply a correction to one of the control points, the correction will be applied to the other control points in the group. However, you can use the size slider to adjust the size of each control point in a group independently.

6. **Ungroup**: To remove the grouping of control points, select the group from the list and press this button. All control points will be displayed as ungrouped, allowing you to delete, modify, or create new groups from individual control points.

7. **Duplicate**: Clicking this button duplicates the currently selected control point(s). You can also duplicate a control point by clicking on it with the Alt/Option key (the pointer will change to a "+") and then dragging the mouse to reposition the duplicated control point.

8. **Delete**: Click the Delete button to delete the currently selected control point(s).

**Loupe and Histogram**

The Loupe and Histogram section is also available regardless of the tools you use. To switch from one to the other, move the mouse just below the title bar to bring up the selector, then click on either function:
1. **Loupe**

   - The preview shows a real-time magnification of 200% as you move the mouse pointer through the image.

   - You can also lock the loupe to a specific place in the image: click on the pin on the right in the title bar and then click on the desired place in the image. To unlock, click the pin again.

   - Regardless of whether the loupe is locked or not, you can also move around in the image after clicking in the loupe (the image displayed in the center does not move, even when zoomed in).
2. Histogram

- **Show clipped shadows / Show clipped highlights**: The two buttons at either end of the Loupe/Histogram mode switch can be used to display clipped shadows (shadows that are too dense) as a red mask or clipped highlights (bright areas that have turned white) as a blue mask.

- By default, the histogram shows all channels. By clicking in the histogram, you switch from All channels to Red, Green, Blue, Brightness, and then back to All channels.

The lower toolbar

The lower toolbar includes access to help, plugin settings, and save functions.

1. **Help** provides access to the online user guide.

2. **Settings** opens the plugin options window.

3. **Previous / Next** allows you to switch between images if you have opened more than one in the same session; and indicates the number of images.

4. **Save & allow to resume editing** activates the reversible workflow. The ? button opens a page with information about this workflow (internet connection required).

5. **Cancel** lets you cancel the current processing and corrections and closes the plugin; the image in the host application is not modified.
6. **Save / Save All** lets you save the processing and corrections and closes the plugin; the image in the host application is modified. The Save All command appears when you have opened several images opened in the plugin.

* For more information, see the Settings and help page.

** Follow the link for more information about the Nik Collection’s non-destructive workflow.

### Keyboard shortcuts

<table>
<thead>
<tr>
<th>Action</th>
<th>Windows</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clipped Highlights</td>
<td>Shift + H</td>
<td>Shift + H</td>
</tr>
<tr>
<td>Clipped Shadows</td>
<td>Shift + S</td>
<td>Shift + S</td>
</tr>
<tr>
<td>Append Filter</td>
<td>Shift + Click on a Filter</td>
<td>Shift + Click on a Filter</td>
</tr>
<tr>
<td>Append Recipe</td>
<td>Shift + Click on a Recipe</td>
<td>Shift + Click on a Recipe</td>
</tr>
<tr>
<td>Undo</td>
<td>Ctrl + Z</td>
<td>Cmd + Z</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl + Y</td>
<td>Cmd + Y</td>
</tr>
<tr>
<td>Full Screen</td>
<td>F</td>
<td>F</td>
</tr>
<tr>
<td>Preview</td>
<td>P</td>
<td>P</td>
</tr>
<tr>
<td>Show/Hide Control Palettes</td>
<td>Tab</td>
<td>Tab</td>
</tr>
<tr>
<td>Apply Filter</td>
<td>Enter</td>
<td>Return</td>
</tr>
<tr>
<td>Cancel Filter</td>
<td>Esc</td>
<td>Esc</td>
</tr>
<tr>
<td>Zoom</td>
<td>Spacebar</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Ctrl + &quot;+&quot;</td>
<td>Cmd + &quot;+&quot;</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Ctrl + &quot;.&quot;</td>
<td>Cmd + &quot;.&quot;</td>
</tr>
<tr>
<td>Zoom to Fit</td>
<td>Ctrl + 0</td>
<td>Cmd + 0</td>
</tr>
<tr>
<td>Zoom to 100%</td>
<td>Ctrl + Alt + 0</td>
<td>Cmd + Alt + 0</td>
</tr>
<tr>
<td>Add + Control Point</td>
<td>Ctrl + Shift + A</td>
<td>Cmd + Shift + A</td>
</tr>
<tr>
<td>Add - Control Point</td>
<td>Ctrl + Alt + Shift + A</td>
<td>Cmd + Option + Shift + A</td>
</tr>
<tr>
<td>Delete Control Point</td>
<td>Delete</td>
<td>Delete</td>
</tr>
<tr>
<td>Duplicate Control Point</td>
<td>Ctrl + D, Alt + drag, or Ctrl + C to copy and Ctrl + V to paste</td>
<td>Cmd + D, Alt + drag, or Cmd + C to copy and Cmd + V to paste</td>
</tr>
<tr>
<td>Expand/Collapse Control Point</td>
<td>E</td>
<td>E</td>
</tr>
<tr>
<td>Group Control Points</td>
<td>Ctrl + G</td>
<td>Cmd + G</td>
</tr>
<tr>
<td>Ungroup Control Points</td>
<td>Ctrl + Shift + G</td>
<td>Cmd + Shift + G</td>
</tr>
</tbody>
</table>
Managing recipes and filters

Color Efex Pro 4 offers an infinite choice of filters that you can combine with each other to create recipes, whose settings you can change and then save as custom filters. The Recipes section also contains a large number of predefined recipes, and you can also import and export filters and recipes for sharing.

- Recipes library
- Applying a recipe
- Adding a filter
- Saving recipes and custom filters
- Importing recipes and filters
- Managing recipes

Recipes library

Contents

![Filter Library](image)

The Recipes section contains all recipes of Color Efex 4, whether original, custom, or imported. Recipes are sets of filters added to each other (see below). The section consists of the following subsections:

1. **All**: Displays all recipes—original, imported, and custom.
2. **Custom**: Contains all the recipes or custom filters you have saved.
3. **Imported**: Contains all imported recipes and filters.
4. **Favorites**: Contains all the recipes you have marked as favorites.
5. **Recently used**: Contains the recipes that you have used recently.
6. **Sample recipes**: Recipes originally provided and offered by Color Efex 4.
7. **En vogue**: Includes recipes added in versions 2 and 2.5 of the Nik Collection by DxO.

## Applying a recipe

![Recipe Selection Screen](image)

To apply a recipe:

1. Simply click on a thumbnail.

2. A dialog box warns that the selected recipe will replace the recipe and filters currently applied to the image. (Check “Yes” to close the dialog box.)

3. The recipe is applied to the image; you can change the settings in the right panel.

For example, if you apply the recipe Clarity Bump (in the En Vogue subsection), the filters displayed on the right and applied to the image include:

- Tonal Contrast*.
- Brilliance/Warmth*.
- Pro Contrast*.

Of course, even if you use recipes, you can add filters**, and save new custom recipes.

### Adding a filter

When you select a filter from the left panel of the Filter Library, its rendering and effects are applied to the image, and the associated tools and settings appear in the right panel:
If you want to add a filter or another effect to the selected filter:
1. Click the *Add* button in the right pane below the filter panel.
2. An empty Filter section immediately appears.
3. You are prompted to select a filter from the library.
4. Once selected, the corresponding filter panel and its tools are displayed, and the effect is also applied to the image.
5. If you change your mind, click the *X* button in the filter title bar to remove it. Note that you can combine as many filters as you like.

**Saving recipes and custom filters**

**Saving a custom recipe**

If you make changes to a single filter that you want to save, or if you combine several filters and want to find this recipe and your own settings later:

1. Click on **Save** in the right-hand pane, under the filter panels.
2. Enter the name of your recipe in the **Custom Recipe** floating window.
3. Confirm by clicking **OK**.
4. You can now find your filter recipe in the Recipes section, which appears automatically.

**Saving a custom filter**

If you just want to save a variant of a filter, with your own settings:
1. Click on **Save**.

2. Enter the name of your filter variant in the floating window.

3. Confirm by clicking **OK**.

4. You can now find your filter variant in the Recipes section, which appears automatically.

**Importing filters and recipes**

In the **Recipes** section:

1. At the very bottom, click on the **Import** button.

2. Find the location of the recipe(s) you want to import in the system dialog box.

3. Select the items you want to import and then click on **Open**.

4. You will find the imported recipes and filters in the **Imported** sub-section.

**Managing recipes**

In the **Custom** and **Imported** sub-sections, you can export, modify, and delete whatever custom recipes and filters you wish.
1. **Rename this recipe**: Click on the name of the recipe below the thumbnail to activate the input field. After entering the new name, press *Enter*.

2. **Add to favorites**: Click on the star to assign the recipe to the Favorites sub-section (the
star turns yellow). Click again to remove it (the star turns white again).

3. **Click to delete this recipe**: Click to remove this recipe: Hover over the recipe to display the buttons embedded in the thumbnail. Click on the \( X \) in the upper left corner to remove the recipe.

4. **Click to export this recipe**: Hover over the recipe to display the buttons embedded in the thumbnail. Clicking on the button in the top right corner will export the recipe for sharing. A system dialog box allows you to change the name and choose the save location before you click on **Save**.

5. **Click to update this recipe with the current settings**: Hover over the type to display the buttons embedded in the thumbnail. Clicking on the button in the bottom right corner will update the recipe if you have made changes to the settings with the tools in the right pane.

6. **Export All**: This button, located at the top of the section, allows you to save all the recipes in one go in a folder that you created beforehand, and which is accessible via a system dialog.

* Applies only to custom and imported recipes and filters.
Dfine 2
Dfine 2 in noise analysis mode

Dfine 2 in noise reduction mode
Dfine 2

Compared to the other modules in the Nik Collection by DxO, Dfine 2 is the only one designed to address only one problem: digital noise. Whether it’s contrast noise or color noise, the module allows you to automatically or manually analyze your images, which you can then correct globally or selectively, using control points or color ranges.

Dfine 2 also offers specific noise correction brushes for use in Adobe Photoshop. For more information, see the Selective Tool 2, Meta-presets, and Brush tool page in the Adobe Photoshop Workflow chapter.

For optimal performance of Dfine 2 and to avoid accumulating noise corrections that could affect image detail, we recommend disabling noise reduction, both in-camera and in your host software.
Dfine 2 settings and help

In the Dfine 2 settings, you will be able to make adjustments to the interface and noise analysis profiles, and access the online user guide.

- **Interface settings**
- **Help**

**Interface settings**

After launching Dfine, click on the **Settings** button in the lower left corner. The floating window offers you the following options:

- **Default Zoom**: Sets the zoom value to apply when opening the app, either **Zoom to Fit**, which adjusts the image to the available space in the program window, or **Zoom to
100%.

- **Default Preview Mode**: Allows you to choose how images will be displayed when you open the app, either **Display single image**, or **Split preview** (the image is separated by a line, with Before corrections on the left, After corrections on the right), or **Preview side by side** (the two versions of the image, before and after corrections, are displayed next to each other).

- **Default Appearance**: Determines the appearance of the background, white, gray, or black.

- **Auto Profile Load Behavior**: When you open an image in Dfine 2, Dfine 2 automatically analyzes the noise in the image, with **Auto Image Profiling** as the default. You can also apply the last used profile or apply it based on the camera credentials in your EXIF metadata of the image. Finally, if you do not want automatic profiling at opening, select **Do nothing**.

- **Default Profiles Path**: Dfine 2 gives you the ability to create noise analysis profiles, which are stored in a predetermined location. You can access and change this location by clicking **Browse**, which will open a system dialog box.

*Changes take effect the next time you launch Dfine 2.*

For each of the default display options, if you select **Use last setting**, the setting from the previous session will be automatically applied.

To save your choices, click **OK**, otherwise click **Cancel**.

**Help**

To access the online help links, you can go to the **Help** menu or click on the **Help** button at the bottom left (Internet connection required):

- User guide
- Frequently Asked Questions (FAQs)
- Online Support (report problems and ask questions after creating a support ticket)
- DxO Academy (tutorials, videos, webinars)
Dfine 2 interface

Generally speaking, all the components of the Nik Collection suite share the same interface, except for a few details and elements. Dfine 2 is composed of 4 distinct elements, and includes keyboard shortcuts (see table below):

1. The upper toolbar
2. The image display area
3. The right pane
4. The lower toolbar

> Keyboard Shortcuts

The four elements of the Dfine 2 interface

You can find information and details about the Open and Last Modified menus on the Standalone mode page in the Workflows chapter.

The upper toolbar

The top toolbar contains the tools and commands related to the display of the image and side panes:
The upper toolbar

1. **Single image display**: Normal image display without separation and comparison.

2. **Split preview**: Divides the image in two with a vertical red line that you can move left or right, or toggle to horizontal mode by clicking the arrow at the top of the line, with the option of also moving the red line up and down. The left half (or upper half) represents the image as it was opened in the plugin, the right half (or lower half) represents the processed and corrected image. You can also zoom in and out of the image either with the browser or with the Hand tool by pressing the spacebar.

3. **Side-by-side preview**: The version before processing is displayed on the left, the version after processing is displayed on the right. You can also display the two versions of the image one above the other by clicking on the button in between. You can also zoom and move synchronously in the two images, either with the Browser or with the Hand tool, by pressing the spacebar.

4. **Preview**: by checking/unchecking this box, you alternate the display of the image with and without the noise corrections. The preview works with all the display modes described below.

5. **Modes**: Dfine 2 offers several image display modes allowing you, by removing color information, to analyze and view the noise, but also the effect of corrections (best appreciated when using the comparison display modes):
   - **RGB**: Normal display of the image and its three channels — Red, Green, and Blue.
   - **Red, Green, Blue**: Displays the image without the color in one of these channels.
   - **Luminance**: Displays the brightness/contrast noise (grainy, comparable to grains of salt).
   - **Chrominance**: Displays color noise (clusters of colored pixels).
- **Contrast Noise mask**: Displays the contrast noise correction mask of a Control Point or color range (white mask: maximum correction; black mask: no correction; gray mask: correction more or less intense depending on the gray density).

- **Color Noise Mask**: Displays the color noise correction mask of a Control Point or color range (white mask: maximum correction; black mask: no correction; gray mask: more or less correction depending on the gray density).

6. **Select** lets you make a rectangular selection within the image—for example, to link together several control points or noise measurement rectangles.

7. **Zoom + / Zoom -** lets you enlarge the image, by default at 100%, using successive clicks. From 100% up to 300%, the Loupe (magnifying glass) contains a "+"; to unzoom (with the Loupe showing a "-"), press the Alt (PC)/Option (Mac) key, which transforms the Loupe + into a Loupe -. The magnification value is displayed in the upper right corner of the image.

8. **Pan** (or Hand) lets you navigate and move around in the image after zooming.

9. **Change the background color**: Click the button successively to change the background from medium gray to white, black, and back to medium gray so as to adapt the screen to the brightness of the image displayed (for example, you can darken the background to avoid too strong a contrast between a dark image and the interface).

*Examples of display modes: Blue channel / Chrominance / Contrast noise mask*

The image display area
This is where the image is displayed, on a medium gray background (which you can change by clicking the Change Background Color button in the top toolbar).

At the bottom right, below the image, you will find the following information:

1. File name and extension
2. Size in megapixels
3. ISO sensitivity
4. Camera used

The right panel

The right panel displays the Noise Reduction section, including noise analysis and correction tools (see the Measuring and reducing noise page), as well as the Loupe and Navigator combined.
1. **Loupe:** Active when the image is displayed normally:
   - The red line separates the preview before correction (left) and after correction (right).
   - You can move around in the preview where you want by clicking and holding the click while you move the mouse.
   - You can lock the loupe at any point in the image by activating the pin and placing it in the image (you can still move it by hand).

2. **Navigator:** When you zoom in, the Navigator replaces the Loupe, and displays the entire image. You can move around the image using the red rectangle.

The lower toolbar

The lower toolbar includes access to help, plugin settings, and save functions:

1. **Help** provides access to the online user guide.
2. **Settings** opens the plugin options window.
3. **Previous / Next**: allows you to switch between images if you have opened more than one in the same session; and indicates the number of images.

4. **Save & resume editing**: activates the reversible workflow. The ? button opens a page with information about this workflow (internet connection required).

5. **Cancel**: Cancels the current processing and corrections and closes the plugin; the image in the host application is not modified.

6. **Save**: Saves the processing and corrections and closes the plugin; the image in the host application is modified.

* For more information, see the [Settings and help](#) page.

** More information about the Nik Collection’s non-destructive workflow.

### Keyboard shortcuts

<table>
<thead>
<tr>
<th>Action</th>
<th>Windows</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Tool</td>
<td>A</td>
<td>A</td>
</tr>
<tr>
<td>Zoom Tool</td>
<td>Z</td>
<td>Z</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Select Zoom Tool, hold Alt and click</td>
<td>Select Zoom Tool, hold Option and click</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Ctrl + &quot;.&quot;</td>
<td>Cmd + &quot;.&quot;</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Ctrl + &quot;+&quot;</td>
<td>Cmd + &quot;+&quot;</td>
</tr>
<tr>
<td>Zoom to Fit</td>
<td>Ctrl + 0</td>
<td>Cmd + 0</td>
</tr>
<tr>
<td>Zoom to 100%</td>
<td>Ctrl + Alt + 0</td>
<td>Cmd + Alt + 0</td>
</tr>
<tr>
<td>Pan Tool</td>
<td>H or Spacebar</td>
<td>H or Spacebar</td>
</tr>
<tr>
<td>Apply Filter</td>
<td>Enter</td>
<td>Enter</td>
</tr>
<tr>
<td>Cancel Filter</td>
<td>Esc</td>
<td>Esc</td>
</tr>
<tr>
<td>Delete Selected Item</td>
<td>Backspace</td>
<td>Delete</td>
</tr>
</tbody>
</table>
Measuring and reducing noise

Using Dfine 2 takes place in two steps: the automatic measurement of the noise, then the processing of the noise itself, in a global or selective way (the latter involving either control points or color ranges). Here, we discuss:

- Measuring noise
- Overall noise reduction
- Reducing noise with control points
- Reducing noise with color ranges
- Advanced tools

**IMPORTANT:** For optimal use of Dfine 2, and to avoid cumulative noise processing, disable noise correction in your camera, and most importantly, in your host application.

Dfine 2 also offers specific noise correction brushes for use in Adobe Photoshop. For more information, see the Selective Tool 2, Meta-presets, and Brush tool page in the Adobe Photoshop Workflow chapter.

Measuring noise
As soon as you open your image, Dfine 2 will analyze it and place measurement rectangles in the image. A progress bar, in the right panel, indicates the current measurement, which can take several seconds.

Once the analysis is finished, the message **Auto profile applied** is displayed in green in the progress bar (1), and the image displays analysis rectangles or tiles, that Dfine 2 has placed in several locations (2-5).

**Noise reduction panel**

The Noise Reduction panel, in measurement mode, consists of the following parts:

1. **Mode selector**: Measure or Reduce
2. **Method selector**: Automatic or Manual

3. **Add Rectangle**: Allows you to draw analysis rectangles (visible in the Manual method section).

4. **Measure Noise**: Click to restart an analysis after reinitialization or switching to manual mode.

5. **Noise analysis progress bar**

6. **Reinitialize** lets you cancel the noise analysis (click on Measure Noise to restart an analysis).

7. **Load** allows you to load and apply noise reduction profiles.

8. **Save** allows you to create noise reduction profiles.

**Analysis rectangles**

You can modify the analysis rectangles as you wish, which means a switch to the **Manual** method:

1. Click on a rectangle to select it (the white dotted rectangle becomes red and white).

2. Use the mouse to move the rectangle where you want in the image.

3. Use the corner handles to change the size of the rectangle.

4. Duplicate a rectangle by clicking with the **Alt/Option** key held down (the pointer will show a "+" sign) then drag the mouse to detach and move the duplicated rectangle.

5. To delete a rectangle, click on it to activate it, then press the **Delete** key on your keyboard.

Any action or modification on an analysis rectangle generates the message “Profile must be updated” in the progress bar. In this case, click on the **Measure Noise** button to restart an analysis.
You can also draw your own rectangles:

1. Select **Manual** from the **Method** drop-down menu.
2. Click on the **Add rectangle** button.
3. Draw your rectangle in the image.*
4. Redo an analysis by clicking on the **Measure Nose** button.

You can draw as many measurement rectangles as you want.

* Draw your rectangles on flat areas or in areas of the image with no details.

**Saving and loading a profile**

While it is ideal to let the automatic noise measurement and correction do the work, Dfine 2 allows you to save noise measurements and corrections as profiles that you can assign to a particular camera model and ISO sensitivity.

1. To do so, click on **Save** after measuring.
2. The first time you use Dfine 2, a dialog box prompts you to create a folder in which to place your profiles. In fact, in the next dialog box, a Profiles folder is offered to you, but you can
change its name as you wish. You can also create sub-folders for each of your devices, for example.

3. The profile is automatically named with the camera model and sensitivity, retrieved in the EXIF metadata of the image, as well as the date of creation of the profile. Of course, you can change the suggested name.

4. Click on **Save** to save the profile.

### To load and apply a profile:

1. Click the **Load** button, which opens a list of your latest profiles.
2. Select a profile from the menu.
3. The profile is applied, and the name of the profile appears in green in the progress bar field.
4. If your profile is not visible among the choices in the drop-down menu, click **Browse** to locate your profile via a system dialog box.

If you have no profiles already loaded in Dfine 2, clicking **Load** will open your system browser.

### Overall noise reduction

To access the noise reduction tools, click the **Reduce** button. First choose your reduction method (Control Points or Color Ranges, discussed further below; Control Points is the default method). Below the Method drop-down, you will find two sliders that allow you to act globally, especially if you want to adjust or resume the automatic correction:
1. **Contrast Noise**: Set to 100% by default, this slider acts on the noise that appears as grain reminiscent of analog film. Beware of too many advanced corrections which will not only excessively smooth the image, but also affect the micro details. You need to find a balance between acceptable noise presence and preservation of detail.

2. **Color Noise**: Also set to 100% by default, this slider acts on the noise that manifests itself in the form of green- and/or magenta-colored pixels, and is particularly noticeable in dark or flat areas.

### Reducing noise with control points
**Applying and using control points**

While automatic correction generally works well for most images, the real advantage of Dfine 2 is its ability to process noise with great precision, using the control points presented here, or using the color ranges discussed in the next paragraph. In either case, you can correct noise in defined areas of the image, such as smoothing out noise visible in the sky, while protecting detail elements from excessive smoothing.
1. Choose **Control Points** from the Method drop-down in the **Reduce** section under **Noise Reduction** in the right-hand panel.

2. Under the Contrast Noise and Color Noise sliders, click the **Add Control Point +** button on the right.

3. Click in the image to place a control point on the area to be processed.

4. Adjust the radius of action of the control point with the first slider.

5. Locally correct the contrast and/or color noise with the sliders (set to 100% by default).

**Using and grouping several control points**
To correct a large area of the image, such as a sky, set additional control points and repeat the steps in the section above. You can also group the control points by activating the Select tool (A key), then drawing a rectangle that encompasses multiple control points. In this case, you can simply move one slider and the correction will be applied in the same way to all the others.

**Protecting using a negative control point**

You can also protect part of the image from noise reduction using a negative control point (which you can also group together):
1. In the **Reduce** panel, click on the "-" button (minus sign).
2. Click in the image to place the protection control point.
3. Adjust the radius to cover the area to be protected.
4. The sliders are set to 0 (no correction will be applied).

**Managing control points**
The Control Points list:

1. Lets you temporarily deactivate a control point by clicking on the checkbox to its left.

2. Indicates the level of correction (as a percentage) applied by each of the two control point sliders (Contrast Noise on the left, Color Noise on the right, more fully explained in Overall noise reduction above).

Duplicating a control point

There are two methods for duplicating a control point:

1. In the list of control points, click on the control point you want to duplicate and then click on Duplicate.

2. Move the mouse over the control point you want duplicate in the image while pressing the Alt/Option key. The mouse pointer will change to a "+" sign: click and hold on the control point, then drag the duplicate where you want it.

Deleting a control point

There are several ways to delete one or more control points:

Method A:
1. In the list, click on a control point to select it.

2. To select the entire list or contiguous control points, click on the first control point and then click on the last control point with the **Shift** key.

3. To select several control points that are not adjacent to each other, click on them with the **Ctrl/Cmd** key held down.

4. Click on **Delete**.

Method B:
1. In the image, click on the control point you want to delete.

2. Click on **Delete** or on your keyboard’s **Backspace** key.

Method C:
1. To delete multiple control points in the image, activate the **Selection** tool (**A** key).

2. Draw a rectangle containing the control points to delete.

3. Click on **Delete** or on the **Backspace** key, then validate your choice in the dialog box that appears (you can deactivate its display by checking **Do not show again**).

Use the specific display modes when processing noise, in particular the monochrome masks (white: maximum application of noise reduction, black: no noise reduction), as well as the **Preview** or the **Loupe** checkbox at the bottom right. It can be helpful to zoom into the image to judge the noise reduction.

**Reducing noise with color ranges**

Another method of noise reduction is color-dependent, and requires selecting **Color Ranges** from the **Method** menu. By default, Dfine 2 offers you three ranges: red, orange, and blue, represented by tiles accompanied by an eyedropper, which will allow you to select colors directly in the image:
1. Click on an eyedropper to activate it.

2. Place it in the image, then click.

3. The corresponding color is sampled and indicated in the small tile.

4. Adjust the **Contrast Noise** and/or **Color Noise** sliders (set to 100% by default).

5. For another color, click on another eyedropper and repeat the previous steps.

To add a range of colors, click on the "+" button below the list, which will display the tile (in gray), the eyedropper, and associated sliders. You can add as many ranges as you wish, and you can remove them individually by clicking on their "-" (minus sign) button.

*Note that protection control points can be combined with color range correction.*

**Advanced tools**

When you click on the small **More** arrow under the tools, a number of additional options are revealed. These are tools for dealing with special problems inherent to noise:
1. **Edge Preservation**: Allows you to preserve the sharpness of contours, in conjunction with contrast noise reduction algorithms, to prevent excessive smoothing. Check the box to activate the tool, and then use the slider (set to 50% by default) to sharpen (to the right) or soften (to the left) the edges.

2. **JPEG Artifact Reduction**: JPEG compression tends to amplify noise reduction artifacts, which take the form of horizontal and vertical structures at the pixel level. Checking this box enables algorithms that attenuate the presence of such artifacts.

3. **Debanding**: This tool, when enabled, allows you to attenuate a form of noise from the camera’s sensor, called banding. This is seen in flat, dark or solid areas of the image, either with a horizontal or vertical banding effect. Check the box, click Horizontal or Vertical and, if necessary, change the slider setting (to 100% by
default).
HDR Efex Pro 2
Merge dialogue box

Images: Chris Gorman

HDR Efex Pro 2 interface
With the HDR Efex Pro 2 module, you can stitch and merge images shot at different exposure settings to expand the dynamic range, giving you the ability to reproduce the darkest and brightest tones in the same image. Thanks to its 32-bit engine, HDR Efex Pro 2 opens up many creative possibilities for both surrealistic and natural renderings, as you can globally and selectively correct the resulting image using Control Points.

Access to HDR Efex Pro 2 is different from the other modules in the Nik Collection by DxO. To access via Adobe Lightroom, see the PhotoShop, see the Adobe Lightroom Classic page; to access via Adobe Photoshop, see the Accessing the Nik Collection page.
HDR Efex Pro 2 settings and help

Within the HDR Efex Pro 2 settings, you will be able to choose settings for the interface, ghost image processing, GPU acceleration, image output, image stacking with originals, and accessing the online user guide.

- **Interface settings**
- **Ghost reduction**
- **Image output**
- **Stacking**
- **Help**

**Interface settings**

After launching Analog Efex Pro 2, click on the **Settings** button in the lower left corner. In the floating window, you can open one of the sections by clicking on its banner, starting with **Interface settings:**

- **Interface Language**: Allows you to choose from one of 17 languages. By default, the language selected is that of your operating system.

- **Default Preview Mode**: Allows you to choose how images will be displayed when you open the app, either **Display single image**, or **Split preview** (the image is separated by a line, with Before corrections on the left, After corrections on the right), or **Preview side by side** (the two
versions of the image, before and after corrections, are displayed next to each other).

- **Default Background Color**: Determines the appearance of the background, white, gray, or black.

- **Default Zoom Status**: Sets the zoom value that will be applied to the image when you click the Zoom button (values from 6.25% to 400%).

### Alignment and reduction of ghost images

If you want, HDR Efex Pro 2 is capable of taking into account images to be merged taken freehand and/or containing moving or moving elements. It is also capable of correcting chromatic aberration.

- **Alignment**: Enables or disables the alignment of images that have not been shot on a stable, stationary surface or with a tripod.

- **Ghost Reduction**: Enables or disables the processing of elements or moving subjects in the sequence of images to be merged.

- **Ghost Reduction Strength**: There are 5 levels of ghost reduction — 20% to 100%. The higher the value, the more effective the reduction, but the presence of artifacts and noise in the image will be proportionately higher.

- **Chromatic Aberration**: Chromatic aberration occurs in the form of colored fringes along elements with strong backlighting, and this phenomenon can be amplified when merging images. You can enable or disable the correction, but we recommended that you correct this beforehand on the original images in the host program.

- **Merge Dialog Preview Quality**: The Quick and Precise options respectively allow you to generate a faster but lower quality preview or a better quality preview that will take longer.

*Changes take effect when you open HDR Efex Pro 2 the next time.*

For each of the default display options, if you select **Use last setting**, the setting from the previous session will be automatically applied.

### GPU

The GPU (Graphics Processor Unit) section, which you can access by clicking on its banner, allows you to use your computer’s video card to perform calculations related to image processing, thus relieving the load on the main processor. To do this, check the **Use GPU for image processing** checkbox. You will also find information about your GPU’s make, model, memory, and driver version (if available) in this section.
Image output settings

In this section, you can make the settings for the output files after clicking the Image Output Settings banner:

- **Image Output Format**: You can choose from 8-bit TIFF, 16-bit TIFF, and JPG. If you select JPG, a JPEG Quality slider, set to 80% by default, allows you to adjust the compression level.

- **TIFF compression**: Choose between LZW or ZIP compression methods if you want to reduce the size of your TIFF files. Otherwise, select No compression.

**When choosing an output format, be careful not to contradict the same setting in the host program. If you have selected 16-bit TIFF in the host program and choose JPEG from one of the Nik Collection modules, a JPEG will be generated when saving.**

Stacking

The following options allow you to manage and organize the merged images back into certain applications:

- **Automatically reimport**: Returns the merged image to the host program.

- **Stack With First Image**: Stacks the merged image with the first image in the sequence when it is returned to the host application.

Improve the Nik Collection

If you want the program to transmit usage statistics, check the dedicated box, after opening the section by clicking on its banner. These statistics, which remain anonymous, allow DxO Labs developers to evaluate how users use the program, with the aim of developing and improving the product. There is a link below the checkbox that you can click to find out more about the improvement program (internet connection required).

To save your choices, click OK, otherwise click Cancel.

Help

To access the online help links, you can go to the Help menu or click on the Help button at the
bottom left (Internet connection required):

- User guide
- Frequently Asked Questions (FAQs)
- Online Support (report problems and ask questions after creating a support ticket)
- DxO Academy (tutorials, videos, webinars)
HDR Efex Pro 2 interface

Generally speaking, all the components of the Nik Collection suite share the same interface, except for a few details and elements. HDR Efex Pro 2 is composed of five distinct elements, and includes keyboard shortcuts (see table below):

1. **The upper toolbar**
2. **The left panel**
3. **The image display area**
4. **The right panel**
5. **The lower toolbar**

> Keyboard shortcuts

The preview window contains preparatory processing tools for merging; see Merging images for more information.

You can find information and details about the Edit and Help menus on the **Standalone mode** page in the Workflows chapter; note that the File menu is inactive in plugin mode.
The upper toolbar

The top toolbar contains the tools and commands related to the display of the image and side panes.

1. **Hide or view adjustment panels**: Hide or reveal the left panel.
2. **Single image view**: Normal image display without separation and comparison.
3. **Split preview**: Divides the image in two with a vertical red line that you can move left or right, or toggle to horizontal mode by clicking the arrow at the top of the line, with the option of also moving the red line up and down. The left half (or upper half) represents the image as it was opened in the plugin, the right half (or lower half) represents the processed and corrected image. You can also zoom in and out of the image either with the browser or with the Hand tool by pressing the spacebar.
4. **Side-by-side preview**: The version before processing is displayed on the left, the version after processing is displayed on the right. You can also display the two versions of the image one above the other by clicking on the button in between. You can also zoom and move synchronously in the two images, either with the Browser or with the Hand tool, by pressing the spacebar.
5. **Compare**: By clicking this button, you can quickly compare the before- and after-correction versions of your image. You can use this tool only in Single image display mode (2).
6. **Zoom + / Zoom -**: Set to 100% by default, lets you zoom into the image. After you zoom in, a floating Navigator window automatically displays the enlarged zone in the image; you can move this window either by clicking on it and dragging it, or by clicking on a different part of your image. (By pressing and holding the spacebar, you can also use the Hand tool to move around in your image.) To return to normal view, click on the Zoom button again, which will also hide the Navigator window. The arrow lets you access different sizes, from 6.25% to 400%. You can also use the zoom and movement functions in split preview and side-by-side display modes.
7. **Change background color**: Click the button successively to change the background from medium gray to white, black, and back to medium gray so as to adapt the screen to the brightness of the image displayed (for example, you can darken the background to avoid
too strong a contrast between a dark image and the interface).

8. **Hide or view adjustment panels:** Hide or reveal the right panel.

* You can use the **Tab** key to hide/unhide the two side panes at the same time.

** To zoom in, you can also press the **Spacebar**, and go back to the previous size by releasing it.
The left panel

The left panel contains all the filters and effects grouped under the Presets section, as well as the Custom section, for creating your own effects, and the Imported section, for loading effects shared by other users. (For the operation of these palettes, see Using and managing presets.)
The panel also includes the **History** section, which shows all the processing and correction steps of your image, from the top (older) to the bottom (newer). To view the image at a particular stage, click on the stage in question in the list. The selected step is displayed in yellow, all previous (top) steps are white, and all subsequent (bottom) steps are grayed out: if you make a correction at this time, the grayed out steps will be removed.

The **Merge Settings** button lets you return to the Merging window (see the [Merging images](#) page).
In split or side-by-side display mode, you can move the history selector, in the form of a yellow arrow on the left edge of the section (circled above), to apply a history step to the left view.

The image display area
This is where the image is displayed, on a medium gray background (which you can change by clicking the **Change Background Color** button in the top toolbar).

At the bottom right, below the image, you will find the following information:

- File name and extension
- Size in megapixels
- ISO sensitivity
- Camera used

**The right panel**

The right panel displays the tool sections, based on the effects and filters selected in the left panel. But there are also a number of common features:
1. **Toggle the effect of the section**: By unchecking the box to the left of the palette name, you temporarily disable the tools and settings applied to the image so as to let you make quick comparisons. To reactivate the tools and settings, check the box.

2. **Reset the controls in this section**: Click on the curved arrow to reset all the tools and settings in the section at once.

3. Click on the section name bar or the arrow on the left to close/open the section.

4. Double-click on a slider to reset it.
5. **Selective adjustments**: See the [Correction tools](#) page for more details.

The Loupe and Histogram section is also available regardless of the tools you use. To switch from one to the other, move the mouse just below the title bar to bring up the selector, then click on either function:

1. **Loupe**

   - The preview shows a real-time magnification of 200% as you move the mouse pointer through the image.
   - You can also lock the loupe to a specific place in the image: click on the pin on the right in the title bar and then click on the desired place in the image. To unlock, click the pin again.
   - Regardless of whether the loupe is locked or not, you can also move around in the image after clicking in the loupe (the image displayed in the center does not move, even when zoomed in).

2. **Histogram**

   - **Show clipped shadows** / **Show clipped highlights**: The two buttons at either end of the Loupe/Histogram mode switch can be used to display clipped shadows as a red mask (shadows that are too dense) or blue mask (highlights that have turned white).
   - By default, the histogram shows all channels. By clicking in the histogram, you switch from All channels to Red, Green, Blue, Brightness, and then back to All channels.
channels.

The lower toolbar

The lower toolbar includes access to help, plugin settings, and save functions:

1. **Help** provides access to the online user guide.
2. **Settings** opens the plugin options window.
3. **Previous / Next** allows you to switch between images if you have opened more than one in the same session; and indicates the number of images.
4. **Save & resume editing** activates the reversible workflow. The ? button opens a page with information about this workflow (internet connection required).
5. **Cancel** lets you cancel the current processing and corrections and closes the plugin; the image in the host application is not modified.
6. **Save / Save All**: saves the processing and corrections, then closes the plugin. The image in the host application is modified. The **Save All** command appears when several images have been opened in the plugin.

* For more information, see the Settings and help page.

** Follow the link for more information about the Nik Collection’s non-destructive workflow.

Keyboard shortcuts
<table>
<thead>
<tr>
<th>Action</th>
<th>Windows</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clipped Highlights</td>
<td>Shift + H</td>
<td>Shift + H</td>
</tr>
<tr>
<td>Clipped Shadows</td>
<td>Shift + S</td>
<td>Shift + S</td>
</tr>
<tr>
<td>Undo</td>
<td>Ctrl + Z</td>
<td>Cmd + Z</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl + Y</td>
<td>Cmd + Y</td>
</tr>
<tr>
<td>Full Screen</td>
<td>F</td>
<td>F</td>
</tr>
<tr>
<td>Preview</td>
<td>P</td>
<td>P</td>
</tr>
<tr>
<td>Show/Hide Control Palettes</td>
<td>Tab</td>
<td>Tab</td>
</tr>
<tr>
<td>Apply Filter</td>
<td>Enter</td>
<td>Return</td>
</tr>
<tr>
<td>Cancel Filter</td>
<td>Esc</td>
<td>Esc</td>
</tr>
<tr>
<td>Zoom</td>
<td>Spacebar</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Ctrl + &quot;+&quot;</td>
<td>Cmd + &quot;+&quot;</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Ctrl + &quot;-&quot;</td>
<td>Cmd + &quot;-&quot;</td>
</tr>
<tr>
<td>Zoom to Fit</td>
<td>Ctrl + 0</td>
<td>Cmd + 0</td>
</tr>
<tr>
<td>Zoom to 100%</td>
<td>Ctrl + Alt + 0</td>
<td>Cmd + Alt + 0</td>
</tr>
<tr>
<td>Add Control Point</td>
<td>Ctrl + Shift + A</td>
<td>Cmd + Shift + A</td>
</tr>
<tr>
<td>Delete Control Point</td>
<td>Delete</td>
<td>Delete</td>
</tr>
<tr>
<td>Duplicate Control Point</td>
<td>Ctrl + D, Alt + drag, or Ctrl + C to copy and Ctrl + V to paste</td>
<td>Cmd + D, Alt + drag, or Cmd + C to copy and Cmd + V to paste</td>
</tr>
<tr>
<td>Expand/Collapse Control Point</td>
<td>E</td>
<td>E</td>
</tr>
<tr>
<td>Group Control Points</td>
<td>Ctrl + G</td>
<td>Cmd + G</td>
</tr>
<tr>
<td>Ungroup Control Points</td>
<td>Ctrl + Shift + G</td>
<td>Cmd + Shift + G</td>
</tr>
</tbody>
</table>
Merging images

Working in HDR Efex Pro 2 is a two-step process: merging images and then processing the HDR images. On this page, you will learn about image merging, which uses a special interface, the Merge Settings window, to handle a number of issues inherent in image merging. Once the original images have been merged, the HDR image will be displayed in the plugin.

- Upon image opening
- Handling problems
- Previewing and inspecting merged images
- Starting HDR merging

Access to HDR Efex Pro 2 is based on a particular workflow, especially with respect to host applications. To access via Adobe Lightroom, see the Adobe Lightroom Classic page; to access via Adobe Photoshop, see the Accessing the Nik Collection page.

Upon image opening

After selecting images with different exposures for HDR merging, and then ordering them to be transferred to HDR Efex Pro 2, they will first open in the Merge Settings window, where you will find the following options:

1. Image thumbnails are displayed at the top of the window, and are indicated by their file name. The darkest image is on the left, the normally-exposed one is in the center, and the
brightest one is on the right. (This order also applies if your series contains more or fewer than three images: darker on the left to brighter on the right.*)

2. If the distance between each image is more than 3 EV, a message will warn you that the quality of the blending may be affected, but you can still start it. Otherwise, choose images with a smaller gap, or add intermediate images.

3. An exclamation point in a yellow triangle indicates a number issues with metadata information (focal length, image size, etc.) that HDR Efex Pro 2 requires for image merging. In some cases, HDR Efex Pro 2 will still perform the merge, with automatic cropping if necessary.

In case of problems related to exposure deviations, in addition to a yellow triangle, exposure adjustment menus will be visible below the images:

1. Beneath the thumbnails, you will find a menu that allows you to manually adjust the exposure differences from one frame to the next (bracketing technique) individually, especially if for some reason HDR Efex Pro 2 does not automatically detect this information in the EXIF metadata of each image.

2. You can also set image exposure differences by batches, by choosing a value from the EV** Spacing menu located to the right. For example, if you choose 3, you will apply a 3-stop (or
3-EV) difference between the darkest image and the normal image, and then between the normal image and the brightest image. In this case, the difference between the darkest and lightest image will be 3 EV + 3 EV = 6 EV, or 6 f-stops.

3. Each manipulation of the EV values and their differences refreshes the preview of the final image.

* If you transfer only a single image into HDR Efex Pro 2, it will open directly into HDR Efex Pro 2 without going through the merge window, in which case you will be able to work in single-image HDR mode, but with all the limitations that this imposes in terms of dynamic range.

** The notion of exposure value (EV) as expressed here is 1 EV = 1 f-stop.

Handling problems
Prior to merging images, HDR Efex Pro 2 allows you to correct certain issues and inspect your image in the Preview. You can uncheck any of the following options in their corresponding checkboxes:

1. **Alignment**: Allows you to best align a series of images taken without a tripod.

2. **Ghost Reduction***: Algorithms detect and prevent the repetition of a moving element in the...
image (pedestrian, vehicle, etc.). You can select the strength of the reduction, knowing that the higher the value, the more effective it will be—but at the expense of computing time, and with the probable appearance of artifacts or localized noise in the final image.

3. **Chromatic aberration**: Used to attenuate colored fringes along contours subject to high contrast (for example, tree branches in front of a very bright sky, and located at the edge of the image). Nevertheless, we strongly advise you to treat this phenomenon on the original files, in your host application.

*You can inspect the effect of reducing ghost images and chromatic aberration in the preview of the merged image (see below).*

### Previewing and inspecting merged images

A preview of the image after the HDR merge is available in the interface. The image’s appearance will vary depending on the manual settings of the EV deviations.

The **Adjust the exposure of the preview** slider just below the preview image lets you adjust the EV values at each end of the scale. To see the darkest image, move the slider all the way to the left, and for the lightest image, move the slider all the way to the right; you can view any of the intermediate images along the gamut.

You can use slider to darken or lighten the image to inspect for ghost images and chromatic aberration after clicking the **Loupe** button:
1. Move the loupe in the image and then use the red rectangle to position it where you want. As soon as you are positioned, the portion of the image in the red rectangle is displayed in the loupe.

2. You can change the display mode at the top of the loupe by clicking either **Ghost Reduction** or **Chromatic Aberration** (the active mode is indicated in yellow).

3. To close the loupe, click on the **Loupe** button.

* The slider adjusts only the brightness of the preview image; it has no influence on the merged result.

### Starting HDR merging

Once you have adjusted your settings, all you have to do is start merging the images:

1. Click on **Create HDR**.

2. You will immediately switch to the HDR Efex Pro 2 interface, with a progress bar indicating
that processing is in progress.

If you wish to return to the Merge Settings window, especially to change your settings:

1. Go to the History section in the left pane.
2. Click on the Merge Settings button at the top of the section.
Using and managing presets

- Preset Library
- Adding to favorites
- Custom section
- Imported section

Preset Library
The Preset Library is a collection of effects available for HDR Efex Pro 2, with thumbnails displaying the effect of each style on the active image. Presets are a quick way to learn and use HDR Efex Pro 2, while providing a starting point for creating custom presets that you can then apply to your image with a single click.

Preset categories
Predefined categories allow you to filter the presets provided. By clicking on a category, only the presets in that category will be displayed. Click on the All category to display all presets again. The categories are:
PRESET LIBRARY

<table>
<thead>
<tr>
<th>ALL (40)</th>
<th>REALISTIC (3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARCHITECTURE (4)</td>
<td>LANDSCAPE (4)</td>
</tr>
<tr>
<td>ARTISTIC (6)</td>
<td>SURREAL (5)</td>
</tr>
<tr>
<td>RECENTLY USED</td>
<td>FAVORITES (1)</td>
</tr>
<tr>
<td>EN VOGUE (12)</td>
<td></td>
</tr>
</tbody>
</table>

Search Results (40)

- 01 - Default
- 02 - Balanced
- 03 - Deep 1
- 04 - Deep 2
- **All**: Displays all available presets.
- **Realistic**
- **Architecture**
- **Landscape**
- **Artistic**
- **Surreal**
- **Recently used**: Displays the last presets you tried or used.
- **Favorites**: Displays your favorite presets (see below about adding to favorites).
- **En vogue**: Collection of presets introduced by Nik Collection versions 2 and 2.5.

**Adding to favorites**

By clicking on the star next to a preset, you will assign it to the Favorites category. To deselect a preset as a favorite, click on its star again (white star: not a favorite preset, yellow star: a favorite preset).

**Custom section**

This library stores all your custom presets, separating them from the presets included in the software and to facilitate your own workflow. Custom presets include your own settings, recipes and effects, which you can also share with other Nik Collection users—and vice versa!
1. Create a new custom preset based on the current photo status (+ button): Click this button to save current corrections as a custom preset. After naming the preset, the thumbnail will be added to the Custom section for later use.

2. Rename this preset: Click on the preset name below the thumbnail to activate the input field. After entering the new name, validate with the Enter key.

3. Add to Favorites: Click on the white star to assign the preset to the Favorites section of the preset library (the star turns yellow). Click again to remove it (the star turns white again).

4. Click to remove this preset*: Hover over the preset to display the buttons embedded in the thumbnail. Click on the X in the upper left corner to remove the preset from the Custom section. This control is only available for imported/custom presets.

5. Click to export this preset*: Hover over the preset to display the buttons embedded in the thumbnail. Clicking on the top right button will export the preset for sharing. A system dialog box allows you to change the pre-entered name, and to choose the save location, before clicking on Save.

6. Click to update this preset with the current settings*: Hover over the preset to display the buttons embedded in the thumbnail. Clicking on the button in the bottom right corner will update the preset if you make changes to the settings with the tools in the right pane.

7. Export all: This button, located at the very bottom of the panel, allows you to save all the
presets in one go in a folder (which you have created beforehand) that is accessible by a system dialog box.

* These commands are available only for custom presets, and not for the presets delivered with the plugin.

**Imported section**

This library is a collection of presets provided to you by another user or downloaded from the Internet.

1. **Import a preset from your computer** (+ button): When you click on this button, a system dialog box opens, where you can locate the presets to be imported. After selecting them, click Open. The imported presets will appear as thumbnails in the **Imported** section.

2. **Click to remove this preset**: Hover over the preset to display the buttons embedded in the thumbnail. Click on the X in the upper left corner to remove the preset from the **Custom** section. This control is only available for imported/custom presets.

3. **Click to export this preset**: Hover over the preset to display the buttons embedded in the thumbnail. Clicking on the top right button will export the preset for sharing. A system dialog box allows you to change the pre-entered name, and to choose the save location, before clicking on Save.

4. **Export all**: This button, located at the very bottom of the panel, allows you to save all the presets in one go in a folder (which you have created beforehand) accessible by a system dialog box.

* These commands are only available for custom presets, and not for the presets delivered with the plugin.
delivered with the plugin. Note that you cannot update or rename imported presets. To do so, apply them, change the settings, and then save as a new preset.
Correction tools

HDR Efex Pro 2’s correction tools allow you to go far beyond simply choosing a predefined HDR rendition. You will be able to alter the HDR method, tone compression, tonality, color, and also make localized adjustments using control points. On this page, we discuss:

- Global adjustments
- Tone compression
- Tonality
- Color
- Selective settings
- Finishing

The HDR processing engine in HDR Efex Pro 2 is 32-bit end-to-end (compared to 16-bit RAW, TIFF, and 8-bit JPEG files).

Global adjustments

After merging then opening your HDR image, the program applies a default rendering (type 01 - Default), and from there you can:

- Apply one of the types offered by the HDR Efex Pro 2 library and save.
- Start with the default type and apply your own corrections.
- Apply another type and modify it.

For the last two cases, tools are available in the right pane that allow you to act on tone...
compression, tone, and color; assign selective corrections with control points; and apply some finishing effects.

Tone compression

Use tone compression to reduce wide variations in brightness, to restore detail and information in the dynamic range of the image, and to give the image a special appearance by combining the following settings:
1. **Tone Compression**: Adjusts the brightness of different tones relative to each other.

2. **Method Strength**: Modulates the combined effect of the HDR method settings (below) and tone compression settings.

3. **HDR Method**: Depending on the type you initially select, HDR Efex Pro 2 will apply different levels to the following settings:

   - **Depth** affects the overall impact of HDR rendering with the Off, Subtle, Normal, Strong settings.
   - **Detail** reinforces the level of detail to extremes with the settings Soft, Realistic, Accentuated, Detailed, and Grungy settings.
   - **Drama** also enhances the contrast of details to extreme levels with the Flat, Natural, Deep, Dingy, Sharp, and Grainy settings.

* First select your HDR method settings, then your tone compression settings, and finally adjust the intensity of the method (work in the 3-1-2 direction of the above points).

---

**Tonality**

The sliders in the Tonality panel allow you to correct the overall brightness and contrast of your image, and enhance the presence of details and textures:
1. **Exposure** adjusts the overall brightness of the image, darker to the left, brighter to the right, with the ability to intervene more finely at the end of the spectrum using the following two sliders:

   - **Shadows** corrects the brightness of the darkest tones in the image.
   - **Highlights** corrects the brightness of the lightest tones in the image.

2. **Contrast**: acts on the differences in brightness by giving the image a flat aspect to the left (reducing the differences in brightness between dark and light tones), or a highly-modeled aspect to the right (amplifying the differences in brightness, with denser dark tones and more brightness in the light tones). You can fine-tune the contrast settings with these two sliders:

   - **Blacks**: To the right, subtly lightens the dark areas and recovers more details; to the left, deepens the density of the dark areas.
   - **Whites**: To the left, subtly darkens the details of the light areas; to the right, makes details in light areas brighter.

3. **Structure**: To the right, reinforces small details and textures in the image; to the left, diffuses details and textures.

**Color**

In the Color panel, you can warm up or cool down your image, and reduce or enhance the overall brightness of the colors:
1. **Saturation** makes colors more vivid by moving the slider to the right, or gradually removes colors by moving to the left, until you get a grayscale image.

2. **Temperature** uses the same white balance principle found in all photo software: warm the image to the right (insert yellow), and cool it to the left (insert blue).

3. **Tint** compensates for possible color drifts (green on one side, magenta on the other), after adjusting the temperature.

**Selective adjustments**

Selective adjustments allow only certain parts of the image to be changed. Add a control point, and slider settings for that point will only affect the objects or areas within the radius of the control point. In HDR Efex Pro 2, the control points take over the global settings, along with the ability to modulate the chosen HDR method.

> You will find more information and details on the operation of Control Points in the dedicated chapter.

**Control points**
1. **Control Points**: Click this button to add a control point. The mouse pointer changes to indicate that you can click to place the control point in the image. You can place as many control points as you want. After placing the control point on the image, you can apply and adjust the following settings:

2. **Size**: The slider adjusts the range or radius of application of the control point. All image elements whose color, brightness, and contrast correspond to the pixels on which the control point is placed will be affected by the following corrections and adjustments.

3. After placing the control point on the image, you can apply and adjust the following settings:

   - **Exposure (Ex)**: Changes the brightness of the selected area or object.
   - **Contrast (Co)**: Changes the contrast of the selected area or object.
   - **Saturation (Sa)**: Adjusts the color brightness of the selected area or object.
   - **Structure (St)**: Reinforces or attenuates the structure (reproduction of details and textures) of the selected area or object.
   - **Blacks (Bk)**: Increases or decreases the shadow density of the selected object or area.
   - **Whites (Wh)**: Increases or decreases the brightness of the highlights of the selected object or area.
   - **Temperature (Te)**: Warms (to yellow) or cools (to blue) the selected object or
area.

- **Tint (Ti)**: Compensates for possible color drifts (green on one side, magenta on the other).

- **Method Strength (MS)**: reinforces or attenuates the previously selected HDR method.

* You can adjust the HDR method and tone compression settings with this slider, but you cannot change the type of HDR method or the type of tone compression with this slider.

4. The small triangle located under the first 4 sliders (Ex, Co, Sa, St) reveals or hides the other sliders of the control point.

**Selective adjustments section**

The Selective adjustments section allows you to manage the different control points applied to the image, presented here as a numbered list. An active control point is indicated in yellow.

1. **Enable/Disable effect for all control points**: the switch disables and re-enables all control points applied to the image, as well as the associated corrections and settings.

2. **Show/Hide the effect of the control point**: The checkbox to the left of each control point in the list lets you temporarily deactivate and reactivate the display of the concerned control point and its associated corrections and settings.

3. **Show/Hide selection for all control points**: This button displays the monochrome masks for all control points. To display the mask of only one control point at a time, check the box on the right side of the list. In the monochrome mask, white indicates areas of the image where 100% correction is applied, black indicates no correction, and gray variations indicate areas more or less affected by the correction.

4. **Size**: The dotted circle indicates the size column, in %, of the radius of control point
effectiveness.

5. **Group**: You can group several control points by selecting them beforehand (draw a rectangle encompassing the control points or click on it with the Ctrl/Cmd key) and then clicking on this button. In the list, the selected control points are grouped in a numbered group. When you apply a correction to one of the control points, the correction will be applied to the other control points in the group. However, you can use the size slider to adjust the size of each control point in a group independently.

6. **Ungroup**: To remove the grouping of control points, select the group from the list and press this button. All control points will be displayed as ungrouped, allowing you to delete, modify, or create new groups from individual control points.

7. **Duplicate**: Clicking this button duplicates the currently selected control point(s). You can also duplicate a control point by clicking on it with the Alt/Option key (the pointer will change to a “+”) and then dragging the mouse to reposition the duplicated control point.

8. **Delete**: Click the Delete button to delete the currently selected control point(s).

**Finishing adjustments**

The **Finishing** section is purely creative, allowing you to apply vignetting effects and neutral density, and to use the curve to take contrast further.
1. **Vignette** section tools allow you to apply an effect to darken or lighten the edges of the image, to give it a vintage effect or to focus attention on the subject:

   - **Vignette** (drop-down menu): Set by default to Off (no vignetting), move the mouse over the list to see the effect on your image in real time. To select an effect and apply it, click on it.
   - **Place Center**: Click the button to position an off-center vignetting effect. The
mouse pointer will change to a "+" that you then click to place in the image. If you want to change the positioning, click the button again and start over.

- **Quantity** controls the amount of vignetting. Moving this slider to the left darkens the edges of the image, and moving it to the right lightens them.
- **Circle** controls the overall shape of the vignetting, between circular and rectangular.
- **Size** adjusts the extent of the vignetting effect in the image.

2. **Graduated Neutral Density** applies more or less density to the upper and lower areas of the image without altering the colors:

- **Upper Tonality** acts on the density, lighter or denser, in the upper 2/3 of the image.
- **Lower Tonality** acts on the density, lighter or denser, in the lower 2/3 of the image.
- **Blend** controls the transition (0% sharp, 100% diffuse) between the image and the edge of the upper or lower tones.
- **Vertical Shift** allows you to extend or reduce the density effect.
- **Rotation** controls the rotation angle of the effect.
3. **Levels and curves** (section): The curve allows you to refine or completely rework the contrast of your images, either by using a predefined curve or by acting on the curve and level sliders:

- **Levels and curves** (menu): Set to Neutral by default, this menu allows you to select contrast, silver film contrast, or color curve presets. You can configure the curve as you wish and you can change the settings.

- **Channel**: Set to RGB by default (RGB: Red, Green, Blue, = RGB: Red, Green, Blue), this menu allows you to select the channel for which the tone should be set. In addition to the RGB channels, there is also a Luminosity channel that lets you adjust the brightness and contrast of your photo without changing the colors.

- **Tone curve**: Click on the curve to adjust it, and add anchor points, which will allow you to lock the contrast settings at specific points on the curve, and thus on the image. To remove an anchor point, double-click on it.

- **Levels sliders** let you adjust the extent of Shadows (left), Midtones (center), and Highlights.

---

Bright Contrast curve
Perspective Efex
Perspective Efex

The Efex Perspective module allows you to correct geometric problems such as perspective (for example, lines that are not parallel but should be) and volume distortion (stretching of elements at the edges of an image taken with a wide-angle lens). It also allows you to create miniature effects.

Perspective Efex is based on DxO ViewPoint, from which it takes all of the tools, and also allows you to take advantage of the efficiency of DxO Optics Modules to correct vignetting, distortion, and chromatic aberration.
Perspective Efex settings and help

Perspective Efex settings allow you to set the language and interface elements, and give you access to the online user guide.

Preferences

After launching Perspective Efex, go into the Perspective Efex menu and select Preferences from the drop-down menu. In Preferences, you can choose the following options or settings:

- **Language**: Allows you to choose from one of 4 languages. By default, the language selected is the language of your operating system.

- **Background color**: Adjusts the gray level of the background to your liking, from white to black.
- **Overlay grid size**: Adjusts the size of the grid squares; the default value is 50.

- **Display image size**: Permanently displays the width x height of the image in pixels in the bottom right corner of the desktop.

- **Automatically check for updates every 24 hours**: If the option is deactivated, you can make an immediate search by clicking on the link.

- **I agree to participate anonymously in the Product Improvement Program**: By clicking on the link, you open a web page with more information (DxO Labs evaluates how users use the program, with the aim of developing and improving the product).

- **Send crash reports**: In the event of an incident or crash, a diagnostic log is automatically generated and sent to DxO Labs for investigation.

*Internet connection required.*

To save your choices, click **Save**, otherwise click **Cancel**. No restart is required for the changes to take effect.

**Online help**

By clicking on the button at the bottom left, you will access the Perspective Efex online user guide (internet connection required).
Perspective Efex interface

On this page you will find a description of the Perspective Efex interface:

- The menu bar
- Interface and layout
- Toolbars
- Palettes
- Keyboard shortcuts

The menu bar

Standalone application and plugin versions (PC)

1. **File**: open and close images, open recent images, save corrections, and close the program.
2. **Edit**: Undo/Redo commands to undo or redo an image correction step, image rotation commands, and access to Preferences.
3. **Display**: switch to/from full screen mode, hide/show the correction tool panel, and display/hide the grid in overlay.
4. **Help**: access to online help, the DxO website, product activation, update search and access to version information (About).

Standalone application and plugin versions (Mac)

1. **Perspective Efex**: access to version information (About) and Preferences.
2. **File** (standalone version): open and close images, open recent images or folders, save corrections, and close the program (standalone version), save corrections (plugin version).
3. **Edit**: Undo/Redo commands to undo or redo a correction step in the image, and rotate left or right.
4. **Display**: switch to/from full screen mode, hide/show the correction tools panel and displays/hides the overlay grid.

5. **Window**: Lets you reduce/enlarge the window size.

6. **Help**: access to online help, DxO Academy tutorials, DxO website, product activation and update search.

## Interface and layout

The Perspective Efex interface is composed of five principal parts:

1. The upper toolbar
2. The image display area
3. The lower toolbar(s)
4. The correction palette
5. The loupe

### Toolbars

#### The upper toolbar

Located at the top of the Perspective Efex window, it includes tools for opening and saving files, as well as different display and navigation modes.
1. **Display before and after correction side by side**: Display the image before correction (left) and after correction (right) at the same time.

2. **Display the image before and after correction one behind the other***: Click the left mouse button to display the before and after corrections one after the other.

3. **Fit to screen**: The image is displayed in its entirety, taking up all the available space in the display window.

4. **Display at 100%****: the image is 100% enlarged (1 image pixel = 1 screen pixel).

5. **Compare with original image**: Hold the button for a quick comparison with the original image. (Release to return to regular display.)

6. **Show or Hide Overlay Grid**: Enables or disables the display of the overlay grid in the image.

*You can also toggle the image before and after correction with the D key.

**To zoom in the image, use the mouse wheel, and navigate with the Hand tool that replaces the mouse pointer.

The lower toolbar

1. **Line color**: Click on the small blue tile (default color) to open a system color chart that allows you to choose the color of the perspective and horizon correction lines, to improve their visibility in relation to the displayed image. (Note that this command is not available with the Crop tool.)

2. **Show Grid**: Available only with the Crop tool, this button activates or deactivates the display of the grid superimposed in the image.

*Perspective tool (upper) / Crop tool (lower)*

Depending on the correction tool you have selected and activated in one of the side panels, this bar is displayed at the bottom of the program window and includes the following commands:

1. **Selected tool**: The icon is a simple reminder of the tool activated in a side palette.

2. **Line color**: Click on the small blue tile (default color) to open a system color chart that allows you to choose the color of the perspective and horizon correction lines, to improve their visibility in relation to the displayed image. (Note that this command is not available with the Crop tool.)

3. **Show Grid**: Available only with the Crop tool, this button activates or deactivates the display of the grid superimposed in the image.
4. **Mask Opacity**: Available only with the Crop tool, this slider lightens or darkens parts of the image that are outside the cropped area.

5. **Preview**: Available only with the Perspective and Horizon tools, this tool lets you update the image content after making corrections.

6. **Reset**: Cancels all corrections made and returns to the original image.

7. **Apply**: Applies the corrections and closes the lower toolbar.

**Secondary lower toolbar**

![Secondary lower toolbar](image)

In the plugin version of Perspective Efex, a second bar (under the first) is located at the very bottom of the window with the following commands:

1. **Preferences**: Opens the program settings dialog window.

2. **Help**: Accesses the Efex Perspective online help (Internet connection required).

3. **Exit**: Exits Perspective Efex, but a dialog box will first ask whether you wish to save changes or not. The **Cancel** option closes the dialog box and allows you to remain in Perspective Efex.

4. **Save**: Applies the corrections permanently and then closes the plugin before returning to the host application.

**Palettes**

**Correction tool palettes**

We will discuss the operation of the different correction tools — Distortion, Volume Distortion, Perspective, Horizon, Cropping and Miniature Effect — in more detail in the appropriate sections. Here we present the general operation of these palettes and the controls they have in common.
1. **Reset all**: Cancels all corrections and returns to the original image. See **Reset correction** below.

2. **Expand or hide palettes**: Each palette has a number of controls and sliders. To unfold them, click on the arrow-shaped icon in the upper left corner of the relevant sections. Follow the same procedure to hide them.

3. **Enable / disable palette**: The button indicates the palette’s operating status (left and grey: disabled; right and blue: enabled). Click on the palette to temporarily activate or deactivate it and its associated corrections.

4. **Hide tools**: When the entire contents of a palette is expanded (all tools and sliders showing), you can return to the standard view by clicking on the "-" (minus) sign at the bottom right of each palette.

5. **Reset correction**: Each tool in a palette has a reset button.

6. **Hide / show palettes**: Click to hide or reveal the side panel.
## Keyboard shortcuts

<table>
<thead>
<tr>
<th>Command</th>
<th>Windows</th>
<th>OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fit display to screen</td>
<td>F3</td>
<td>Cmd + 0</td>
</tr>
<tr>
<td>Display at 100%</td>
<td>F4</td>
<td>Cmd + 1</td>
</tr>
<tr>
<td>Zoom in</td>
<td>Ctrl + +</td>
<td>Cmd + +</td>
</tr>
<tr>
<td>Zoom out</td>
<td>Ctrl + -</td>
<td>Cmd + -</td>
</tr>
<tr>
<td>Hand tool</td>
<td>H or spacebar</td>
<td>H or spacebar</td>
</tr>
<tr>
<td>Crop tool</td>
<td>C</td>
<td>C</td>
</tr>
<tr>
<td>Show/Hide superimposed grid</td>
<td>G</td>
<td>G</td>
</tr>
<tr>
<td>Move anchor points</td>
<td>Arrows</td>
<td>Arrows</td>
</tr>
<tr>
<td>Toggle between anchor points</td>
<td>Tab</td>
<td>Tab</td>
</tr>
<tr>
<td>Quit</td>
<td>Alt + F4</td>
<td>Cmd + Q</td>
</tr>
<tr>
<td>Undo</td>
<td>Ctrl + Z</td>
<td>Cmd + Z</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl + Y</td>
<td>Cmd + Shift + Z</td>
</tr>
<tr>
<td>Preferences</td>
<td>Ctrl + Shift + P</td>
<td>Cmd + ,</td>
</tr>
<tr>
<td>Show image before and after correction</td>
<td>Ctrl + D</td>
<td>Cmd + D</td>
</tr>
<tr>
<td>Full screen</td>
<td>F</td>
<td>F</td>
</tr>
<tr>
<td>Exit full screen mode</td>
<td>F or Esc</td>
<td>F or Esc</td>
</tr>
<tr>
<td>Show/Hide controls</td>
<td>F9</td>
<td>Tab</td>
</tr>
<tr>
<td>Online help</td>
<td>F1</td>
<td>Cmd + /</td>
</tr>
<tr>
<td>Slow mode for Perspective and Horizon tools</td>
<td>Press on Shift while placing anchor points on the image</td>
<td>Press on Shift while placing anchor points on the image</td>
</tr>
</tbody>
</table>
Downloading and installing DxO Optics Modules

When you choose automatic distortion correction, a dialogue box about managing DxO Optics Modules will open. This dialogue box indicates which DxO Optics Module(s) can be used, allows you to choose among the appropriate DxO Optics Modules available if there is any ambiguity—that is, if DxO ViewPoint cannot fully identify the camera/lens combination you used to take the shot.

The same dialogue box also displays the status of the appropriate available DxO Optics Modules—Installed, Update available, or Download.
1. Select the DxO Optics Module you want to use and then click on **OK**.

2. If you are downloading an updated version or a new module, you will see a progress bar. As soon as the download is finished, the installation will be immediately effected and taken into account. You will not need to restart the application.

**When a DxO Optics Module is not available**

If no DxO Optics Module is available for your equipment, the **Auto** button is deactivated. In this case, you can manually correct your image.

You can eliminate the DxO Optics Module you are using for processing an image by clicking on the trash can icon located in the upper right of the Distortion palette.
Correcting distortion

- About distortion

- Applying an automatic distortion correction

- Applying an automatic distortion correction when EXIF metadata is lost

- Manually correcting distortion

About distortion

All lenses are more or less affected by distortion, which takes two principal forms:

- Barrel: Lines are curved toward the exterior of the image.

- Pincushion: Lines are curved toward the interior of the image.
The two principal types of distortion: pincushion (left) and barrel (right)

Some lenses are affected by both phenomena — for example, a zoom lens can display a barrel distortion at its shortest focal length, and a pincushion distortion at its longest focal length... not counting all the distortion variations at intermediate focal lengths.

Since Perspective Efex relies on DxO Optics Modules to correct distortion, we recommend that you do not use lens correction tools from host applications or from your camera body.

Perspective Efex allows you to correct distortion for all lenses, either automatically, using DxO Optic Modules, or manually, if there is no DxO Optics Module for your camera hardware (body and lens). You can also correct images that you take with fisheye lenses, either automatically or manually, to remove or tamp down circular distortion.

**Applying an automatic distortion correction**

If your material is supported by a DxO Optics Module, you can correct your image automatically.

1. From your host application, open the image in Perspective Efex.
2. Click on **Auto** in the Distortion palette.
3. When a DxO Optics Module is installed and taken into account, the Distortion palette
displays the following information: camera model used, lens model used, and the name of the original image file.

- A dialogue box will indicate if a DxO Optics Module for your equipment is already installed, or if not, whether it is available for downloading.
- Click on OK to correct the image using the selected DxO Optics Module and to close the dialogue box.

Applying an automatic distortion correction if EXIF metadata is lost
If Perspective Efex does not find the necessary EXIF metadata information, a dialogue box will offer to find the original image in order to retrieve the missing information. This said, certain programs modify and sometimes eliminate the EXIF data necessary for Perspective Efex to determine the proper DxO Optics Module to use.

1. From your host application, open the image in Perspective Efex.
2. If a dialogue box in the Distortion palette requests access to the original file, click on Open original image.
3. To find the original image, click on Open in the dialog box that appears at the top of Perspective Efex: a system dialogue box will open. You will need to find the JPEG or RAW image file that was loaded directly from your camera before processing.
4. After finding and selecting the original image, validate by clicking on Open. If the corresponding DxO Optics Module is not already installed, a new dialogue box will open and prompt you to download it (if available); otherwise it will display the information about the shooting equipment and the name of the original file.
5. After you have applied your corrections, click on the Save button on the lower right. Perspective Efex will close and the corrected file will be transferred back to the host application.

If your image file does not contain the necessary EXIF data, you will have to do your corrections manually.
Manually correcting distortion

If your shooting equipment is not supported by a DxO Optics Module, you can manually correct your image.

![](Distortion palette, manual correction)

1. From your host application, open Perspective Efex.

2. In the Distortion palette, click on the Manual button.

3. Depending on the type of distortion visible in the image, select either **Barrel**, **Pincushion**, or **Fisheye**. The correction will be applied immediately.

4. If necessary, you can use the **Intensity** slider to fine-tune the correction.
Correcting volume deformation

- About volume deformation
- Determining the type of volume deformation
- Correcting volume deformation

About volume deformation (anamorphosis)
The deformation of subjects located on the edges of images is a geometrical flaw that is frequently seen in interior, marriage, and other event photos.

Known as volume deformation or “anamorphosis,” this flaw is due to taking pictures of groups of people or objects with a wide-angle or wide-angle zoom lens. The curve of the lens stretches out and distorts the subjects on the image edges.

For optimal quality results, we advise you to correct any problems with distortion before correcting volume deformation.

Determining the type of volume deformation
Look carefully at your image to determine the kind of distortion affecting it:
If the spherical objects (such as heads) near the edges of your image appear stretched or flattened, your image is suffering from a cylindrical or horizontal/vertical volume deformation, in which case you need to use the horizontal/vertical correction tool.

If objects seem to stretch toward the corners of the image, then you are dealing with diagonal volume deformation, in which case you will need to use the diagonal correction tool.

Correcting volume deformation
Correcting horizontal/vertical deformation
1. After opening your image in Perspective Efex from the host application, activate the horizontal or vertical volume deformation correction by clicking on the Horizontal/Vertical button in the Volume deformation palette. The correction is automatically and immediately applied to the image.

2. You can use the sliders to adjust the settings.
   - The **Horizontal** slider can stretch the image content toward the edges of the photo (slider moved to the left) or can compress the objects toward the center (slider moved to the right). Its default value is 100 (slider at center).
   - The **Vertical** slider flattens the image content vertically. Its default value is 0 (slider on the left).

**Correcting diagonal deformation**

1. After opening your image in Perspective Efex from the host application, activate the diagonal volume deformation correction by clicking on the Diagonal button in the Volume deformation palette.

2. The correction is automatically and immediately applied to the image.

   **When in doubt, don’t hesitate to experiment with both tools, and then choose the one that makes the subjects in your image appear the most natural.**

If necessary, you can manually fine-tune the automatic correction by adjusting the **Intensity** slider. Moving the slider to the left, the image will be progressively stretched and distorted toward the center; moving to the right, the image is stretched and distorted toward the edges. The default setting for this slider is **150**.

   **Double-click on any slider to return it to its default value setting.**
Correcting volume deformation can clip the total surface area of the image. If you think you will need to apply this correction, give a larger frame to your photo when shooting.

You can fine-tune the value of your correction by entering a value in the bubble displayed above the slider in use.
Fixing perspective

- About perspective
- Automatically fixing perspective
- Forcing vertical parallels
- Forcing horizontal parallels
- Forcing a rectangle
- Correcting perspective in 8-point mode
- Advanced settings

About perspective

In architectural photography, the position of the photographer relative to a building almost always means a low-angle or high-angle shot. In both cases, convergent lines distort the subject, and the distortion becomes even more pronounced toward the edges of the image.

Perspective Efex offers tools for correcting vertical and horizontal parallel lines, for forcing a rectangle (to straighten out, for example, window and door frames), as well as an 8-point correction mode that allows you to correct each side completely independently.

Automatically fixing perspective

Perspective Efex lets you automatically correct perspectives as well as to manually adjust the
corrections (if necessary). Any automatic corrections are preserved if you then decide to go into one of the manual modes (Forcing [vertical/horizontal] parallels, Rectangle, and 8 points).

After opening the image in Efex Perspective from your host application, go to the Perspectives palette and click on the Auto correct button. By default, Perspective Efex will automatically correct both vertical and horizontal perspectives. If you are not satisfied with the result, you can select one of two different modes within the Auto correction palette, Verticals only or Horizontals only; the correction will be applied as soon as you select it in the drop-down menu.

You can use the Intensity slider to adjust the automatic correction, or you can use the advanced settings to modify the perspective (see the Advanced settings section).

To reset the automatic perspective correction, click on the Cancel icon in the upper right side of the palette.

Correcting perspectives can result in heavy cropping, so be sure to take that into account and include sufficiently large margins when framing your photos.

Before correcting perspectives automatically, first correct any distortion in order to achieve optimal results.

The integration of the loupe with the anchor points, using the Shift key to slow down placement movement, and switching from one anchor point to another using the Tab key also work for Forcing a rectangle and Correcting perspectives in 8-point mode.

Forcing vertical parallels
1. After opening your image Perspective Efex from your host application, go to the Perspective palette and then click on the **Force Vertical Parallel** button. Two vertical lines, each one with two circular anchor points, will be superimposed on your image.

2. Choose two vertical reference elements in your image, preferably located on the same plane, for optimal correction.

3. Place the mouse cursor on one of the anchor points and click on it: a magnifying glass will automatically appear to help you place the anchor points with greater precision. Move the anchor point to one of the ends of your reference element. An active anchor point is indicated by a dark gray circle.
Press the **Shift** key to slow down the movement of the anchor point so that you can increase the precision of its placement.

4. Place the second anchor point so as it aligns with your vertical element. Follow the same procedure for the second line. You can also use your keyboard’s 4 arrow keys to place the anchor points with even greater precision. Once aligned, it is also possible to reposition the lines by clicking on their center with the mouse.

Pressing the **Tab** key lets you switch from one anchor point to another.

5. Perspective Efex lets you verify your correction settings before applying them to your image. To do so, click on the **Preview** button in the lower toolbar. Perspective Efex will correct your image and will darken the parts of the image that will be suppressed when the automatic crop is applied (see Cropping). The greater the correction, the more the image will be cropped to compensate for rectifying the low- or high-angle shot.
6. Click on the **Apply** button in the lower toolbar.

So long as you have not saved the corrected image, you can undo the changes and can reset by clicking on the **Reset the correction** button.

You can change the color of the lines to improve their visibility with respect to the background color of your image. Click on the colored Line color block located in the lower toolbar and select the color you want to use.

Correcting volume deformation can clip the total surface area of the image. If you think you will need to apply this correction, give a larger frame to your photo when shooting.

**Forcing horizontal parallels**
The principle for forcing horizontal parallels is identical to that for forcing vertical parallels, except that the reference lines are horizontal and will let you align and level, for example, the top and bottom of a building, a window frame, or a door.

1. To activate the correction for horizontal perspectives, click on the **Force Horizontal Parallel** button in the **Perspective** palette. Two horizontal lines with two circular anchor points will be superimposed on your image.

2. Choose two horizontal reference elements in your image and place your lines in the same way as for correcting vertical perspectives.

3. Place the mouse arrow on one of the anchor points and click on it to grab it and move it to one of the ends of your reference element. Move the second anchor point so as to align the line with your horizontal element. Proceed in the same way for the second line.
4. Verify your correction by clicking on the **Preview** button in the lower toolbar. Perspective Efex will darken the parts of the image that will be suppressed when the automatic cropping is applied.

5. Click on the **Apply** button in the lower toolbar.

**Forcing a rectangle**

A third function of the perspective correction feature lets you use a reference rectangle to simultaneously correct both vertical and horizontal perspectives independently on each side. The applications are numerous: you can restore the exact shapes and forms to distorted elements in the scene, or straighten an interior space (such as an airport arrivals hall, a museum, or palace gallery) that was not shot in perfect alignment with an axis, or was taken at a too-low or too-high angle, etc.

1. To activate the correction, click on the **Rectangle** button.

2. You can act on all four lines: place the anchor points on the axes of the vertical and horizontal reference lines (which should be on the same plane as much as possible — that is, on elements located at approximately the same shooting distance).
Each anchor point acts on two lines at the same time.

3. Verify your correction by clicking on the Preview button in the lower toolbar. DxO ViewPoint will darken the parts of the image that will be suppressed when the automatic cropping is applied.

4. Click on the Apply button in the lower toolbar.

Manipulating one anchor point circle in the Rectangle tool affects both a vertical and a horizontal line.

Clicking on Ctrl/Cmd while moving an anchor point will cause the correction to take effect in real time without having to click on the Preview button.

You can display the composition grid to verify that all the principal elements in your image have been correctly adjusted according to your settings, instead of relying solely on a naked-eye assessment.

Correcting perspective in 8-point mode
The 8-point perspective correction follows the same principle as forcing a rectangle, with one important difference: while forcing a rectangle lets you adjust the four sides independently, the lines need to be placed on the same plane in order to achieve an optimal result.

With the 8-point method, you can place the lines on different planes, which gives you great flexibility when making complex corrections, or when the elements that need to be fixed are not all at the same distance from the where the photo was shot.

1. To activate the correction, click on the **8 points** button.
2. You can act on each of four lines in a completely independent way: you can place them on the vertical and horizontal reference lines in the image, even if they are not on the same plane — that is, even if they are at different distances from the shooting point. The lines should be located as far away as possible from each other.

*Choosing horizontal and vertical reference elements and placing correction lines.*
3. Verify your correction by clicking on the **Preview** button in the lower toolbar. Perspective Efex will darken the parts of the image that will be suppressed when the automatic cropping is applied.

4. Click on the **Apply** button in the lower toolbar.

**Advanced settings**

The **Perspective** palette provides four sliders for fine-tuning correction settings:

- **Intensity**: This slider, with a default value of **100**, helps you find the best compromise between possible corrections and the most natural rendering. The Intensity slider lets you adjust the perspective correction to achieve the most natural look.

You can fine-tune how natural the perspective correction looks by, for example, setting the **Intensity** slider to **75** instead of 100. (Of course, the setting will depend on the subject and on the type of rendering you would like).

- **Up/Down**: Toggles the image around a horizontal axis. You can use this command if the image has few reference lines, and also to compensate as much as possible for a shot
that was not perfectly in line with the subject.

- **Left/Right**: Toggles the image around a vertical axis.

- **H/V Ratio**: This slider lets you fix distortions that can sometimes accompany perspective corrections. The default value is 0. Moved to the left, the image is compressed vertically; moved to the right, the image is compressed horizontally.

*Effect of the H/V Ratio slider*
Straightening horizons and cropping

- About horizons
- Automatically straightening horizons
- Straightening the horizon by drawing a reference line
- Cropping an image
- Automatically cropping an image
- Manually cropping an image

About horizons
A common flaw in landscape photography: the horizon is tilted by several degrees, or vertical elements such as poles or trees appear slanted. In all instances, tilting occurs most often because the photographer does not hold the camera absolutely level. The solution to this problem is simple: adjust the entire image by several degrees.

Automatically straightening horizons
To straighten the horizon automatically, go to the Horizon palette and click on the Auto button.

To optimize the calculations for automatically straightening the horizon, first correct the distortion, which can — depending on the camera and/or lens that you may use —
significantly curve the horizon line.

If you are not satisfied with the result, you can:

- Use the **Angle** slider to adjust the correction, either by moving the slider or by entering a value in the bubble that displays about the slider.
- Use the manual straightening tool.

### Straightening the horizon by drawing a reference line

Before straightening the horizon, correct the distortion, which — depending on the camera and/or lens you use — can significantly curve the horizon line.

The Horizon tool lets you correct compositions with a tilted horizon line. This feature can be used in tandem with the Perspective tool.

1. To activate the tool, click on the **Horizontal Level** or **Vertical Level** button in the **Horizon** palette.

   **If the horizon line isn't visible in your image, you can still straighten it by using a vertical reference line (such as the side of a building, a ship mast, a window or door frame, etc.).**

2. A horizontal or vertical line with two circular anchor points will be superimposed on your
image.

3. Place the mouse pointer on one of the anchor points. Click on the anchor point to grab and move it to one of the ends of your reference element. Move the second anchor point to align with the line on your horizontal or vertical element.

4. When you click on an anchor point, the magnifying glass (loupe) automatically displays so that you can use it to more precisely place the anchor point.

To slow down the movement of the loupe, hold down the **Shift** key. You can also use your keyboard’s arrow keys to move an anchor point. The **Tab** key lets you switch from one anchor point to another.

5. Verify your correction by clicking on the **Preview** button in the lower toolbar. Perspective Efex will darken the parts of the image that will be suppressed when you apply automatic cropping.

6. Click on the **Apply** button in the lower toolbar.

**Cropping an image**
The corrections done using the Distortion, Volume deformation, Perspective, and Horizon tools include an automatic crop feature that maximizes the visible field of the image. Perspective Efex’s **Crop** tool lets you adjust the proportions of the final image to suit your tastes.

**Automatically cropping an image**

After correcting the perspective of your image in Perspective Efex, go to the **Crop** palette and click on the **Crop** button. An adjustable grid will be superimposed on your image.

1. Click on the **Auto** button. In this mode, Perspective Efex calculates the preserved zone of the image as closely as possible and displays darkened zones that correspond to the surface area that will be lost in the original image.

   **Checking/unchecking the Show grid box in the lower toolbar lets you activate/deactivate the composition grid in the image.**
Auto mode calculates the crop as closely as possible.

Several formats are offered in the Aspect Ratio drop-down menu: 16/9 (TV format), 5/4, 5/2, 2/1, 3/2 (APS-C reflex and full-format cameras), 4/3 (compact camera format), and 1/1 (square format).

- By clicking on Preserve in the Aspect Ratio drop-down menu, you will preserve the proportions of the original image.
- By selecting Unconstrained, you can manually apply a correction.
- By selecting Add Custom, you can enter the pixel values (for height and width) of your choice and define the proportions of the custom crop.

2. Select the format you would like: the grid superimposed on your image will be automatically modified. By clicking on the grid, you can also change the position of the frame and adapt it to the composition of your image.
You can resize and reposition the grid.

The crop grid is divided into thirds, making it easy to apply the "rule of thirds" when composing your final image.

Even though the crop is applied when you click on Apply, this can be undone so long as the image is not saved.

3. By checking the Constrain to image box, the frame is automatically confined to the part of the image being worked on so as to avoid having any dark zones superimposed on the perspective corrections.

4. To apply the crop, click on the Apply button in the lower toolbar.

Whether in automatic or manual mode, Perspective Efex automatically detects the orientation of the crop zone.

Manually cropping an image

Click on the Crop button in the Crop palette. The adjustable grid will be superimposed on your image. To adjust the proportions of the final image to suit your tastes, select Freehand mode from the Correction drop-down menu.

Change the dimensions of the adjustable grid by manipulating the resizing points located in the corners and on the sides of the grid. You can also change the overall position of the frame to adapt it to the composition of your image.
You can use the arrow keys on your keyboard to adjust the position of the crop zone.
Miniature effect

- About the miniature effect
- Applying a miniature effect

About the miniature effect

The miniature effect tool simulates a tilt-shift lens, which moves the plane of sharpness in an image so as to give photos of landscapes or cityscapes the appearance of a scale model or diorama. This effect is particularly dramatic in urban landscape photos taken from above. Perspective Efex’s miniature effect tool gives you great flexibility in choosing the positioning and the intensity of the focus areas.

Example of line placement for creating a miniature effect
Applying a miniature effect

After opening an image in Perspective Efex from your host application, select the **Miniature Effect** palette:

You can then select a shape from the **Blur shape** menu; if you do not select a shape, the circular shape will be applied by default:
Once activated, along with the selected blur shape, the Miniature effect superimposes a number of lines and tools on the image (numbered in the following image and explained further below):

1. You can use the mouse to move the center anchor point in the image. By default, it is placed in the middle of the image, and is activated when the pointer passes over it.
2. The two continuous lines, one on each side, define the area of sharpness in the center on either side of the central anchor point. You can use the mouse to spread them further apart or to close them synchronously, or you can select one of the two lines (for movement in both directions), or select an anchor point (for movement in any direction and for rotation).
3. The small disk to the right of each reference line adjusts the blur intensity: Click to adjust the slider value with the mouse; the scale goes from 0 to 100 (the default value is 40).
4. The two dotted lines define the blur transition area between a solid line and a dotted line (the blur is maximal outside the dotted line). To adjust the size of the transition zone, just move one of the dotted lines toward the center (to reduce the transition area), or away from the center (to
increase the transition area).

5. By default, the position of lines and blurring are symmetrical. If you want to set the blur to be on either side of the center mark, go into the Miniature effect palette, and uncheck Symmetrical position and / or Symmetric blur. This way you can move all the lines independently, as well as define two different blur intensity values.

6. When you are finished defining the miniature effect, click on Apply in the bottom toolbar (or click Reset to cancel the effect).

   To see the thumbnail effect without being hindered by lines, move the mouse out of the image.

   To get a wide view of the working area, move the mouse wheel upwards to zoom out.

   You can change the color of the lines in the lower toolbar.

The **Blur shape** menu allows you to choose between different blur effects, such as a more or less pronounced circular pattern, or the simulated blur of a 6-, 8-, or 9-blade lens iris diaphragm (the higher the number of blades, the smoother and more gradual the blur/net transitions).

![Differences among the different available kinds of blur](image)
Sharpener Pro 3
Sharpener Pro 3

The Sharpener Pro 3 module is composed of two separate modules that are used at two different stages of the image processing workflow: RAW Presharpener, for preliminary sharpening; and Output Sharpener, for output sharpening.

RAW Presharpener

The RAW Presharpener module, as its name suggests, is intended for the preliminary sharpening of RAW files, which are generally softer due to several possible factors, including the presence of a low-pass filter in front of the sensor; in-camera processing; and processing applied to a file upon its import into RAW development software.

⚠️ To take full advantage of RAW Presharpener, we recommend that you disable any sharpening done in the camera and in the host RAW file processing software.
Output Sharpener

The second module, Output Sharpener, is intended for sharpening after the image development and processing phase, depending on the destination and the output medium (electronic distribution or printing, which require very different settings).
Sharpener Pro 3 settings and help
In the RAW Presharpener and Output Sharpener settings, you will be able to make interface adjustments, choose output sharpening options, and access the online user guide.

- Filter settings
- Output Sharpener settings
- Help

Filter settings
This tab applies to both RAW Presharpener and Output Sharpener, the latter having an additional tab (see below). After launching one of the two modules, click on the Settings button in the lower left corner. In the floating window, you can make the following settings:

- **Default Zoom**: Sets the zoom value to apply when opening the app, either **Zoom to Fit**, which adjusts the image to the available space in the program window, or **Zoom to 100%**.

- **Default Preview Mode**: Allows you to choose how images will be displayed when you open the app, either **Display single image**, or **Split preview** (the image is separated by a line, with Before corrections on the left, After corrections on the right), or **Preview side by side** (the two versions of the image, before and after corrections, are displayed next to each other).
• **Default Appearance**: You can choose whether the background gray level will be light, medium, or dark.

*Changes take effect when you open the plugin the next time.*

* For each of the default display options, if you select **Use last setting**, the setting from the previous session will be automatically applied.

---

**Improve the Nik Collection**

If you want the program to transmit usage statistics, check the dedicated box, after opening the section by clicking on its banner. These statistics, which remain anonymous, allow DxO Labs developers to evaluate how users use the program, with the aim of developing and improving the product. There is a link below the checkbox that you can click to find out more about the improvement program (internet connection required).

To save your choices, click **OK**, otherwise click **Cancel**. To reset all options to the default configuration, click **Reset**.

---

**Output Sharpener settings (Output Sharpener only)**

Output Sharpener allows you to set up sharpening tools as well as calibrate sharpening settings:

- **Default Control Point Settings**: From this menu, you can choose the mode of operation for a new Control Point: on **Neutral**, the slider settings will be 100% for **Output Sharpness** and 0% for the other sliders (**Structure**, **Local Contrast**, and **Focus**). The other option allows you to apply your own sharpening settings by default.

- **Default Control Point Sliders**: The default option **Output Sharpness Intensity** displays only this slider when you apply a new Control Point. The **All** option always displays all sliders, and **Use Last Control Point Settings** repeats the option used in the previous session.

- **Default Measurement Unit**: Choose between metric and imperial values.

- **Number of Inks Used**: Allows you to adapt the accentuation algorithms to be used according to the type of printing: **Normal**, **Photo** (default setting) and **Four-Tone**.

- **Image Slider Size**: Choose whether or not to display the **Image Width** and **Image Height** sliders in the **Output Sharpening** palette for all output types except **Screen**.

To save your choices, click **OK**, otherwise click **Cancel**.
Help

To access the online help links, you can go to the Help menu or click on the Help button at the bottom left (Internet connection required):

- User guide
- Frequently Asked Questions (FAQs)
- Online support (report problems and ask questions after creating a support ticket)
- DxO Academy (tutorials, videos, webinars)
Sharpener Pro 3 interface and keyboard shortcuts

You will find the following topics on this page:

- RAW Presharpener interface
- Output Sharpener interface
- Keyboard shortcuts for RAW Presharpener and Output Sharpener

You can find information and details about the Open and Last Modified menus on the Standalone mode page in the Workflows chapter.

RAW Presharpener interface

Generally speaking, all the components of the Nik Collection suite share the same interface, except for a few details and elements. RAW Presharpener is composed of 4 distinct elements, and includes keyboard shortcuts (see table below):

1. The upper toolbar
2. The image display area
3. The right panel
4. The lower toolbar
The four elements of the RAW Presharpener interface

The upper toolbar

The top toolbar contains the tools and commands related to the display of the image and side panes.

1. Single image display: Normal image display without separation and comparison.
2. Split preview: Divides the image in two with a vertical red line that you can move left or right, or toggle to horizontal mode by clicking the arrow at the top of the line, with the option of also moving the red line up and down. The left half (or upper half) represents the image as it was opened in the plugin, the right half (or lower half) represents the processed and corrected image. You can also zoom in and out of the image either with the Navigator or with the Hand tool by pressing the spacebar.
3. Side-by-side preview: The version before processing is displayed on the left, the version
after processing is displayed on the right. You can also display the two versions of the image one above the other by clicking on the button in between. You can also zoom and move synchronously in the two images, either with the Navigator or with the Hand tool, by pressing the spacebar.

4. **Preview:** by checking/unchecking this box, you alternate the display of the image with and without the noise corrections. The preview works with all the display modes described below.

5. **Modes:** RAW Presharpener provides display modes for easy viewing of sharpening enhancements:
   - **Sharpened image:** Normal image display with the sharpening settings.
   - **Effect Overlay** displays a red/orange color mask when placing a control point or working with color ranges. This mask allows you to visualize the stacking of corrections: the more stacks, the denser the color mask becomes.
   - **Effect Mask** shows the effect of highlighting with control points or color ranges. White indicates a 100% application of sharpness enhancement, black indicates no sharpness enhancement, and intermediate gray values indicate more or less sharpness enhancement.

6. **Select** activates the tool for making a rectangular selection within the image—for example, to link together several control points or noise measurement rectangles.

7. **Zoom + / Zoom -** lets you enlarge the image, by default at 100%, using successive clicks. From 100% up to 300%, the Loupe (magnifying glass) contains a "+"; to unzoom (with the Loupe showing a "-"), press the Alt (PC)/Option (Mac) key, which transforms the Loupe + into a Loupe -. The magnification value is displayed in the upper right corner of the image.

8. **Pan** (or Hand) tool lets you navigate and move around in the image after zooming.

9. **Change background color:** Click the button successively to change the background from medium gray to white, black, and back to medium gray so as to adapt the screen to the brightness of the image displayed (for example, you can darken the background to avoid too strong a contrast between a dark image and the interface).

The image display area
This is where the image is displayed, on a medium gray background (which you can change by clicking the **Change Background Color** button in the top toolbar).

At the bottom right, below the image, you will find the following information:

- File name and extension
- Size in megapixels
- ISO sensitivity
- Camera used

**The right panel**
The right panel displays the Global and Selective accentuation* tools, as well as the combined Loupe and Navigator. You can open or close the **Selective Sharpening** section by clicking on the arrow or in the title bar. A checkbox allows you to quickly compare the image with and without locally-applied sharpening.

1. **Loupe**: Active when the image is displayed normally:
   - The red line separates the preview before correction (left) and after correction (right).
   - You can move around in the preview where you want by clicking and holding the click while you move the mouse.
   - You can lock the loupe at any point in the image by activating the pin and placing it in the image (you can still move it by hand).

2. **Navigator**: When you zoom in, the Navigator replaces the Loupe, and displays the entire image. Move the red rectangle to see different parts of the zoomed-in image.

* For more information about global and selective sharpening tools, refer to RAW Presharpener - Initial Sharpening section in this chapter.
The lower toolbar

The lower toolbar includes access to help, plugin settings, and save functions:

1. **Help** provides access to the online user guide.
2. **Settings** opens the plugin options window.
3. **Previous / Next**: allows you to switch between images if you have opened more than one in the same session; and indicates the number of images.
4. **Save & resume editing** activates the reversible workflow. The ? button opens a page with information about this workflow (internet connection required).
5. **Cancel**: Cancels the current processing and corrections and closes the plugin; the image in the host application is not modified.
6. **Save / Save all**: saves the processing and corrections, then closes the plugin. The image in the host application is modified. The **Save all** command appears when several images have been opened in the plugin.

> * For more information, see the **Settings and Help** page.

> **Click on the link for more information about the Nik Collection 3’s non-destructive workflow.**

---

Output Sharpener interface

Generally speaking, all the components of the Nik Collection suite share the same interface, except for a few details and elements. Output Sharpener is composed of four distinct elements, and includes keyboard shortcuts (see table below):

1. **The upper toolbar**
2. **The image display area**
3. **The right panel**
4. **The lower toolbar**
The four elements of the Output Sharpener interface

The upper toolbar
The top toolbar contains the tools and commands related to the display of the image and side panes.

1. **Single image display**: Normal image display without separation and comparison.
2. **Split preview**: Divides the image in two with a vertical red line that you can move left or right, or toggle to horizontal mode by clicking the arrow at the top of the line, with the option of also moving the red line up and down. The left half (or upper half) represents the image as it was opened in the plugin, the right half (or lower half) represents the processed and corrected image. You can also zoom in and out of the image either with the Navigator or with the Hand tool by pressing the spacebar.
3. **Side-by-side preview**: The version before processing is displayed on the left, the version after processing is displayed on the right. You can also display the two versions of the
image one above the other by clicking on the button in between. You can also zoom and move synchronously in the two images, either with the Navigator or with the Hand tool, by pressing the spacebar.

4. **Preview**: by checking/unchecking this box, you alternate the display of the image with and without the noise corrections. The preview works with all the display modes described below.

5. **Modes**: Output Sharpener provides display modes for easy viewing of sharpening enhancements:
   - **Sharpened image**: Normal image display with the sharpening settings.
   - **Effect Overlay** displays a red/orange color mask when placing a control point or working with color ranges. This mask allows you to visualize the stacking of corrections: the more stacks, the denser the color mask becomes.
   - **Effect Mask** shows the effect of highlighting with control points or color ranges. White indicates a 100% application of sharpness enhancement, black indicates no sharpness enhancement, and intermediate gray values indicate more or less sharpness enhancement.

6. **Selection** activates the tool for making a rectangular selection within the image—for example, to link together several control points or noise measurement rectangles.

7. **Zoom + / Zoom -** lets you enlarge the image, by default at 100%, using successive clicks. From 100% up to 300%, the Loupe (magnifying glass) contains a "+"; to unzoom (with the Loupe showing a "-"), press the Alt (PC)/Option (Mac) key, which transforms the Loupe + into a Loupe -. The magnification value is displayed in the upper right corner of the image.

8. **Pan** (or Hand) tool lets you navigate and move around in the image after zooming.

9. **Change the background color**: Click the button successively to change the background from medium gray to white, black, and back to medium gray so as to adapt the screen to the brightness of the image displayed (for example, you can darken the background to avoid too strong a contrast between a dark image and the interface).

The image display area
This is where the image is displayed, on a medium gray background (which you can change by clicking the **Change Background Color** button in the top toolbar).

At the bottom right, below the image, you will find the following information:

- File name and extension
- Size in megapixels
- ISO sensitivity
- Camera used

**The right panel**
The right panel displays the Global and Selective accentuation* tools, as well as the Loupe and the Navigator combined. You can open or close tool sections by clicking on their arrow or in the title bar. A checkbox in the title bar of the \textbf{Selective sharpening} section allows you to quickly compare the image with and without locally-applied sharpening.

1. \textbf{Loupe}: Active when the image is displayed normally:

   - The red line separates the preview before correction (left) and after correction (right).
   - You can move around in the preview where you want by clicking and holding the click while you move the mouse.
   - You can lock the loupe at any point in the image by activating the pin and placing it in the image (you can still move it by hand).

2. \textbf{Navigator}: When you zoom in, the Navigator replaces the Loupe, and displays the entire image. You can move around by entering the red rectangle.

* For more information about global and selective sharpening tools, refer to the Output Sharpener — creative output enhancement section in this chapter.
The lower toolbar

The lower toolbar includes access to help, plugin settings, and save functions:

1. **Help** provides access to the online user guide.
2. **Settings** opens the plugin options window.
3. **Previous / Next** allows you to switch between images if you have opened more than one in the same session; and indicates the number of images.
4. **Save & resume editing** activates the reversible workflow. The ? button opens a page with information about this workflow (internet connection required).
5. **Cancel** cancels the current processing and corrections and closes the plugin; the image in the host application is not modified.
6. **Save / Save all** saves the processing and corrections, then closes the plugin. The image in the host application is modified. The **Save all** command appears when several images have been opened in the plugin.

* For more information, see the **Settings and Help** page.

**For more information about the Nik Collection 3’s reversible workflow, see the chapter by the same name.

### Keyboard shortcuts (RAW Presharpener and Output Sharpener)

<table>
<thead>
<tr>
<th>Action</th>
<th>Windows</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Tool</td>
<td>A</td>
<td>A</td>
</tr>
<tr>
<td>Zoom Tool</td>
<td>Z</td>
<td>Z</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Select Zoom Tool, hold Alt and click</td>
<td>Select Zoom Tool, hold Option and click</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Ctrl + &quot;-&quot;</td>
<td>Cmd + &quot;-&quot;</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Ctrl + &quot;+&quot;</td>
<td>Cmd + &quot;+&quot;</td>
</tr>
<tr>
<td>Zoom to Fit</td>
<td>Ctrl + 0</td>
<td>Cmd + 0</td>
</tr>
<tr>
<td>Zoom to 100%</td>
<td>Ctrl + Alt + 0</td>
<td>Cmd + Alt + 0</td>
</tr>
<tr>
<td>Action</td>
<td>Keyboard Shortcut</td>
<td>Keyboard Shortcut</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Pan Tool</td>
<td>H or Spacebar</td>
<td>H or Spacebar</td>
</tr>
<tr>
<td>Apply Filter</td>
<td>Enter</td>
<td>Enter</td>
</tr>
<tr>
<td>Cancel Filter</td>
<td>Esc</td>
<td>Esc</td>
</tr>
<tr>
<td>Delete Selected Item</td>
<td>Backspace</td>
<td>Delete</td>
</tr>
<tr>
<td>Add Control Point</td>
<td>Ctrl + Shift + A</td>
<td>Cmd + Shift + A</td>
</tr>
<tr>
<td>Duplicate Control Point</td>
<td>Ctrl + D, or Alt + drag</td>
<td>Cmd + D, or Option + drag</td>
</tr>
<tr>
<td>Show Control Point Mask</td>
<td>Ctrl + drag</td>
<td>Cmd + drag</td>
</tr>
</tbody>
</table>
RAW Presharpener — initial sharpening

The RAW Presharpener module is designed to compensate for the loss of sharpness in your image during capture, due to the presence of a low-pass filter in front of the camera sensor, but it can also be used in a complete sharpening workflow, from capture to creative processing to output (the latter two being provided by Output Sharpener), when you want to keep full control over this important phase of the workflow. In this case, and regardless of the original format of the file to be processed, we advise you to disable any sharpening, both in the camera and in the host application, especially if the latter is a RAW file converter and processor.

On this page, we discuss:

- Enhancing overall sharpness
- Enhancing sharpness with control points
- Enhancing sharpness with color ranges

Enhancing overall sharpness

Once you have opened your image in RAW Presharpener, you can use a simple method, suitable for the majority of images, to enhance overall sharpness with adaptive tools that you will find in the right panel:

![RAW Presharpener interface](image)

1. Adaptive Sharpening
2. Sharpen Areas
3. Sharpen Edges
4. Image Quality: Normal, High ISO

---

Copyright © 2021 DxO
1. **Adaptive Sharpening**: Set by default to 50%, this slider strengthens (to the right) or attenuates (to the left) sharpness based on algorithms capable of taking into account the presence of elements in the image such as outlines, details, and flat areas. The rule here is to sharpen the image decisively, but without exaggeration. You can control this by unchecking the Preview* box in the top bar to compare the image after and before sharpening (feel free to zoom in at 100% or compare using the Loupe*).

2. **Sharpen Areas / Sharpen Edges**: Set by default in the center, this slider lets you give more importance to the areas and details of the image within the contours and/or to flat areas by moving it to the left; moving it towards the right, to emphasize the contours or edges instead. In general, however, we advise leaving the cursor as it is, and if you need to emphasize something within the edges, use the selective methods discussed below instead.

3. **Image Quality**: With this function set to **Normal** by default, the **High ISO** option allows you to adapt the sharpening algorithms to images shot at high sensitivity and therefore with noise, which may be amplified by any sharpening. Click the button to activate High ISO.

4. **Apply to entire image**: This slider works best in conjunction with the control points. As long as you are satisfied with overall sharpening, this slider is set to 100%, but you can also use it to modulate the sharpening.
When sharpening, you can compare the image before and after correction by zooming in on the image, or by using the Loupe, the Preview button, or the different display modes available in the top bar. For more information about these tools, see the [Interface and keyboard shortcuts](#) page.

Enhancing sharpness with control points

Applying and using control points

Control points allow you to enhance the sharpness in a very precise way on elements of the image rather than its entirety. For example, in a portrait, you may want to sharpen the eyes and mouth but not the skin; and in a landscape, you may want to sharpen the ground, but not the sky (especially a blue sky where noise could quickly appear). In the **Selective sharpening** section on the right, a menu allows you to choose between two methods, Control Points, discussed here, and Color Ranges, discussed further below.
1. From the drop-down menu, choose Control Points.

2. Click on the "+" button on the right.

3. Click in the image to place a control point on the area to be treated.

4. The Apply to entire image slider automatically changes from 100% to 0%.

5. Adjust the radius of action of the control point with the first slider.

6. Accentuate the sharpness with the Adaptive Sharpening and/or Sharpen Areas/Sharpen Edges sliders, located in the top right corner of the panel (see previous paragraph).

7. Adjust the sharpness to your liking using the control point’s Opacity slider (set to 100% by default).
Using multiple control points and grouping them together

To correct a large area of the image, set additional control points and repeat the above steps. You can also chain the control points by activating the Select tool (A key), then drawing a rectangle that encompasses multiple control points. In this case, you can simply move one slider to make the emphasis apply equally to all the others.
Protecting with a negative control point

*Left: blue sky unprotected from accentuation (100% opacity) / Right: protected blue sky (0% opacity)*

You can also protect part of the image from sharpening with a negative control point (you can also put several negative control points together and chain them):

1. In the **Selective sharpening** section, click the "-" (minus sign) button.
2. Click in the image to place the protection control point.
3. Adjust the radius to cover the area to be protected. The negative control point’s **Opacity** slider is set to 0 (no sharpening) by default, to protect that part of the image.

Here is another example showing the accuracy of a control point emphasis in the case of a portrait. Control points were placed on the eyes [1] and at different points of the mouth [2] to make them sharper, while negative control points [3] were placed to protect the skin from any sharpening:
The sharpness mask display mode shows the sharpened areas in white and the protected areas in black.
Duplicating a control point

There are two ways you can duplicate a control point:

Method 1:
1. Click on the control point you want to duplicate in the list of control points to select it.

2. Click on **Duplicate**.

**Method 2:**

1. Move the mouse over the control point to duplicate in the image while pressing the Alt/Option key. The mouse pointer will change to a "+" sign.

2. Click and hold the click on the control point, then drag the duplicate to where you want it.

---

### Deleting a control point

There are three ways to delete one or more control points:

**Method 1:**

1. In the list, click on a control point to select it.

2. To select the entire list or contiguous control points, click on the first control point and then click on the last control point while holding down the **Shift** key.

3. To select several control points that are not adjacent to each other, choose **Ctrl/Cmd**.

4. Click on the **Delete** button.

**Method 2:**

1. In the image, click on the control point you want to delete to select it.

2. Delete it using the **Delete** or **Backspace** key on your keyboard.

**Method 3:**

1. To delete multiple control points in the image, activate the **Selection** tool (**A** key).

2. Draw a rectangle around the control points you want to delete.
3. Use the Delete or Backspace key on your keyboard, then validate in the dialog box that appears (you can deactivate its display by checking Do not display again).

Enhancing sharpness with color ranges

Another method of sharpening is color-dependent. By default, RAW Presharpener offers you three ranges: red, orange, blue, represented by tiles accompanied by an eyedropper, which will allow you to select colors directly in the image. After choosing Color Ranges from the Method menu:

1. Click on an eyedropper to activate it.
2. Place it in the image, then click.
3. The corresponding color is taken and indicated in the small tile.
4. Enhance the sharpness with the Adaptive Sharpening and/or Sharpen Areas/Sharpen Edges sliders.
5. Adjust the sharpness with the Opacity slider below each color range (default setting is 100%).
6. For a different color range, click another eyedropper and repeat the previous steps.

To add a color range, click on the "+" button below the list, which will display a tile (in pale violet), the eyedropper, and the associated sliders. You can add as many ranges as you wish,
and you can remove them individually by clicking on their "-" (minus sign) button.

Note that protection control points can be combined with color range sharpening.
Output Sharpener — creative output enhancement

The Output Sharpener plugin allows you to prepare and sharpen your image in a creative way, depending on its destination (electronic publishing, printing, circulation) and on its size and resolution. This last stage of sharpness work comes after the following steps:

- Creative sharpening in the host application
- Initial sharpening in RAW Presharpener

Output Sharpening and Creative Sharpening are closely related in Output Sharpener, because they occur after you have decided what type of media you are going to use for your image. This means you first deal with the tools in Output Sharpening, and then with the tools in Creative Sharpening.

On this page we will discuss the following topics:

- Output Sharpening
- Creative Sharpening
- Selective Sharpening
- Presets

When working on the sharpness of your images, remember to use the comparison and verification display modes, as well as the Loupe and Zoom functions, the latter being essential for checking the sharpness and the possible appearance of artifacts and sharpening halos along the edges. You will find all the necessary information about these functions in the Interface and keyboard shortcuts page.

Output sharpening

In this section, you will determine the output media for your image, between on-screen display, which is the default choice, and a number of methods for printing on paper. This is the first step before moving on to creative sharpening, since for the latter you will not use the same settings for a screen and an inkjet printer. To choose the output media, click to scroll down the list (the options depend on the output type, although all types may share some settings in common):

1. **Display**: Sharpens the image for display on a computer screen (electronic publishing, web gallery, etc.).
Adaptive Sharpening: Set to 50% by default, enhances or reduces overall sharpness (it works similarly to the same slider in RAW Presharpener).

2. Inkjet: Enhances the sharpness of an image printed on an inkjet photo printer.

• Viewing Distance: Set to Auto by default, adjusts the sharpness according to the distance from which the viewer will view the print. Five distances are provided; the farther away the observer is, the less detail they will perceive. Auto distance is a conservative approach based on the diagonal size of the image, and we recommend using this option, especially if you do not know how the print will be viewed. If you have chosen the **Sharpening Software Proof** display option, in the top bar, and you select a distance from the menu, your image will be displayed at a smaller size to simulate the effect of viewing distance.

• Paper Type: This menu offers several choices of paper (matte, glossy, etc.). Sharpness is influenced by the way the ink dots are absorbed by the paper, and by the texture of the paper.

• Print Resolution: Here you will have to choose the same setting as in the printer driver, and not the “commercial” resolution of your printer. The values are expressed in length x width and in DPI (dots per inch). In the menu at the very bottom, you can enter a value, by going to **User Defined**, then clicking on **Empty** to display input fields.

• Image Width / Image Height: Use these sliders to determine the physical size
of the print. Normally, they are not displayed, so you must go to Settings > Output Emphasis Settings > Image Size Sliders > Display.

3. **Continuous Tone**: Sharpens prints in the photo lab (unless your lab also uses inkjet).

![Output Sharpening](image)

- **Viewing Distance**
- **Print Resolution**: You can choose from several values expressed in DPI (150, 300, etc.), and you can also enter a value in the **Empty** field.

- **Image Width / Image Height**

4. **Halftone**: Enhances the sharpness of images for print media (newspapers, magazines, etc.).

![Output Sharpening](image)

- **Viewing Distance**
- **Paper Type**: Select the type of publication, newspaper, coated paper, glossy paper, etc.
- **Print Resolution**: The slider allows you to set the lpcm (lines per cm) value, according to the guidelines of the publication where your images will be printed.
5. **Hybrid Device**: You can apply this option if you do not know whether your images will be broadcast (screen) or published (print).

[Image of Hybrid Device settings]

- **Viewing Distance**
- **Image Width / Image Height**

* For more details, refer to the function description in section 2, *Inkjet*, above.

**Creative Sharpening**

Once you have established how to adjust the sharpness of your images because of their destination and output media, it is time to move on to the creative part of the sharpening process, either globally, or with selective tools (control points and color ranges), discussed in the next paragraph, which use the same sliders and algorithms. The Creative Sharpness section in the right panel offers the following tools:

1. **Output Sharpening Strength**: This overall sharpness slider allows you to modulate all other settings. The default value is 100%; you can de-emphasize the sharpness to the left, and amplify it to the right.

2. **Structure**: Enhances or attenuates textures, without affecting the sharpness of the edges.

3. **Local Contrast**: By acting on the micro-contrast of details, this slider lets you give more punch to your image (towards the right) or, on the contrary, to diffuse the details (towards the left).

4. **Focus**: Allows you to restore sharpness to elements of the image that are slightly out of
focus by moving the slider to the right. By adjusting the slider to the left, you introduce a blur effect, as if the lens focus had been shifted.
Selective Sharpening

Output Sharpener’s **Selective Sharpening** uses two methods that you can combine: with control points and/or with color ranges.

**Enhancing sharpness with control points**

Control points allow you to enhance the sharpness in a very precise way on elements of the image rather than its entirety. In the **Selective Sharpening** section a menu allows you to choose between two methods, Control Points, discussed here, and Color Ranges, discussed further below.
1. From the drop-down menu, choose **Control Points**.
2. Click on the "+" button.
3. Click in the image to place a control point on the area to be treated. The **Apply to entire image** slider automatically changes from 100% to 0%.
4. Adjust the radius of action of the control point with the first slider.
5. Apply one of the 4 available corrections (click on the small triangle to reveal all the sliders):
   - **Output sharpening intensity***
- Structure (S)*
- Local Contrast (LC)*
- Focus (F)*

* These sliders are the same as the ones in the **Creative Sharpness** section; refer to the paragraph dedicated to this section to learn more about these tools.

To correct a large area of the image, set additional control points and repeat the above steps. You can also chain the control points by activating the **Select** tool (A key), then drawing a rectangle that encompasses multiple control points. In this case, you can simply move one slider to make the emphasis apply equally to all the others.
Protection control points set in the sky (as well as in the canopy of the bridge), all sliders at 0.

Middle: Global accentuation applied; the bridge is sharper, the sky remains intact (no increase in grain/noise).

Bottom: The effect mask, white shows enhanced areas, black shows protected areas.

You can also protect part of the image from sharpening with a negative control point (you can also put several negative control points together and chain them):
1. Click the **Add Control Point** (+) button.

2. Click in the image to place the protection control point.

3. Adjust the radius to cover the area to be protected. Set the sliders to 0 (no sharpening) to protect that part of the image.

### Managing control points

From the control point list, you can do the following:

1. Temporarily deactivate a control point: check on the **Show/hide effect of Control Point** box on its left.

2. The value in % shown on the right indicates the size of the control point’s radius of action (adjusted with the **Size** slider for each control point).

3. **Show/hide selection for all Control Points**: You can display the monochrome mask of all control points at the same time by clicking the square button in the header of the control point list, or individually by checking the checkbox(es) in the same column. Note that the mask displays white (areas affected by 100% corrections), black (areas not affected by corrections), and shades of gray, depending on the density of the correction.

4. **Reset the control point sliders**: The curved arrow on the far right resets the slider settings for the selected control point to 0%.

5. **Duplicating a control point**

There are two methods for duplicating a control point:

   **Method 1:**
   1. Click on the control point you want to duplicate in the list of control points to select it.
   2. Click on **Duplicate**.
Method 2:
1. Move the mouse over the control point to duplicate in the image while pressing the Alt/Option key. The mouse pointer will change to a "+" sign.
2. Click and hold the click on the control point, then drag the duplicate to where you want it.

6. Deleting a control point

There are three ways to delete one or more control points:

Method 1:
1. In the list, click on a control point to select it.
2. To select the entire list or contiguous control points, click on the first control point and then click on the last control point while holding down the Shift key.
3. To select several control points that are not adjacent to each other, choose Ctrl/Cmd.
4. Click on the Delete button.

Method 2:
1. In the image, click on the control point you want to delete to select it.
2. Delete it using the Delete or Backspace key on your keyboard.

Method 3:
1. To delete multiple control points in the image, activate the Select tool (A key).
2. Draw a rectangle around the control points you want to delete.
3. Use the Delete or Backspace key on your keyboard, then validate in the dialog box that appears (you can deactivate its display by checking Do not display anymore).

Enhancing sharpness with color ranges
Choose **Color Ranges** from the **Method** menu. By default, RAW Presharpener offers you three ranges: red, orange, blue, represented by tiles accompanied by an eyedropper, which will allow you to select colors directly in the image:

1. Click on an eyedropper to activate it.
2. Place it in the image, then click.
3. The corresponding color is taken and indicated in the small tile.
4. Enhance the sharpness with the **Output Sharpening Strength** slider for each color range as desires (default value is 100%).
5. For a different color range, click the eyedropper into another color and repeat the previous steps.

To add a color range, click on the "+" button below the list, which will display a tile (in pale violet), the eyedropper, and the associated sliders. You can add as many ranges as you wish, and you can remove them individually by clicking on their "-" (minus sign) button.

Note that the protection control points can be combined with color range accentuation.

**Presets**

If you have developed a sharpening method and want to use it later on future images, you do not need to redo all the settings every time you start a work session. At the top of the right panel
is a section for managing presets:

1. Make your settings in Output Sharpener.
2. In the Presets section, click **Add New Preset**.
3. A dialog box will prompt you to enter the name of your preset.
4. Validate by clicking **OK**. Your preset appears in the section. When working on a new image, click on the preset to apply it.

You can create as many presets as you want, and manage them with the following commands:

1. To update your preset with new settings, hover your mouse over the preset, then click the **Update** button on the right.
2. To delete a preset, move the mouse over it and click the **X** button on its left.
Silver Efex Pro 3
The Silver Efex Pro 3 module will allow you to discover (or rediscover) black & white photography, thanks to its numerous presets, global and selective correction tools, filters and numerous colorization effects, tone curves, analog film simulations, and finishing tools (including vignetting, burnt edges, and image contours).

The carefully designed, ready-to-use renderings may be more than enough to satisfy you, but you can also modify them to your liking, or create renderings from scratch. You can also share them with other Silver Efex Pro 3 users.
Silver Efex Pro 3 settings and help

Silver Efex Pro 3 allows you to make a number of adjustments to its display modes and to access the online user guide.

- Preferences
- Help

Preferences

To access the Preferences:

- Mac: click on the Silver Efex Pro 3 menu at the top left, then select Preferences.
- PC: Go to the File menu, then select Preferences.

The Preferences window contains a single tab called General. It offers the following options (from top to bottom):
**Default preview mode**: allows you to choose how the image will be displayed upon opening, either **Single Image Display**, **Split Preview** (the image is separated by a line, before corrections on the left, after corrections on the right), or **Side-by-Side Preview** (the two versions of the image, before and after corrections, are presented next to each other).
• **Background color**: you can select the level of gray on which you want to see your images: white, gray, dark gray, black.

• **Zoom status**: sets the zoom value applied to the aperture, from Fit (fit display) to 3:1 (300%).

• **Graphics processor**: Check this box if you want Silver Efex Pro 3 to take advantage of the computing power of your graphics card.

• **TIFF compression**: Choose between compression with the LZW method, which reduces the file size, or no compression.

• **JPEG quality**: Allows you to adjust the compression and quality of the JPEG files generated when you save your work in Silver Efex Pro 3. The default setting is 80%, a good compromise between quality and file size.

• **Language**: Nik Collection by DxO offers a choice of 17 languages.

• **Reset preferences**: click on the Reset button to reset preferences to default values and choices.

* By default, if you do not change this option, the last setting is used.

** Changes take effect at the next launch.

Common options and settings made in one module will apply to all modules in the Nik Collection by DxO.

Click on the **Save** button to save your changes. Some changes will not be applied until the next launch (see above). To leave the Preferences without taking your changes into account, click on **Cancel**.

Help
Silver Efex Pro 3, Help menu (top: Mac, bottom: PC)

To access the online help links, you can go to the Help menu (internet connection required):

- **User Guide**: viewable online and downloadable as a PDF
- **Frequently asked questions**
- **Online support**: report problems and ask questions after creating a support ticket
- **DxO Academy**: tutorials, videos, webinars
- **Check for updates**: if an update is available, you can download and install it. When installing the update, you will be prompted to close the Nik Collection by DxO and host programs.
- **About Silver Efex Pro 3** (PC): Displays the home screen with the installed version number.

* Internet connection required.
Silver Efex Pro 3 interface

The Silver Efex Pro 3 is composed of the following elements:

1. The menu bar
2. The upper toolbar
3. The image display area
4. The left panel (presets)
5. The right panel (tools)
6. The lower toolbar

> Keyboard shortcuts

The six elements of the Silver Efex Pro 3 interface

The menu bar

Mac:
The menu bar at the top of the Silver Efex Pro 3 window contains the following menus:

1. **Silver Efex Pro 3**: gives access to the Preferences.

2. **Edit**: contains the Undo and Redo commands, to undo or redo previous actions one by one, as well as the Apply Last Edit command, which allows you to apply corrections made to another image during a previous session with Silver Efex Pro 3 to a new image.

3. **Help**: contains links to the user guide, DxO support, etc. (see the Preferences and help page).

PC:

The menu bar at the top of the Silver Efex Pro 3 window includes the following menus:

1. **File**: gives access to the Preferences.

2. **Edit**: contains the Undo and Redo commands, to undo or redo previous actions one by one, as well as the Apply Last Change command, which allows you to apply the corrections made to another image during a previous session with Silver Efex Pro 3 to a new image.

3. **Help**: contains links to the user guide, DxO support, etc. (see the Preferences and help page).
The upper toolbar

The upper toolbar includes the display, comparison, and zoom tools.

Compare and Zoom buttons

The Compare and Zoom buttons let you compare your image before and after correction:

1. **Alternate**: click on the button to display the image before correction, release to display the corrected image.

2. **Split vertically or horizontally**: divide the image in two with a vertical line that can be moved left or right, and switch to horizontal mode by clicking on the arrow in the center of the line, with the possibility to move it freely up or down. The left half (or top half) represents the image before correction, as it was opened in the plug-in, the right half (or bottom half) represents the processed and corrected image. You can zoom and move synchronously in both halves of the image, either with the Navigator or with the Hand tool, by pressing the Space bar.

3. **One above the other** or **side by side**: the pre-correction version is displayed at the top, the post-correction version at the bottom. You can also display both versions of the image side by side by clicking on the button between the two. You can also zoom and move synchronously in both images, either with the Navigator or with the Hand tool, by pressing the Space bar.

4. **Fit**: displays the entire image in the display area.

5. **Fill**: displays the image so that it fills the entire display area (image will therefore be cropped).

6. **1.1**: standard zoom value equivalent to 100% (1 pixel of the image = 1 pixel of the screen).

7. **2.1**: zoom value equivalent to 200%.

8. **Other zoom values**: by clicking on the arrows, a menu offers other zoom values. When you select one of these values, it is displayed in the button (7).
Alternate display mode.

Vertical or horizontal split display mode.
Display modes: one on top of the other or side by side
(Note that you can zoom in the comparison modes.)

As soon as you zoom into the image (including in Fill mode), a floating navigation window appears at the top right of the image display area. You can move around the image by grabbing the pad or by clicking in the floating navigation window.

The floating navigation window (Zoom mode)
The image display area

This is where the image is displayed on a medium gray background that you can change in the Preferences.

Below the image you will find the following information:

1. If you have opened several images,* a small horizontal scrollbar allows you to switch from one to the other.

2. File name and extension. If the image has EXIF metadata, the shooting and material settings will also be displayed.

3. You will also find the checkbox for non-destructive workflow mode.

* Note that if you want to open multiple images, you must do so all at the same time.
The left panel (presets)
The left panel contains all the filters and effects grouped into 6 categories (All, Classic, Modern, 25th Anniversary, In Vogue, Retro) under the Presets section, as well as Custom, to create your own presets, Imported, to load effects shared by other users and, finally, a History section, which compiles all the corrections and adjustments applied to the selected image (see below). You can hide or reveal the left panel either by clicking on its right edge or by pressing the L key. The presets are presented as preview thumbnails of the image opened in the plug-in. If the image is framed horizontally, the thumbnails are arranged in a single-image column. If the image is cropped vertically, the thumbnails are grouped in pairs.

To hide or reveal a section, click on the arrow on the right. The number indicates the number of presets in each section, and the double arrow lets you save and export a preset. In each section, you can filter the presets by favorites or recently used. Finally, to hide or reveal the left panel, click on the right edge.
The left panel

For detailed information about these sections, refer to the chapter on Using and
managing presets

History

The **History** section shows all the processing and correction steps of your image, from top (oldest) to bottom (most recent). To see the image at a particular stage, click on the stage in question in the list. The selected step is displayed in yellow, all previous steps (top) are white, and all subsequent steps (bottom) are grayed out: if you make a correction at this point, the grayed out steps will be removed.

In split or side-by-side display mode, you can apply a step to the left view from the history by moving the history selector (the yellow arrow on the left edge of the section).

The right panel (tools)

The right panel contains all the global and selective correction sections, as well as a loupe (magnifying glass) and a histogram, arranged from top to bottom:

- **Loupe** (see below)
- **Histogram** and **Zone system** (see below)
- **Global settings***: global tone and color correction sliders, and selective tone sliders.
- **Selective settings***: creation and management of control points. Activating them displays sliders equivalent to global settings, selective tonality, as well as a color picker and color selectivity sliders.
- **ClearView***: atmospheric haze correction tool
• **Color filter**: selection of color filters, imitating optical filters

• **Film types**: simulations of analog films inherited from the Nik Collection

• **Film grains**: simulations of analog films made by DxO, and associated grain adjustment tools

• **Finishing adjustments**: (Toning, Vignette, Burn Edges, Image Borders)

• **Save preset** button: allows saving the settings as presets

* For detailed information about the operation and use of these tools, refer to the **Correction tools** and **Using and managing presets** sections.

You can hide or reveal the right panel by clicking on its left edge or with the R key. Likewise, you can hide or reveal the sections by clicking on their respective arrows at the top right.

When you exit and return to Silver Efex Pro 3, the status of the sections in the right panel — open or closed — is retained.

To reset a setting, double-click the slider. To reset the settings for each section, click on the rounded arrow.

The checkbox in front of each section name allows you to temporarily deactivate and reactivate the corrections for the sections concerned.
The right panel
Loupe

The Loupe section is available regardless of the tools used:

- The loupe permanently displays an enlarged preview of the image area hovered over by the mouse.
- The loupe can be locked at any point in the image by clicking on the pin and then in the image (tilted pin: inactive, vertical pin: active).
- When you activate one of the zoom modes, the loupe is centered by default.

Histogram

The histogram shows the distribution of the brightness levels of the pixels in the selected image, with dark tones on the left, medium tones in the center, and light tones on the right, with the peaks corresponding to the number of pixels per brightness range. You can view the histogram in different ways by clicking on the buttons:

- **RGB**: default indication, covering the 3 channels Red, Green, Blue as well as the complementary colors Cyan, Magenta and Yellow, according to the principle of additive synthesis.
- **R**: displays only the red channel.
- **G**: displays only the green channel.
- **B**: displays only the blue channel.
- **L**: displays the global luminosity values.
Thanks to the possibility of displaying the brightness values per channel, you will be able to act more precisely on your tonality (exposure, contrast) and color settings. Note that the histogram is also present in the **Levels & Curves** tool.

**Zone system**
Above the histogram are blocks numbered from 0 to 10. This is the “Zone system”: when you click on one of the blocks, the parts of the image that correspond to that level of brightness are highlighted by a colored, hatched mask. Zone 0 is deep black, and Zone 10 is pure white, which can help you adjust the tonality of your image so that it doesn't have clipped tones and therefore loses detail.

The Zone system is enabled by default, and you can disable and re-enable it by clicking in the first box on the left. It can be used regardless of the histogram display mode (RGB, R, G, B or L).

**The bottom toolbar**

The bottom bar includes the following information and functions:

1. **File source**: indicates the name of the host application.
2. **Cancel**: Cancels the current processing and corrections and closes the plug-in. The image in the host application is not modified.
3. **Apply**: saves the processing and corrections and closes the plug-in. The image in the host
application is modified (if several images are open, the button says **Apply...**, short for **Apply to all**).

## Keyboard shortcuts

<table>
<thead>
<tr>
<th>Action</th>
<th>Windows</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel</td>
<td>Ctrl + Z</td>
<td>Cmd + Z</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl + Y</td>
<td>Cmd + Y</td>
</tr>
<tr>
<td>Full screen</td>
<td>F</td>
<td>F</td>
</tr>
<tr>
<td>Preview</td>
<td>P</td>
<td>P</td>
</tr>
<tr>
<td>Show / Hide the left and/or right panels</td>
<td>Tab (both), L (left), R (right)</td>
<td>Tab (both), L (left), R (right)</td>
</tr>
<tr>
<td>Apply the preset</td>
<td>Enter</td>
<td>Return</td>
</tr>
<tr>
<td>Cancel the preset</td>
<td>Esc</td>
<td>Esc</td>
</tr>
<tr>
<td>Zoom</td>
<td>Spacebar</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Select several control points in the image</td>
<td>Ctrl + A</td>
<td>Cmd + A</td>
</tr>
<tr>
<td>Select several control points in the list</td>
<td>Ctrl + click</td>
<td>Cmd + click</td>
</tr>
<tr>
<td>Supprimer un point de contrôle</td>
<td>Delete</td>
<td>Delete</td>
</tr>
<tr>
<td>Duplicate a control point</td>
<td>Ctrl + D, Alt + drag &amp; drop</td>
<td>Cmd + D, Alt + drag &amp; drop</td>
</tr>
<tr>
<td>Group control points</td>
<td>Ctrl + G</td>
<td>Cmd + G</td>
</tr>
<tr>
<td>Ungroup control points</td>
<td>Ctrl + Shift + G</td>
<td>Cmd + Shift + G</td>
</tr>
</tbody>
</table>
Using and managing presets
The left pane, dedicated to presets, consists of the following sections:

- Presets
- Custom
- Imported
- History (see the Interface and keyboard shortcuts page)

Each section can be hidden or expanded using the arrow to the right of the section name. The number indicates the number of presets in each section.

Presets section
Presets consist of adjustments and corrections whose effect is represented by thumbnails, using the active image. Presets are a quick way to learn how to use Silver Efex, while providing a starting point for creating custom presets, which you can then apply to your images with a single click.
Preset categories

At the top of the Presets section, the presets are organized by category (All, Classic, Modern, 25th Anniversary, En Vogue and Retro). If you click on any of the categories, the associated presets are displayed in a scrolling list of thumbnails.

Starting image (Neutral preset)
Selecting another preset (002 Overexposed)

Warning about changing presets
Applying the new preset and setting changes

To apply a preset, click on its thumbnail in the left pane. The corrections are immediately applied to the image, and a dialog box tells you that the previous settings and corrections will be replaced. Click Yes to accept, and No to cancel (if you don't want to see the dialog again, check the Don't show again box).

Each time you apply a preset, the settings and sliders change in the right pane, reflecting the preset's corrections.
You can mark presets as favorites by clicking on the gray star to the left of each thumbnail. Favorite presets are indicated by a gold star. To remove the favorite status, click on the gold star and it will return to gray.
The Presets section also allows you to filter and display presets according to the following statuses (you can add the filters):

- Favorite presets: click on the **Favorites** button.
- Recently used presets: click the **Recent...** button.

Active filters are represented by their respective light gray buttons and the brighter name. To revert to a single filter or to disable filters completely, click on the relevant button(s).

**Custom presets section**

The Custom section stores presets that you create, and also has tagging and filtering by favorites or recently used.
Creating a custom preset

1. Open a photo in Silver Efex Pro 3 and apply any desired adjustments.

2. Click on the 'Save' button to open the Custom Preset dialog.

3. Enter a name for your custom preset in the 'Enter name for new preset' field. For example, you could name it 'Smooth contrast + Cyanotype'.

4. Optionally, select the 'Save with Control Points' checkbox if you want to save the specific settings used to create the preset.

5. Click on the 'Save' button to save your custom preset. You can then apply it to other photos to achieve a consistent look.
To create a custom preset:

1. Make the desired corrections with the tools in the right pane, both global and selective settings (control points).

2. At the bottom of the right pane, click the **Save preset** button.

3. In the **Custom type** dialog box, enter an explicit name (e.g., Soft Contrast + Cyanotype, Color and Contrast +, Desaturation, Structure ++, etc.).

4. If you want to save the control points and the associated selective corrections, make sure that the Save with control points box is checked (it is checked by default).

5. Validate by clicking on **Save**.

6. The custom preset appears in the **Custom** section in the left pane.

* You can also save by going to the **Custom** section, clicking on the double arrow to the right of the number of presets and selecting **Save preset** from the pop-up context menu.

Managing custom presets
You can take advantage of your custom presets with the following features:

1. **Rename**: Click on the preset name below the thumbnail to activate the input field. After entering the new name, press **Enter** to confirm.

2. **Mark as favorite**: Click on the star to the left of the preset (the star turns gold). Click again to cancel (the star turns light gray again).

3. **Export**: Hover over the preset to display the buttons to the right in the thumbnail. Clicking the top button will allow you to export the preset, for the purpose of sharing it. A system dialog allows you to choose the save location, before clicking **Open**.

4. **Update**: After editing or adding corrections from a custom preset, hover over the thumbnail to display the buttons on the right. Click on the curved arrow to update the preset with the modified or added corrections.

5. **Delete**: Hover over the preset to display the buttons to the right in the thumbnail. Click the trash can to delete it.

* These commands are available only for custom presets, not for original presets.
To export all your custom presets:

1. Click the double arrow to the right of the number of custom presets.
2. From the pop-up menu, select Export all.
3. A system dialog box allows you to choose the save location and confirm.

**Imported presets section**

This section allows you to import presets shared by other users, and with a few exceptions, its operation is similar to that of the Custom section.

**Importing presets**
To import presets:
1. In the **Imported** section, click the double arrow to the right of the preset number.
2. From the pop-up menu, select **Import preset**.
3. A system dialog box will open. Locate the location of the presets you want to import.
4. Select the presets you want to import, then click **Open**.
5. The imported presets are displayed in the **Imported** section.

**Managing imported presets**
You have tools and controls for renaming, bookmarking, exporting, and deleting your custom presets:

1. **Rename**: click on the name of the preset under the thumbnail to activate the input field. After entering the new name, confirm with the Enter key.

2. **Mark as favorite**: Click on the star to the left of the preset (the star turns gold). Click again to cancel (the star turns black again).

3. **Export**: Hover over the preset to display the buttons to the right in the thumbnail. Clicking the top button will allow you to export the preset, for the purpose of sharing it. A system dialog allows you to choose the save location, before clicking Open.

4. **Delete**: Hover over the preset to display the buttons to the right in the thumbnail. Click on the trash can to delete it.

*These commands are available only for imported presets, not for presets shipped with Silver Efex Pro.

If it is not possible to edit and update imported presets in the Imported section, you can do so by creating a new preset from an imported preset:

1. Apply the preset you want to modify.

2. Edit the tool corrections in the right pane as desired, both global and selective (control points).

3. At the bottom of the right pane, click the Save preset button.
4. In the **Custom Preset** dialog box, enter an explicit name (e.g., Soft Contrast + Cyanotype, Color and Contrast +, Desaturation, Structure ++, etc.).

5. If you want to save the control points and the associated selective corrections, make sure that the **Save with control points** box is checked (it is checked by default).

6. Validate by clicking **Save**.

7. The modified imported preset appears in the **Custom** section in the left pane.

Finally, just as with custom presets, you have the possibility of exporting all your imported presets:

1. Click on the double arrow to the right of the number of imported presets.
2. From the pop-up menu, select **Export all**.
3. A system dialog allows you to choose and confirm the save location.
Correction tools

On this page you will find a description of all the tools available in the right pane of Silver Efex Pro 3, both for global image correction and for selective adjustments with Control Points. All of these tools can be used based on the default preset applied when you open the image (type 000 Neutral), or based on one of the presets you choose in the left pane.

- **Global Adjustments**
- **Selective Adjustments**
- **ClearView**
- **Color Filter**
- **Film Types**
- **Film Grain**
- **Finishing Adjustments**

**Global Adjustments**

The Global Adjustments section allows you to correct and adjust image tone, brightness, contrast, detail and texture using the following 4 groups of sliders:

1. **Brightness Adjustments**:
   - **Brightness**: changes the brightness of the image. Moving this slider to the left
darkens the image while moving it to the right increases the brightness of the image.

- **Highlights**: adjusts the brightness of light areas in the image.
- **Midtones**: adjusts the brightness of the midtone areas in the entire image.
- **Shadows**: adjusts the brightness of dark areas in the image.
- **Dynamic Brightness**: uses a unique algorithm that automatically adjusts to different areas of the image. This slider allows for finer changes in brightness, ensuring that the image retains a good range of detail, preserves contrast and intelligently applies brightness values to different areas of the image. Move the slider to the left to darken the image while retaining detail in the highlights. Moving the slider to the right will lighten the image while retaining detail in the shadows.

2. **Contrast adjustments**:

- **Contrast**: controls the overall contrast of the image, i.e. the difference between the density of the dark areas and the brightness of the light areas.

- **Amplify Whites**: The slider uses an algorithm that provides unique control over the highlights of the image. By moving this slider to the right, the highlights in each area of the image become brighter. Because of the adaptive nature of the algorithm, each area is treated differently, taking into account its particular characteristics.

- **Amplify Blacks**: Similar to the Amplify Whites slider, this slider uses a unique algorithm to control the tone of the image. Move this slider to the right to make the darker tones in each area of the image even denser. Because the algorithm is adaptive, each area is treated differently, taking into account its particular characteristics.

- **Soft Contrast**: the purpose of the slider is to provide a different approach to contrast, less harsh and with much more diffuse transitions.

3. **Structure Adjustments**:

- **Structure**: controls the overall structure of the image. Increasing the setting emphasizes detail and texture, while decreasing softens fine detail for smoother surfaces.

- **Highlights**: selectively adjusts the structure of light areas in the image.

- **Midtones**: selectively adjusts the structure of midtones in the image.

- **Shadows**: selectively adjusts the structure of darker areas in the image.

- **Fine Structure**: similar to the Structure slider, adjusts the finest details in the
4. **Tonality Protection**: these sliders allow you to recover details in shadows and highlights that were lost during brightness and/or contrast adjustments.

- **Shadows**: moved to the right, the slider will lighten only the shadows and recover the details hidden in the dense areas.
- **Highlights**: moved to the right, the slider will darken only the lightest areas and recover the details embedded in them.

### Selective Adjustments

The tools in the Selective Adjustments section allow you to change only certain parts of the image. Add a control point, and when adjusting the corresponding sliders, it will affect only the objects or areas covered by the control point.

You can find more information and details about the operation of Control Points in the dedicated chapter.

### Adding control points

![Control Points](image)

To place and use a control point:

1. In the **Selective Adjustments** section, click the button to the right of **Control points**.
2. As you move through the image, the mouse cursor changes to a control point.
3. Click where you want in the image to place the control point.
4. The control point appears as a yellow (active control point) or white (inactive control point) dot.

5. When it is active, the control point has a slider for adjusting the radius of effectiveness, represented by a circle.

6. When the control point is inactive, you can move the mouse over it to see the slider and the radius (but to adjust them, you must first activate the control point by clicking on it).

7. If desired, you can move a control point (active or inactive) by holding down the mouse button and moving the mouse.

8. You can add as many control points as you want by repeating steps 1 to 3.

9. To delete a control point, click on it to activate it and press the Delete key on your keyboard. A dialog box will prompt you to confirm (check the Don't show again box to stop displaying the dialog box).

Managing control points

The Selective Adjustments section allows you to manage the various control points applied to the image, presented here as a numbered list. The active control points are indicated in yellow.

1. **Create a control point**: see previous paragraph (*Adding a control point*).
2. **Size**: indicates in % the size of the radius of effectiveness of the control point.
3. **Show/Hide selection for all control points**: this button allows you to display the
monochrome masks of all the control points. To display the mask of only one control point at a time, check the box on the right in the list. In the monochrome mask, white indicates the areas of the file where 100% of the correction is applied, black indicates no correction and the gray variations indicate the areas more or less affected by the correction.

4. **Control point list:** control points indicated by the yellow icon and white text are selected and active, grayed out control points are inactive.

5. **Enable/Disable effect for all control points:** the checkbox disables and re-enables all control points applied to the image, as well as the associated corrections and settings.

6. **Show/Hide control point effect:** The checkbox allows you to temporarily disable and re-enable the display of the control point in question, as well as the associated corrections and settings.

7. **Show/Hide control point selection:** this button allows you to display the monochrome mask of the control point concerned (see also point 3).

8. **Duplicate:** by clicking on this button, you duplicate the currently selected control point(s). You can also duplicate a control point by clicking on it while pressing the Alt/Option key, then dragging the mouse to reposition the duplicated control point.

9. **Group:** You can group multiple control points by first selecting them in the list, holding down the Ctrl (PC) or Cmd (Mac) key and then clicking on this button. In the list, the control points are grouped into a group named Group 1, Group 2, etc. In the image, the first control point selected to form the group is indicated by the normal dot, and all other control points in the group are indicated by a small yellow dot. When you apply a correction to one of the control points, the correction will be applied to the other control points in the group. However, the size slider for each control point in a group can be adjusted independently. You can also select multiple control points by clicking in the image and then, while holding down the left mouse button, draw a selection rectangle encompassing the desired control points (then you can group them by clicking the **Group** button).

10. **Ungroup:** to remove the grouping of control points, select the group from the list and press this button. All control points will be displayed as ungrouped, allowing you to delete, modify or create new groups from the individual control points.

11. **Delete:** Click the Delete button to delete the currently selected control points.

12. **Reset:** Resets all sliders and settings associated with the active control point.
Display of the control point selection as a monochrome mask:

- **Black**: No correction; **White**: 100% correction

*Gray variations: corrections with greater or lesser intensity (see points 3 and 7 in the list above).*

Renaming control points and groups
To help you manage and keep track of your control points and/or control point groups, which can grow quickly, you can rename them as you wish:

1. In the list of control points, double-click on the name of the control point or group to rename. To be renamed, the control point or group must be inactive.

2. The name is highlighted: enter the new name directly. The old name is deleted as soon as you start typing.

3. If you just want to change the name, move the blinking input pointer using the left or right arrows on your keyboard.

4. Confirm by clicking outside the list or by pressing **Enter**.

Renaming does not change the order of the checkpoints in the list, and there is no automatic consideration of alphabetical order; nor can you change the order by drag and drop.

Selective Adjustment sliders
1. **Color selectivity:**
   - Luminance.
   - Chrominance.

2. **Standard selective settings sliders***:
   - Brightness
• Contrast
• Structure
• Amplify Whites
• Amplify Blacks
• Fine Structure
• Selective Colorization: in a black and white image, restores the colors of the portion of the image within the area covered by the control point field. This allows you to highlight an element or a detail in a photo, for example.

* See the Global Settings paragraph for the role and operation of these sliders.

3. Selective tones:

• Highlights: moved to the left, this slider recovers information and details in the brightest parts of the image, especially those close to the clipping (right end of the histogram). Moved to the right, it allows you to give more brightness to the lightest tones.

• Midtones: this slider acts on the midtones (shown in the central section of the histogram).

• Shadows: this slider allows you to lighten the shadows and dark parts of an image.

• Blacks: moving the slider to the right lets you set the "black point" (left end of the histogram) and thus avoid clipping the darkest parts of the image. Conversely, moving the slider to the left, you will make the darkest areas of the image even more dense.

The control points in Silver Efex Pro 3 no longer have their own sliders, as the number of sliders can get in the way of image visibility. This means you will need to make your corrections using the sliders that appear in the Selective Adjustments section of the right pane after you have created a control point. Do not confuse them with the sliders in the Global Settings section.

You can reset a slider to its default setting by double-clicking on it; to reset all the sliders in the Selective Adjustments section, click on the curved arrow to the right of the name of the active control point.

Selective Adjustments allow you to change only certain parts of the image. Add a control point and when adjusting the corresponding sliders, it will affect only the objects or areas covered by the control point.
Here, two duplicate control points were used to add texture to the water, using the Brightness, Contrast, and Structure sliders. In the bottom comparison, the right view shows the activated masks, indicating the portions of the image where the correction is applied (in white) and where
it does not apply (in black).

You can group several control points together to apply the same correction to all of them. To do this, draw a block with the mouse so that it encompasses the desired control points.
Draw with the mouse to encompass the control points.

Grouped control points for applying the same correction
You can find more information and details about the operation of Control Points in the dedicated chapter.

Color Selectivity
The Color Selectivity sliders allow you to extend or reduce the range of the color of a control point. This will allow you to include in your correction variations in the hue and its brightness level (such as in order to take into account variations in skin tones; see example below).

- **Luminance**: determines the range of brightness of the color (default setting 50%).
- **Chrominance**: determines the range of hue variations of a color (default setting 50%).

The effect of the Color Selectivity sliders is subtle, so use the black/white mask display of the control point, as shown below:
Slight lightening with the Luminance slider: the correction is not homogeneous within the radius of the control point.

Adjusting the Color Selectivity
The brightness correction on the face is more homogeneous.
Monochrome mask for displaying the effects of the control point, here without using color selectivity

(in white: correction applied, in black: no correction)
Selective Colorization

The Selective Colorization slider restores the colors of the portion of the image on which the control point was placed on a black and white image. This allows you, for example, to highlight an element or detail in a photo. Of course, you can refine the effect by combining multiple control points, the monochrome mask of control point effects, and the Color Selectivity sliders.
Here, three control points were used with selective colorization to bring back the color of the face, hand, and neck.
ClearView

ClearView allows you to correct the effects of atmospheric haze and fog, which significantly alter the image, especially in distant shots. By restoring black levels, the tool will restore contrast, microcontrast, and saturation to your images. You can also use it to enhance the impact of images taken on a clear day.

The **Intensity** slider, set to 0 by default, allows you to adjust the effect of DxO ClearView Plus on a scale of 0 to 100.

ClearView, when used at high values, greatly enhances the presence of applied silver grain, and may also reveal unnoticed problems such as sensor specks and dust. Also be aware of its impact when used in combination with the **Structure** and **Fine Structure** sliders.

Without ClearView (left) and with Clearview (right)

Color Filter
The **Color Filter** section allows you to simulate the look of the color filters that photographers used to screw onto the lens to alter the contrast of their black and white film, depending on the subject being photographed (making the sky denser, clouds brighter, skin more radiant, etc.).

1. **Color Filters**: click on one of the color filters (red, orange, yellow, green, blue) to quickly select a simulated color filter to apply when converting to black and white. Each selected filter automatically sets the values for the Hue and Color Depth sliders (see below). The first filter is neutral (sliders set to 0), so you can freely define its hue and intensity.

2. **Hue**: adjusts the color of the simulated filter and controls the relationship of the colors in the image. Objects with the same hue as the selected value will become brighter, while objects with a complementary hue will become darker.

3. **Strength**: slide to the left for less contrast between colors or to the right for more contrast between colors.

*Click the Details arrow to expand (or hide) the Hue and Strength sliders.*
Film Types

Silver Efex Pro 3 offers two categories of analog film simulations:
- In the Film Grain section (here): analog film simulations created by DxO and inherited from Dxo FilmPack 5.
- In the Film Types section (see previous paragraph): simulations of silver film created by Nik Software and inherited from the original Nik Collection suite.
Silver Efex Pro 3 offers a collection of black and white films that simulate all their characteristics such as grain, contrast, and color response. You can also modify the characteristics as you wish using the tools available in this section. You can give a specific rendering to your image, or use grain to mask certain problems inherent to the lack of sharpness or excessive smoothing of noise (and details), or quite simply, to get away from the sometimes too-perfect rendering of digital images.

1. **Neutral** drop-down menu: allows you to choose from simulated black and white films,
grouped by ISO sensitivity. For a quick, real-time preview of the rendering, move the mouse over the list and then click on the film of your choice to apply the rendering.

2. **Original Grain** section: groups the sliders that allow to modify the film grain aspect (the sliders are preset according to the selected film):

   - **Grain per pixel**: changes the appearance of the grain applied to the image. Slide to the left for coarser grain or to the right for finer grain.

   - **Grain Hardness**: adjusts the separation and visibility of the grain structure. To the left (SOFT), the grain has a softer appearance, and a harder appearance to the right (HARD).

   

   **Zoom to at least 100% to check and better visualize the appearance of the grain according to your corrections.**

   3. **Sensitivity** section: allows you to change the sensitivity of the selected film to the different colors of the image, with the sliders preset according to the film chosen. In each of the 6 color channels, adjust the slider to the left to make the corresponding colors denser, and to the right to lighten them.

   4. **Levels & Curves** section: allows you to affect the contrast and tonal response of the selected film, with the curve preset according to the selected film. Click to add anchor points to the curve to change the brightness, contrast and tonal relationship of the image. Level adjustments are located below the curve, allowing you to control the tonality of the dark, medium and light values. To reset an anchor point, double-click the point you want to remove.
Rendering of Fuji Neopen 400 silver film (rendering inherited from Nik Original Collection).

**Film grain**

Silver Efex Pro 3 offers two categories of analog film simulations:
- In the Film Grain section (here): simulations of analog film created by DxO and inherited from DxO FilmPack 5.
- In the Film Types section (see previous paragraph): simulations of analog film created by Nik Software and inherited from the original Nik Collection suite.
In the Grain section, you can choose analog film simulations created by DxO, renowned for their fidelity, behavior, and realistic appearance:

1. **Original** menu: select a type of film from the list sorted by brand and alphabetical order.
2. **Intensity**: allows you to reduce or increase the presence of grain in the image.
3. **Grain Size**: sets the fineness of the grain (finer to the left, coarser to the right).

Zoom to at least 100% to check and better visualize the appearance of the grain according to your corrections.
Kodak TriX400 analog film rendering (from DxO Labs)

Finishing Adjustments
The **Finishing Adjustments** section is purely creative, allowing you to apply bending, vignetting, burnt edge and framing effects to your images.

1. **Toning** section: the tools in this section (click the arrow on the left to show or hide them all) allow you to tint black and white images, using darkroom toning techniques:

   - **Toning** drop-down menu: set by default to 1 (**Neutral**, no tinting). Hover your mouse over the list to see the effect in real time on your image. To select a toning and apply it, click on it.

   - **Strength**: This slider sets the overall intensity of the tone applied to the image and also affects the setting of the Silver Hue and Paper Hue sliders (see below).

   - **Silver Hue**: sets the replacement shade for the darker tones, represented by the silver grains in the film.

   - **Silver Toning**: sets the intensity of the dark tones.

   - **Balance**: determines the balance in the combination of tints applied to the dark tones (Silver) and the light tones (Paper). When this slider is set to 0%, the Silver and Paper tones are mixed with the midtones in a balanced way, and to the left you give more importance to the tint of the dark tones, and to the right, more
importance to the tint of the light tones.

- **Paper Hue**: determines the replacement shade of the light tones, associated with the white of the paper.

- **Paper Toning**: defines the intensity of the light tones.

2. **Vignetting** section: these tools (click the arrow on the left to show or hide them all) allow you to apply a darkening or lightening effect to the edges of the image, to give it a retro effect, or to focus attention on the subject.

   - **Vignette** drop-down menu: set to Off by default (no vignetting); mouse through the list to see the effect in real time on your image. To select an effect and apply it, click on it.

   - **Amount**: controls the intensity of the vignetting. Moving this slider to the left darkens the edges of the image; moving to the right lightens them.

   - **Shape**: controls the general shape of the vignetting, between CIRCLE and RECTANGLE.

   - **Size**: sets the extent of the vignetting effect in the image.

   - **Place center**: click on the button to position a vignetting effect off-center. After the mouse pointer changes to a "+", click to place it in the image. If you want to change the positioning, click the button again and start over.

3. **Burn Edges** section: these tools (click on the arrow on the left to show them all or hide them), also inspired by darkroom techniques, will allow you to create denser image edges than with the tools in the Vignetting section. Unlike the latter, you can work side by side, and even combine the effect with vignetting.

   - **Burn Edges** drop-down menu: Off by default, the menu allows you to hover your mouse to preview or to click the mouse to apply one of 4 proposed effects.

   - **Edge selector**: select and adjust the edge(s) that you wish to rework individually in your image.

   - **Strength**: darkens the burned edge effect on the selected side.

   - **Size**: adjusts the extent of the burned edge.

   - **Transition**: controls the blending of the darkening effect with the image.

4. **Image Borders** section: click on the arrow on the left to display all the tools or to hide them. The borders proposed in this section also come from enlarger techniques used in the lab.

   - **Image Borders** drop-down menu: set to Off by default, the menu contains a list of borders that you can preview in the image in real time by hovering the mouse, and
apply by clicking the mouse.

- **Size**: adjusts the thickness of the border added to the image.

- **Spread**: by moving this slider to the right, the border detail of the image extends further into the image.

- **Roughness**: controls the random detail around the image. Moving the slider to the right (from CLEAN to ROUGH) creates more random detail in the border.

- **Vary Border** button: allows you to create random borders from one image to the next. By clicking the button, a random border number will be created. To recreate the exact same border later, note the number, as well as the settings for size, spread, and clean/coarse finish. To get a similar but different border for each image, use the same values for size, spacing, and roughness, but choose a different border number.

* Adding thickness to an edge always trims part of the image. If you want to keep the entire image, increase the size of the work area in Adobe Photoshop.

*Finishing with Café 13 toning, vignetting (vignette) and Type 2 border*
Viveza 3
Viveza 3

The Viveza 3 module is a tool designed to rework the colors and tonality (brightness and contrast) of your images, both globally and locally, using Control Points. With them, you will be able to liven up or attenuate the colors by playing on the hue, saturation, and luminosity, and you can modify the contrast as well as the micro-contrast of your images.
Viveza 3 settings and help
Viveza 3 allows you to make a number of adjustments to its display modes and to access the online user guide.

- Preferences
- Help

Preferences
To access the Preferences:
- Mac: click on the Viveza 3 menu at the top left, then select Preferences.
- PC: Go to the File menu, then select Preferences.

The Preferences window contains a single tab called General. It offers the following options (from top to bottom):
Viveza 3 Preferences, General tab

- **Default preview mode**: allows you to choose how the image will be displayed upon opening, either Single Image Display, Split Preview (the image is separated by a line, before corrections on the left, after corrections on the right), or Side-by-Side Preview (the two versions of the image, before and after corrections, are presented next to each other).

- **Background color**: you can select the level of gray on which you want to see your images:
white, gray, dark gray, black.

- **Zoom status**: sets the zoom value applied to the aperture, from Fit (fit display) to 3:1 (300%).

- **TIFF compression**: Choose between compression with the LZW method, which reduces the file size, or no compression.

- **JPEG quality**: Allows you to adjust the compression and quality of the JPEG files generated when you save your work in Viveza. The default setting is **80%**, a good compromise between quality and file size.

- **Language**: Nik Collection by DxO offers a choice of 17 languages.

- **Reset preferences**: click on the Reset button to reset preferences to default values and choices.

  * By default, if you do not change this option, the last setting is used.

  ** Changes take effect at the next launch.

  Common options and settings made in one module will apply to all modules in the Nik Collection by DxO.

**Saving**

- On a Mac, exit the Preferences window by clicking the red button at the top left (changes are saved automatically, some taking effect on the next launch — see list above).

- On a PC, click on Save to take the changes into account (some of which take effect the next time you launch - see list above). You can exit without taking the changes into account, either by clicking on Cancel or on the red button at the top right).

**Help**
To access the online help links, you can go to the Help menu (internet connection required):

- **User Guide**: viewable online and downloadable as a PDF
- **Frequently asked questions**
- **Online support**: report problems and ask questions after creating a support ticket
- **DxO Academy**: tutorials, videos, webinars
- **Check for updates**: if an update is available, you can download and install it. When installing the update, you will be prompted to close the Nik Collection by DxO and host programs.
- **About Viveza 3** (PC): Displays the home screen with the installed version number.

* Internet connection required.
Viveza 3 interface

The Viveza 3 interface is composed of the following elements:

1. The menu bar
2. The upper toolbar
3. The image display area
4. The left panel (presets)
5. The right panel (tools)
6. The lower toolbar

> Keyboard shortcuts

![The 6 elements of the Viveza 3 interface](image)

The menu bar

Mac:
The menu bar at the top of the Viveza 3 window contains the following menus:

1. **Viveza**: gives access to the Preferences.

2. **Edit**: contains the Undo and Redo commands, to undo or redo previous actions one by one, as well as the Apply Last Edit command, which allows you to apply corrections made to another image during a previous session with Silver Efex Pro 3 to a new image.

3. **Help**: contains links to the user guide, DxO support, etc. (see the Settings and help page).

**PC:**

The menu bar at the top of the Viveza 3 window includes the following menus:

1. **File**: gives access to the Preferences.

2. **Edit**: contains the Undo and Redo commands, to undo or redo previous actions one by one, as well as the Apply Last Change command, which allows you to apply the corrections made to another image during a previous session with Viveza 3 to a new image.

3. **Help**: contains links to the user guide, DxO support, etc. (see the Settings and help page).

**The upper toolbar**

The upper toolbar includes the display, comparison, and zoom tools.
Compare and Zoom buttons

The Compare and Zoom buttons let you compare your image before and after correction:

1. **Alternate**: click on the button to display the image before correction, release to display the corrected image.

2. **Split vertically or horizontally**: divide the image in two with a vertical line that can be moved left or right, and switch to horizontal mode by clicking on the arrow in the center of the line, with the possibility to move it freely up or down. The left half (or top half) represents the image before correction, as it was opened in the plug-in, the right half (or bottom half) represents the processed and corrected image. You can zoom and move synchronously in both halves of the image, either with the Navigator or with the Hand tool, by pressing the Space bar.

   **One above the other or side by side**: the pre-correction version is displayed at the top, the post-correction version at the bottom. You can also display both versions of the image side by side by clicking on the button between the two. You can also zoom and move synchronously in both images, either with the Navigator or with the Hand tool, by pressing the Space bar.

3. **Fit**: displays the entire image in the display area.

4. **Fill**: displays the image so that it fills the entire display area (image will therefore be cropped).

5. **1.1**: standard zoom value equivalent to 100% (1 pixel of the image = 1 pixel of the screen).

6. **2.1**: zoom value equivalent to 200%.

7. **Other zoom values**: by clicking on the arrows, a menu offers other zoom values. When you select one of these values, it is displayed in the button (7).

As soon as you zoom into the image (including in Fill mode), a floating navigation window appears at the top right of the image display area. You can move around the image by grabbing the pad or by clicking in the floating navigation window.
Comparison display mode: Alternate
Comparison display modes: Split vertically or horizontally

Comparison display modes: one on top of the other, or side by side
(Note that you can zoom in these comparison modes.)

The floating navigation window (Zoom mode)
The image display area

This is where the image is displayed on a medium gray background that you can change in the Preferences.

Below the image you will find the following information:

1. If several images have been opened, a small horizontal scrollbar allows you to switch from one to the other.

2. File name and extension. If the image has EXIF metadata, the shooting and material settings will also be displayed.

3. You will also find the checkbox for non-destructive workflow mode.

The left panel (presets)
The left panel contains all the filters and effects grouped into 2 categories (All, En Vogue) under the Presets section, as well as Custom, to create your own presets, Imported, to load effects.
shared by other users and, finally, a **History** section, which compiles all the corrections and adjustments applied to the selected image (see below).

You can hide or reveal the left panel either by clicking on its right edge or by pressing the `L` key.

The presets are presented as preview thumbnails of the image opened in the plug-in. If the image is framed horizontally, the thumbnails are arranged in a single-image column. If the image is cropped vertically, the thumbnails are grouped in pairs.

To hide or reveal a section, click on the arrow on the right. The number indicates the number of presets in each section, and the double arrow lets you save and export a preset. In each section, you can filter the presets by favorites or recently used. Finally, to hide or reveal the left panel, click on the right edge.
The left panel

For detailed information about these sections, refer to the chapter on Using and managing presets.
The right panel (tools)
The right panel contains all the global and selective correction sections, as well as a loupe (magnifying glass) and a histogram, arranged from top to bottom:

- **Loupe** (see below)
- **Histogram** (see below)
- **Global settings**: global tone and color correction sliders, and selective tone sliders
- **Selective tones**: sliders that act on the brightness ranges
- **White balance**: correction of color dominants and color temperature
- **Selective settings**: creation and management of control points. Activating them displays sliders equivalent to global settings, selective tonality, as well as a color picker and color selectivity sliders.
- **Levels & Curves**: advanced correction and adjustment tools for brightness and contrast
- **Save preset** button: allows saving the settings as presets

* For detailed information about the operation and use of these tools, refer to the [Correction tools](#) and [Using and managing presets](#) sections.

You can hide or reveal the right panel by clicking on its left edge or with the R key. Likewise, you can hide or reveal the sections by clicking on their respective arrows at the top right.

When you exit and return to Viveza 3, the status of the sections in the right panel — open or closed — is retained.

To reset a setting, double-click the slider. To reset the settings in the Global Settings and White Balance sections, click the rounded arrow. The White Balance section also has a checkbox to temporarily turn the applied correction off and on. Finally, the Selective settings and Levels & Curves sections have their own reset system.
Loupe

The **Loupe** section is available regardless of the tools used:

- The loupe permanently displays an enlarged preview of the image area hovered over by the mouse.
- The loupe can be locked at any point in the image by clicking on the pin and then in the image (tilted pin: inactive, vertical pin: active).
- When you activate one of the zoom modes, the loupe is centered by default.

Histogram

The histogram shows the distribution of the brightness levels of the pixels in the selected image, with dark tones on the left, medium tones in the center, and light tones on the right, with the peaks corresponding to the number of pixels per brightness range. You can view the histogram in different ways by clicking on the buttons:

- **RGB**: default indication, covering the 3 channels Red, Green, Blue as well as the complementary colors Cyan, Magenta and Yellow, according to the principle of additive synthesis.
- **R**: displays only the red channel.
- **G**: displays only the green channel.
- **B**: displays only the blue channel.
- **L**: displays the global luminosity values.
Thanks to the possibility of displaying the brightness values per channel, you will be able to act more precisely on your tonality (exposure, contrast) and color settings. Note that the histogram is also present in the Levels & Curves tool.

The histogram also allows you to display the clipped values by checking the boxes in the upper left corner (dark tones and blacks) and in the upper right corner (light tones and highlights). The clipped tones, which indicate pixels and therefore image information that may disappear, are also represented in the image as masks:

- Black mask: light tones / clipped highlights
- White mask: dark tones / clipped blacks
- Masks in color: tons clipped in the channels R, G, B as well as the complementary colors C, M, J (principle of the additive synthesis)
Clipping indicators in the histogram and image.

For example, if your image has clipped highlights, you can restore them using the Brightness and Light Tones sliders or the Levels & Curves tool. In this case, the clipping black mask will be reduced or disappear. The same applies to the clipped blacks, which can be corrected with the Brightness, Shadow Adjustment, Shadows, Blacks sliders and with the Levels & Curves tool.

The bottom toolbar

The bottom bar includes the following information and functions:

1. **File source**: indicates the name of the host application.

2. **Cancel**: Cancel the current processing and corrections and closes the plug-in. The image in the host application is not modified.

3. **Apply**: saves the processing and corrections and closes the plug-in. The image in the host application is modified.

**Keyboard shortcuts**

<table>
<thead>
<tr>
<th>Action</th>
<th>Windows</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Windows</td>
<td>Mac OS</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>---------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Select several control points in the image</td>
<td>Ctrl + A</td>
<td>Cmd + A</td>
</tr>
<tr>
<td>Select several control points in the list</td>
<td>Ctrl + click</td>
<td>Cmd + click</td>
</tr>
<tr>
<td>Delete a control point</td>
<td>Backspace</td>
<td>Delete</td>
</tr>
<tr>
<td>Duplicate a control point</td>
<td>Ctrl + D, Alt + drag &amp; drop</td>
<td>Cmd + D, Option + drag &amp; drop</td>
</tr>
<tr>
<td>Apply the preset</td>
<td>Enter</td>
<td>Enter</td>
</tr>
<tr>
<td>Cancel the preset</td>
<td>Esc</td>
<td>Esc</td>
</tr>
<tr>
<td>Full screen</td>
<td>F</td>
<td>F</td>
</tr>
<tr>
<td>Pan or Hand tool</td>
<td>H or spacebar</td>
<td>H or spacebar</td>
</tr>
<tr>
<td>Preview</td>
<td>Ctrl + P</td>
<td>Cmd + P</td>
</tr>
<tr>
<td>Show/Hide the left and/or right panes</td>
<td>Tab (both), L (left), R (right)</td>
<td>Tab (both), L (left), R (right)</td>
</tr>
<tr>
<td>Selection tool</td>
<td>A</td>
<td>A</td>
</tr>
<tr>
<td>Cancel</td>
<td>Ctrl + Z</td>
<td>Cmd + Z</td>
</tr>
</tbody>
</table>
Using and managing presets

The left panel is dedicated to presets and consists of the following sections:

- Presets
- Custom
- Imported

Each section can be hidden or expanded using the arrow to the right of the section name. The number indicates the number of presets in each section.

Presets section
Presets consist of adjustments and corrections whose effect is represented by thumbnails, using the active image. Presets are a quick way to learn how to use Viveza, while providing a starting point for creating custom presets, which you can then apply to your images with a single click.
At the top of the Presets section, the presets are organized by category (All and En Vogue). If you click on any of the categories, the associated presets are displayed in a scrolling list of thumbnails.

*Image before processing (Neutral preset)*
Selecting a preset (002 Golden Hour)

Warning box
To apply a preset, click on its thumbnail in the left pane. The corrections are immediately applied to the image, and a dialog box tells you that the previous settings and corrections will be replaced. Click **Yes** to accept, and **No** to cancel (if you don’t want to see the dialog again, check the **Don’t show again** box).

Each time you apply a preset, the settings and sliders change in the right pane, reflecting the preset’s corrections.
You can mark presets as favorites by clicking on the gray star to the left of each thumbnail. Favorite presets are indicated by a gold star. To remove the favorite status, click on the gold star and it will return to gray.
The Presets section also allows you to filter and display presets according to the following statuses (you can add the filters):

- **Favorite presets**: click on the **Favorites** button.
- **Recently used presets**: click the **Recent...** button.

Active filters are represented by their respective light gray buttons and the brighter name. To revert to a single filter or to disable filters completely, click on the relevant button(s).
Custom presets section
The Custom section stores presets that you create, and also has tagging and filtering by favorites or recently used.

Creating a custom preset
To create a custom preset:
1. Make the desired corrections with the tools in the right pane, both global and selective settings (control points).
2. At the bottom of the right pane, click the Save preset* button.
3. In the Custom type dialog box, enter an explicit name (e.g., Soft Contrast + Cyanotype, Color and Contrast +, Desaturation, Structure ++, etc.).
4. If you want to save the control points and the associated selective corrections, make sure that the Save with control points box is checked (it is checked by default).
5. Validate by clicking on Save.
6. The custom preset appears in the Custom section in the left pane.

* You can also save by going to the Custom section, clicking on the double arrow to the right of the number of presets and selecting Save preset from the pop-up context menu.

Managing custom presets
You can take advantage of your custom presets with the following features:

1. **Rename**: Click on the preset name below the thumbnail to activate the input field. After entering the new name, press **Enter** to confirm.

2. **Mark as favorite**: Click on the star to the left of the preset (the star turns gold). Click again to cancel (the star turns black again).

3. **Export**: Hover over the preset to display the buttons to the right in the thumbnail. Clicking the top button will allow you to export the preset, for the purpose of sharing it. A system dialog allows you to choose the save location, before clicking **Open**.

4. **Update**: After editing or adding corrections from a custom preset, hover over the thumbnail to display the buttons on the right. Click on the curved arrow to update the preset with the modified or added corrections.

5. **Delete**: Hover over the preset to display the buttons to the right in the thumbnail. Click the trash can to delete it.

* *These commands are available only for custom presets, not for original presets.*
To export all your custom presets:
1. Click the double arrow to the right of the number of custom presets.
2. From the pop-up menu, select **Export all**.
3. A system dialog box allows you to choose the save location and confirm.

**Imported presets section**

This section allows you to import presets shared by other users, and with a few exceptions, its operation is similar to that of the Custom section.

**Importing presets**
To import presets:

1. In the **Imported** section, click the double arrow to the right of the preset number.
2. From the pop-up menu, select **Import preset**.
3. A system dialog box will open. Locate the presets you want to import.
4. Select the presets you want to import, then click **Open**.
5. The imported presets are displayed in the **Imported** section.

Managing imported presets
You have tools and controls for renaming, bookmarking, exporting, and deleting your custom presets:

1. **Rename**: click on the name of the preset under the thumbnail to activate the input field. After entering the new name, confirm with the **Enter** key.

2. **Mark as favorite**: Click on the star to the left of the preset (the star turns gold). Click again to cancel (the star turns black again).

3. **Export**: Hover over the preset to display the buttons to the right in the thumbnail. Clicking the top button will allow you to export the preset, for the purpose of sharing it. A system dialog allows you to choose the save location before clicking **Open** to export.

4. **Delete**: Hover over the preset to display the buttons to the right in the thumbnail. Click on the trash can to delete it.

* These commands are available only for custom presets, not for the presets shipped with Viveza.

If it is not possible to edit and update imported presets in the **Imported** section, you can do so by creating a new preset from an imported preset:

1. Apply the preset you want to modify.

2. Edit the tool corrections in the right pane as desired, both global and selective (control points).

3. At the bottom of the right pane, click the **Save preset** button.

4. In the **Custom Preset** dialog box, enter an explicit name (e.g., Soft Contrast + Cyanotype,
Color and Contrast +, Desaturation, Structure ++, etc.).

5. If you want to save the control points and the associated selective corrections, make sure that the Save with Control Points box is checked (it is checked by default).

6. Validate by clicking Save.

7. The modified imported preset appears in the Custom section in the left pane.

Finally, just as with custom presets, you have the possibility of exporting all your imported presets:

1. Click on the double arrow to the right of the number of imported presets.

2. From the pop-up menu, select Export all.

3. A system dialog allows you to choose and confirm the save location.
Correction tools

Viveza 3 is purely a tone and color correction tool, designed to make corrections easier without having to go through the complex masking techniques offered by major retouching software. The tools in Viveza 3 can be used both for global image correction and for selective correction using control points (U-points). They are grouped in the following sections:

- **Global Adjustments and Selective tones**
- **White Balance**
- **Selective Adjustments**
- **Levels & Curves**

Global Adjustments

Overview

The Global Adjustments section of Viveza 3 is divided into two sections:

1. **Global Adjustments**: correction of brightness, color contrast and structure effect (detail enhancement).

2. **Selective tones**: brightness correction by tonal ranges (light tones, medium tones, shadows, blacks).
The sliders are set to 0% by default, and to reset a slider, simply double-click it. To reset all the corrections, click on the curved arrow at the top right.

The sliders described below are used globally, with the corrections acting throughout the image, and the same sliders also appear in the Selective Adjustments section, after you have created a control point and placed it in your image.

**Global Adjustment sliders**

- **Brightness**: adjusts the brightness, darker on the left, lighter on the right.
- **Contrast**: adjusts the contrast — that is, the difference in brightness between the dark and light parts of the image. Towards the left, the image will be flatter and less saturated, towards the right, the image will be more punchy and more saturated.
- **Saturation**: acts on the brilliance of the colors, more vivid towards the right, and less and less saturated towards the left, until obtaining a completely gray image.
**Structure**: reinforces the details and gives more spiciness to the image. Set to the left, the slider softens the details.

**Shadow**: adjusts the level of brightness in the darker areas of the image, without affecting the rest of the image.

**Warmth**: set to the left, cools the colors (towards blue), set to the right, warms the colors (towards yellow/orange).

**Red**: lets you mitigate a dominant color (more green on the left, more red on the right).

**Green**: lets you mitigate a dominant color (more magenta on the left, more green on the right).

**Blue**: lets you mitigate a dominant color (more yellow on the left, more blue on the right).

**Hue**: shifts the set of colors to the opposite colors (for example, the blue of the sky becomes magenta to the right, and green to the left).

* To adjust the brightness of the darker tones, use the Shadows slider in the Selective tones section instead.

** Remember to readjust the color saturation after changing the contrast.

**Selective tones sliders**

- **Highlights**: moved to the left, this slider recovers information and details in the brightest parts of the image, especially those close to the clipping (right end of the histogram). Moved to the right, it allows you to give more brightness to the lightest tones.

- **Midtones**: this slider acts on the midtones (shown in the central section of the histogram).

- **Shadows**: this slider allows you to lighten the shadows and dark parts of an image.

- **Blacks**: moving the slider to the right lets you set the "black point" (left end of the histogram) and thus avoid clipping the darkest parts of the image. Conversely, moving the slider to the left, you will make the darkest areas of the image even more dense.

The Selective tones sliders can dramatically change the contrast of your images. Use them sparingly and, most importantly, watch the histogram to avoid clipping (see the Interface and keyboard shortcuts page for a description of histogram and in-image
White Balance

The White Balance tool allows you to restore natural, balanced colors and to compensate for the presence of colored dominants by acting on the colors. Of course, you can also take advantage of it to create special effects and renderings, which is the purpose of the tool as implemented in Viveza 3, given that your host application will have already performed the white balance of the original RAW file.

Performing and correcting white balance

To perform white balance:

1. In the **White Balance** section, click on the eyedropper to activate it.
2. Move the mouse pointer over the image and it will turn into an eyedropper.
3. You can adjust the diameter of the sampling area (shown by the circle at the end of the dropper) using the **Radius** slider. The default diameter is 5 pixels, on a scale from 1 to 50 pixels.
4. To neutralize a dominant, click on a neutral area of the image, white or gray.
5. To introduce a dominant, click on the desired color (for example, to warm up the image, click on blue, to cool it down, click on yellow, orange or red).
6. You can change the white balance as many times as you wish by clicking repeatedly in the image.

If the neutral area or color you want to click on is small, zoom in to make the sampling more accurate. You can also reduce the diameter of the eyedropper area (**Radius** slider).
Cooler image by clicking on a warm shade
Warmer image by clicking on a cold shade
More balanced image by clicking on a neutral color

Change or fine-tune white balance

Whether you want to neutralize a color cast or alter the colors, you can fine-tune the white balance with the **Temperature** slider. Set to 0 by default, its scale ranges from -100 to +100.
Warm image by increasing the value of the Temperature slider

Reset and compare
You can reset the white balance and compare it to the image opened in Viveza:

- Reset the temperature: double-click the Temperature slider.
- Reset the entire white balance: click on the curved arrow in the White Balance section of the right pane.
- Quickly compare after/before: click in the box to the left of the White Balance heading.

Selective Adjustments
The tools in the Selective Adjustments section allow you to change only certain parts of the image. Add a control point, and when adjusting the corresponding sliders, it will affect only the objects or areas covered by the control point.

You can find more information and details about the operation of Control Points in the dedicated chapter.
Adding control points

To place and use a control point:

1. In the **Selective Adjustments** section, click the button to the right of **Control points**.
2. As you move through the image, the mouse cursor changes to a control point.
3. Click where you want in the image to place the control point.
4. The control point appears as a yellow (active control point) or white (inactive control point) dot.
5. When it is active, the control point has a slider for adjusting the radius of effectiveness, represented by a circle.
6. When the control point is inactive, you can move the mouse over it to see the slider and the radius (but to adjust them, you must first activate the control point by clicking on it).
7. If desired, you can move a control point (active or inactive) by holding down the mouse button and moving the mouse.
8. You can add as many control points as you want by repeating steps 1 to 3.
9. To delete a control point, click on it to activate it and press the Delete key on your keyboard. A dialog box will prompt you to confirm (check the **Don't show again** box to stop displaying the dialog box).

Managing control points

The Selective Adjustments section allows you to manage the various control points applied to the image, presented here as a numbered list. The active control points are indicated in yellow.
1. **Create a control point**: see previous paragraph (*Adding a control point*).

2. **Size**: indicates in % the size of the radius of effectiveness of the control point.

3. **Show/Hide selection for all control points**: this button allows you to display the monochrome masks of all the control points. To display the mask of only one control point at a time, check the box on the right in the list. In the monochrome mask, white indicates the areas of the file where 100% of the correction is applied, black indicates no correction and the gray variations indicate the areas more or less affected by the correction.

4. **Control point list**: control points indicated by the yellow icon and white text are selected and active, grayed out control points are inactive.

5. **Enable/Disable effect for all control points**: the checkbox disables and re-enables all control points applied to the image, as well as the associated corrections and settings.

6. **Show/Hide control point effect**: The checkbox allows you to temporarily disable and re-enable the display of the control point in question, as well as the associated corrections and settings.

7. **Show/Hide control point selection**: this button allows you to display the monochrome mask of the control point concerned (see also point 3).

8. **Duplicate**: by clicking on this button, you duplicate the currently selected control point(s). You can also duplicate a control point by clicking on it while pressing the Alt/Option key,
then dragging the mouse to reposition the duplicated control point.

9. **Group**: You can group multiple control points by first selecting them in the list, holding down the Ctrl (PC) or Cmd (Mac) key and then clicking on this button. In the list, the control points are grouped into a group named **Group 1, Group 2**, etc. In the image, the first control point selected to form the group is indicated by the normal dot, and all other control points in the group are indicated by a small yellow dot. When you apply a correction to one of the control points, the correction will be applied to the other control points in the group. However, the size slider for each control point in a group can be adjusted independently. You can also select multiple control points by clicking in the image and then, while holding down the left mouse button, draw a selection rectangle encompassing the desired control points (then you can group them by clicking the **Group** button).

10. **Ungroup**: to remove the grouping of control points, select the group from the list and press this button. All control points will be displayed as ungrouped, allowing you to delete, modify or create new groups from the individual control points.

11. **Delete**: Click the Delete button to delete the currently selected control points.

12. **Reset** (curved arrow): Resets all sliders and settings associated with the active control point.

**Renaming control points and groups**
To help you manage and keep track of your control points and/or control point groups, which can grow quickly, you can rename them as you wish:

1. In the list of control points, double-click on the name of the control point or group to rename. To be renamed, the control point or group must be inactive.

2. The name is highlighted: enter the new name directly. The old name is deleted as soon as you start typing.

3. If you just want to change the name, move the blinking input pointer using the left or right arrows on your keyboard.

4. Confirm by clicking outside the list or by pressing Enter.

Renaming does not change the order of the checkpoints in the list. There is no automatic consideration of alphabetical order, nor can you change the order by drag and drop.

Selective Adjustment sliders
1. **Color Selectivity**
   - Luminance
   - Chrominance

2. **Global Adjustments***:
   - Brightness
   - Contrast
   - Saturation
   - Structure
   - Shadow
   - Warmth
   - Red
   - Green
   - Blue
   - Hue

   * See the **Global Adjustments** paragraph for the role and operation of these sliders.

3. **Selective tones***:
   - Highlights
   - Midtones
   - Shadows
   - Blacks

   * See **Global Adjustments** for the role and operation of these sliders.

The control points in Viveza 3 no longer have their own sliders, as the number of sliders can get in the way of image visibility. This means you will need to make your corrections using the sliders that appear in the Selective settings section of the right pane after you have created a control point. Do not confuse them with the sliders in the Global Settings section.

You can reset a slider to its default setting by double-clicking on it; to reset all the sliders in the Selective Adjustments section, click on the curved arrow to the right of the active control point's
Selective Adjustments allow you to change only certain parts of the image. Add a control point and when adjusting the corresponding sliders, it will affect only the objects or areas covered by the control point.

Five distinct control points, only one active
Draw with the mouse to encompass the control points.
Control points grouped to apply the same correction.

You can find more information and details about the operation of Control Points in the dedicated chapter.

Color Selectivity
The Color Selectivity sliders allow you to extend or reduce the range of the color of a control point. This will allow you to include in your correction variations in the hue and its brightness level (for example, to take into account slight variations in the blue of the sky).

- **Luminance**: determines the range of brightness of the color (default setting 50%).
- **Chrominance**: determines the range of hue variations of a color (default setting 50%).

The effect of the Color Selectivity sliders is subtle, so use the black/white mask display of the control point, as shown below:

Placement of the control point (no correction applied)
Slight lightening with the Luminance slider: the correction is not homogeneous within the radius of the control point.

Adjusting the Color Selectivity
The correction is more homogeneous.

Without using color selectivity

(in white: correction applied, in black: no correction)

With Color Selectivity

Sampling eyedropper and Color Picker
**Sampling eyedropper**
Active only with the selective adjustments, the eyedropper allows you to pick a hue from the image and apply it to the active control point. For example, if the control point is set to blue sky and you pick green from the vegetation, the control point will apply that hue to that location in the image. The picked color appears in the color picker box to the right of the dropper. Once you have picked the color, the Selective Adjustments sliders will display settings that you can change as you wish.
Color replacement with sampling applied to the control point (duplicated to extend the correction).

Color Picker
You can also click on the tile to the right of the dropper, provided that a control point is active (by default, the tile is gray). This will open the color picker of the operating system, where you can choose a color that will be immediately applied to the active control point when you click on **OK**.

Again, you can use the Selective Adjustments sliders to adjust the chosen color.

**Levels & Curves**

*The “S” curve is a tool that lets you reinforce the contrast*
by making the darker parts denser (lowering the foot of the curve),
the light parts brighter (head of the curve),
and by adjusting the midtones (center of the curve).

The Curve allows you to refine or completely rework the contrast of your images, by acting on the curve either globally or via the RGB channel, as well as by using the Level sliders:

1. **RGB** button: selected by default, it allows you to adjust the brightness and contrast of your images without altering the colors. The histogram represents the 3 RGB channels combined, and the curve is white.

2. **R**, **G**, and **B** buttons: allow you to adjust the brightness of the Red, Green or Blue channels, in particular to attenuate or reinforce their respective dominants. The histogram represents the selected channel and the curve takes the color of the chosen channel (red, green, or blue curve).

3. **Curve**: click on the curve and hold down the left mouse button to adjust it. You can add anchor points to the curve, which will allow you to lock the contrast settings to specific points on the curve, and therefore on the image. To remove an anchor point, double-click it.

4. **Level** sliders: Drag the dark (left), mid (center) or light (right) sliders to adjust the range of their respective ranges.*

5. **Reset**: The double arrow at the top of the Levels and Curves section opens a pop-up menu where you can reset the settings of the active channel, or all applied settings.

* You can see the color changes you make via the Levels & Curves tools in the Histogram, either globally (**RGB** button by default) or individually by clicking on the **R**, **G**, **B**, or **L** (for Luminance) buttons.
Reinforcing global contrast with an "S" curve (see illustration at the beginning of the paragraph).